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Getting Started 

Inset, together with Wordstarn, lets you produce documents with graphics and text 
printed on the same page. For example, you can 

n Illustrate reports with charts and 
graphs 

Create your own graphics or edit 
others 

Use art from clip art libraries in 
your documents 

Here's how Inset works. First, you 
display the graphic image you want 
to appear in your document. In a 
process similar to taking a snapshot 
and preserving an image on film, 
you capture the onscreen image and 
store it in a file. 



Once the image is stored in a file, you can 
open a WordStar document and add a pix tag 
to insert the picture into the text. Then all 
you need to do is print your WordStar docu- 
ment for a picture-perfect page. 

The lnset documentation is organized into 
the following chapters: 

"Getting Started" tells you how to set up lnset 
for your system and shows the basics of how 
to use Inset. 

"Learning Inset" guides you step by step 
through Inset's main features. 

"lnset Reference" i s  an alphabetical guide that explains everything you can do with 
Inset. 

"Changing the Setup Options" describes how to change several lnset settings. 

"More About Inset" describes how to solve problems you may have while working with 
Inset, describes how to capture images from specific programs, and describes lnset 
macros. 

Over  view 

lnset is a memory-resident program that you load into memory before you start work- 
ing. Once lnset is loaded, you can activate it any time you need it. Just create your 
graphics using the graphics, spreadsheet, or other program you normally use. When 
you have the image displayed on the screen, you can use lnset to capture the image 
into a special pix file that you can use in your documents. You can also use lnset from 
the operating system or from within WordStar to create or modify an image. 

To insert an image into a document, you place a pix tag in the text. When you print, 
the image is  automatically inserted. You can also preview the text and graphics on the 
screen while editing your WordStar file. 

To run lnset with WordStar, you need a computer with at least 51 2K of RAM for full 
WordStar functionality. You must also have a printer supported by lnset (see the 
Printers and Monitors List). 

To take advantage of all the lnset capabilities, you need a graphics board in your com- 
puter. See "A Screen" in "Changing the Setup Options" for a list of graphics adapters 
you can use. If you have a monochrome monitor without a graphics adapter, you can't 
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display graphics, so you can't capture or edit them. You can, however, capture graphs 
and charts created in text mode and insert them into your documents. You can also 
insert graphics captured on another monitor into a document and print them. 

Before you use Inset, you must install it and set it up for your monitor and printer. After 
you install and set up Inset, you can delete files you don't need to save space on your 
disk. 

Installing 
If you didn't install lnset when you installed WordStar, do so now. See the lnstalling 
and Customizing booklet for information on adding a feature. This procedure makes a 
directory for the lnset files. It also informs WordStar where the lnset files are located. 

Setting Up Inset for Your System 
You must set up lnset for your monitor and printer before you can use it. Follow these 
steps: 

I Log on to your lnset disk or directory. 

2 Type inset and press J to load lnset into your computer's memory. The first instal- 
lation prompt appears on your screen. 

3 Follow the instructions on the screen to choose your graphics board and printer. 
(If necessary, refer to the manuals that came with your equipment.) If you're not 
sure which graphics board to choose, see "A Screen" in "Changing the Setup 
Options." If you're not sure which printer to choose, see the Printers and Monitors 
List. 

After you make your choices, the Hardware Configuration Setup screen appears. 
You don't have to change any of these settings now; you can change them any time 
using the Setup program described in "Changing the Setup Options." However, if 
your printer i s  attached to a port other than LPT1, you can choose F now to change 
the port. See "F Port" in "Changing the Setup Options." 

4 Press F10 to save your choices and return to the operating system. 



5 At the operating system prompt, type ri (for remove inset) and press J to remove 
lnset from memory. (You need to load lnset again for your selections to take effect.) 

Deleting Unnecessary Files 
Deleting Extra Printer Files 

lnset comes with a printer driver file for each printer it supports. You need only the 
drivers for the printers you use. To conserve disk space, you can remove all the extra 
printer driver files from your hard disk. (You'll still have all the files on your original 
lnset disk in case you make a mistake or get a new printer.) 

To delete the extra files, log on to your lnset disk or directory and follow these steps: 

1 First, find your lnset printer driver name($ The driver names for all the printers are 
listed in the Printers andMonitors List. Find the name for each of your printers. All 
the lnset printer driver files have the extension .PRD. (These names are also shown 
on the Printer Driver Installation screen.) 

2 Now you'll rename the printer driver you installed, and any others you want to 
save, with the extension .NEW. Type ren filename.prd filename.new and press J. 
(In place of filename, type the name of your printer driver.) Repeat this step for any 
additional drivers you want to save. 

3 Next you'll delete all the extra files with the extension .PRD. Log on to your lnset 
directory. Type del *.prd and press J. 

4 Finally, you'll rename the files you saved with their original filenames. Type 
ren filename.new filename.prd and press J. (In place of filename, type the name 
of your printer.) Repeat this step for any additional drivers you renamed in step 1. 
This command renames your printer file(s) exactly as before with the .PRD 
extension. 

Deleting Other Files 
Besides the extra printer driver files, you can also delete the following files: 

All screen drivers except the one(s) you use. To find the name of your screen 
driver, look at the selections for the "A Screen" option of the Setup program (see 
"Changing the Setup Options"). The screen driver names are the short names on the 
left, plus the .EXE filename extension. (Some .EXE files aren't screen drivers but are 
important parts of the program, so be careful deleting .EXE files.). 
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m Either 12OF.EXE or I2OS.EXE. I2OF.EXE is the full version of Inset; I20S.EXE is  the 
small version, which doesn't allow graphics editing. If you have a monochrome 
screen without graphics capabilities, or if you're sure you don't want to edit 
graphics, delete 12OF.EXE; otherwise, delete I20S.EXE. You can also delete 
I20C.EXE, the capture-only version, if you don't plan to use it. 

m If you don't plan to use Inset's help feature, you can delete INSET.HLP 

Loading and Starting lnset 
To load and start lnset while you're editing a document with WordStar, use the lnset 
command on the Utilities menu (Alt+U,I), or use the AP& classic command. When you 
print a document that contains graphics, WordStar automatically loads lnset into 
memory for printing the graphics. After you exit lnset or finish printing graphics, 
WordStar automatically removes lnset from memory. 

Before each work session in which you intend to capture an image, you must load lnset 
into your computer's memory. To load Inset, first log on to the lnset drive or directory. 
Then type inset and press J. A message on your screen says that lnset is loaded and 
shows your current hardware setup. After you load Inset, i t  stays in memory until you 
turn off or reboot your computer, or give the RI command to free it from memory. 

Once lnset is loaded for capturing images, you can start i t  in any directory, either from 
the operating system or while you're using any program. To start Inset, press the pop- 
up keys at the same time, and the lnset Main Menu pops up on the bottom two lines of 
the screen. The pop-up keys are usually LShift (the Shift key on the left side of the 
keyboard) and Ctrl. 

To start lnset from within certain programs or using certain graphics boards, you may 
need to use the override pop-up keys, Alt, LShift, and I. (See Pop-up keys in "lnset 
Reference.") 

Note: You can use the capture-only version of lnset for capturing images. This version 
takes up less memory than the full version. To load the capture-only version, type 
inset /c and press J. 



The Inset Menus 
You use lnset by choosing commands from the lnset menus. These menus are dis- 
played on the bottom two lines of the screen. When you start Inset, the Main Menu 
appears. 

W S a u e  Iodify Ed i t  Print Output Help4 menu line 

Load Image for view ing and Mod if icnt ion description line 

The top line of each menu (the menu line) shows all the commands available. The cur- 
rent menu command is enclosed in angle brackets ( o ) and highlighted. 

The bottom line of each menu (the description line) either contains a description of the 
current command or shows the submenu accessed with the command. 

The menus are in a tree structure, with the Main Menu as the base. The entire menu 
structure i s  shown on the following page. 

Choosing a Menu Command 
There are two ways to choose an lnset menu command: 

Press the first letter of the command. 

Use the left or right arrow key to move the angle brackets to the command and 
press J. (You can also use a mouse to do this. See Mouse in "lnset Reference.") 

T I  P If the cursor movement keys are disabled by the program that is currently 
running, you can use * L  to move left and * R  to move right. 



Inset Menu Map 
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Exiting lnset 
To exit from an lnset menu or command prompt, press Esc. The pre- 
vious menu appears. If you're at the lnset Main Menu, you exit and 
return to the operating system or to the program you started Inset 
from. 

If you try to exit lnset after you edit or modify an image, a prompt 
asks you whether you want to save the modifications. You must answer yes or no 
before you can exit. This ensures that you don't accidentally lose your work. 

Removing lnset from Memory 
To remove lnset from memory, you must be sure that it is the last program loaded, 
including other memory-resident programs. Start from the operating system; you can't 
remove lnset from memory using the WordStar command to run a DOS command. Log 
on to the directory or disk where lnset is located. Type ri (for remove inset) and 
press J. A message tells you that lnset is freed from memory. (If lnset isn't the last 
program loaded, an error message appears. You must remove any program that was 
loaded after lnset before you can remove Inset.) 

Note: When you start lnset from WordStar, you don't need to remove it from memory; 
WordStar removes it automatically. However, if you loaded lnset into memory before 
starting WordStar, WordStar does not remove lnset automatically, and you must use the 
r i  command. 

Inserting Graphics from Other Programs 
You can insert graphics created using a number of other programs into your documents. 
When you insert a graphic file in another format, WordStar converts it to a .PIX file and 
inserts a pix tag that specifies the .PIX file. 



Learning lnset 
This chapter consists of two lessons. Before you begin these lessons, you should know 
how to use WordStar. 

In Lesson 1, you'll capture an image and save it in a picture file. Next you'll clip the 
image and change its size. Then you'll add the image to a page of text and print the 
document with the graphics. 

In Lesson 2, you'll look at some art that's included with Inset, and you'll clip, edit, and 
print a piece of art from a clip art file. 

As you work through the lessons, you can get help at any screen by pressing the F1 
function key. 

If you have a monochrome monitor without a graphics card, you can do Lesson 1 but 
not Lesson 2. 

Lesson 1 : Capturing, Modifying, and 
Inserting an Image 

To print a graphic image in a document, you must first use lnset to capture the dis- 
played image and store it in a picture file. Capturing an image is  similar to taking a 
picture and preserving the image on film. 

In this lesson, you'll capture a chart and make some changes to the captured image. 
Then you'll add the image to a page of text and print the document. 



Loading Inset 
If you haven't loaded lnset into your computer's memory, follow the steps below. 
(If you're already running Wordstar, exit from it; don't use the command to run a DOS 
command.) 

1 Change to the Inset directory. 

2 Type inset and press J. lnset is loaded into memory. 

Displaying the lmage and Starting lnset 
First you'll display the chart you're going to capture, then you'll start Inset. 

1 Type type chart and press J. The chart shown below appears on the screen. 

Sa le s  - Jan ,-flar 1 1988 

Prodt~ct  Sa l e s  

RD1-Kit 
RDl-flssenb led 
RD2 
A 1  1 Others 

I , , , , ,  
I I I I I I  

Thousands $-10-28-38-48-58-68 

2 Hold down the Shift key on the left side of the keyboard and press the Ctrl key. 
These keys are called "pop-up" keys. You can tell that lnset i s  running when you 
see the lnset Main Menu pop up on the bottom of the screen. 

Capturing the lmage 
You capture a screen image at the lnset Main Menu by saving it in a special picture file 
with a .PIX extension. This file i s  called a pix file. 

Follow these steps to capture the displayed screen: 

1 Press the right arrow key once to move the highlighting to Save. Then press .J to 
capture the displayed screen. (Or you can press S, the first letter of the command.) 
lnset prompts you for the name of the pix file. 
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2 Type chart and press J. 

lnset saves the image in a file named CHART.PIX. (The .PIX extension is  automati- 
cally added to the name you type.) 

Now you've captured the image. Before you insert it into a WordStar document, you'll 
clip the image and change its size. 

Modifying the Image 
When you captured the image, you captured the whole screen. However, you want to 
insert only the chart into the document. The process of choosing a part of the image to 
use is  called clipping. 

Before you insert the chart in the document, you'll also change its size. 

The lnset Main Menu should be on the screen. Follow the steps below to clip the cap- 
tured image. 

1 Choose View. (You can either move the highlighting to View and press J or just 
press V.) 

2 Type chart and press J. lnset clears the screen and displays the image. (If the page 
is still on your screen from when you captured it, you don't see the change.) 

3 Choose Modify. (Either move the highlighting to Modify and press J or just press 
M.) 

4 At the Modify Menu, choose Clip. 

The "clip lines" appear around the entire image. Notice that the cursor is at the 
upper-left corner of the clip lines. 

5 First, you'll choose the upper-left corner for clipping. Use the key to move the 
cursor down and the + key to move it to the right. You can use the PgDn key to 
move the cursor down and right at the same time. Notice that the top and left clip 
lines move with the cursor. Move the cursor to the left of the top-left corner of the 
chart. When the top clip line is covering the top border line of the chart and the 
left clip line is two columns to the left of the left border line, press J. 

6 The cursor is now at the lower-right corner of the clip lines. Use the '? key to move 
the cursor up and the t key to move the cursor to the left. You can use the Home 
key to move the cursor up and left at the same time. Move the cursor to the 
bottom-right corner of the chart's border. When the clip lines are covering the bor- 
der lines as shown in the following illustration, press J. 

T I  P You can hold down the Shift key while pressing the cursor keys to move the 
cursor more quickly. 

If you make a mistake and want to change the locations of the clip lines before you 
press J, press Esc to back up a step, then repeat steps 5 and 6. 



Next, you'll change the size of the image and save your changes. Follow these steps: 

1 At the Modify Menu, choose Expand. This command allows you to set the size at 
which the image will be printed. For this lesson, you'll set the size to 2.8 inches by 
1.5 inches. 

2 At the Expand submenu, choose Inches. 

3 At the Enter Width: prompt, type 2.8 and press J. 

4 At the Enter Aspect Ratio: prompt, type 0 and press J. (This choice allows you to 
set the height in inches rather than as a ratio of the width.) 

5 At the Enter Height: prompt, type 1.5 and press J. 

6 Press Esc twice. lnset asks if you want to save the image with modifications. 

7 Press Y to save the image, and press J to accept the same filename. lnset returns 
you to the operating system. 

8 Type ri and press J to remove lnset from memory. 

The pix file is now ready to be placed into text. Next you'll insert it into a WordStar 
document. 

Inserting the Image into Text 
To insert an image into text, you use the lnset command on the Insert menu (Alt+l,G) or 
the "P* classic command and type a pix tag where you want to place the image. The 
pix tag gives the name of the pix file that contains the image. 

1 Start in your WordStar directory. Type ws and press J. Then log on to the lnset 
directory. 

2 Choose the command to open a document, and choose the file named 
GRAPHICS.DOC. This file contains a short memo. Notice that the first lines of the 
memo are short. You'll insert the chart to the right of these lines. 
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3 Move the cursor to the end of the first line of the second paragraph (the space right 
after the word "the"). 

4 Choose Insert, Graphics (Alt+l,G) or press "P*. WordStar prompts you for the name 
of the pix file. 

5 Type chart and press J. Notice that you don't need to include the .PIX filename 
extension. 

WordStar inserts a pix tag that consists of the pix filename enclosed in brackets. 

6 Choose Utilities, lnset (Alt+U,I) or press "P& to load and start Inset. If you entered 
the pix tag correctly, a box appears where the chart will be. The image's size in 
rows and columns appears next to the pix tag. 

Note: Because the CHART.PIX file was captured in text mode, you cannot preview 
the page with Preview on the View menu ("OP). 

7 Press Esc to exit lnset. 

Save the GRAPHICS.DOC file, then print it. Use the usual WordStar printing proce- 
dure. Your file is printed with the text and graphics. 

Summary 
In this lesson, you learned the basics of capturing an image, modifying it, and inserting 
it into text, and then printing the document with the inserted image. 

When you're ready, continue to Lesson 2 to learn more about using lnset to clip and 
edit graphics. 

Lesson 2: Editing a Graphic Image 
lnset allows you to create new graphic images or edit existing ones. In this lesson, 
you'll look at some examples of graphics created or captured with Inset, then you'll 
clip, edit, and print one of the images. 

Note: If you have a monochrome monitor without a graphics card, you can't display 
graphics so you can't do this lesson. 

Looking at Drawings 
1 Log on to the lnset drive or directory, type inset, and press J to load lnset into 

memory. 

2 Press LShift-Ctrl to start Inset. The lnset Main Menu appears. 



3 Choose View. (Either use the cursor keys to move the highlighting to View and 
press J or just press V.) 

Inset prompts you for the name of the file to view. 

4 Type * and press J. Look at the names that appear on the bottom line of the screen. 
These are the pix files that are supplied with Inset. They contain drawings that have 
already been captured with Inset. 

5 Move the cursor to LOGOS1 and press J. The LOGOS1 .PIX file appears on the 
screen. It contains several drawings. You can use any of these drawings (and the 
drawings in the other pix files) in your documents. SYMBOLS, LOGOS2, LEISURE, 
DINGBATS, and EGALOGOS contain groups of drawings similar to those in 
LOGOS1. BORDERS contains several long thin images that you can use as dividers 
or borders. The remaining files, PCMAN, PC, MAN, TEST, and EGACHART, are 
more examples of drawings captured by Inset. 

If you want, you can look at more of these files now. Choose View, and then 
press * and J to display the list of files. Move the highlighting to the one you want 
to see and press J. (If you don't want to look at these drawings now, you can use 
the same procedure to view them later whenever you want.) 

Note: EGALOGOS and EGACHART were created on a high-resolution color 
screen. If you look at these drawings without an EGA card, they may not be clear. 

6 Choose View again. 

7 Type symbols and press J. 

The SYMBOLS.PIX file shown below appears on the screen. It contains various 
symbols that might be used in documents. In the rest of this lesson, you'll clip one 
symbol, copy it to its own file, and edit it. 



G E T T I N G  S T A R T E D  

Clipping an Image 

Use the following steps to clip the image of three electrical plugs in the upper-left 
corner of the screen: 

1 Choose Modify. 

2 At the Modify Menu, choose Clip. 

The clip lines appear around the entire image. The cursor is at the upper-left corner 
of the clip lines. 

3 Choose the upper-left corner for clipping. Use the 1, +, and PgDn keys to move 
the cursor slightly closer to the upper-left corner of the plugs drawing, as shown in 
the illustration below. The top and left clip lines move with the cursor. When the 
clip lines are where you want them, press J. 

4 The cursor is now at the lower-right corner of the clip lines. Use the '?, t, and 
Home keys to move the cursor to a point near the lower-right corner of the plugs 
drawing, as shown in the illustration below. You can hold down the Shift key 
while pressing the cursor keys to move the cursor more quickly. When the clip 
lines frame the drawing as shown below, press J. 

If you make a mistake and want to change the locations of the clip lines before you 
press J, press Esc to back up a step, then repeat steps 3 and 4. 

5 At the Modify Menu, press Esc to return to the Main Menu. 

6 Choose Save to save the clip lines. Press J to replace the original SYMBOLS.PIX 
with the image with clip lines. 



Putting the Clipped Image into a File 
The image you just clipped is  going to be part of a letterhead. Use the following steps 
to start a file for the letterhead image: 

1 At the Inset Main Menu, choose Edit. 

2 Choose Options, then choose Clear to clear the screen. 

3 Press J to accept the default resolution for your screen. (For a CGA screen, this is 
medium resolution; for another screen, it may be different.) 

4 Press Esc to return to the Edit Menu. 

5 At the Edit Menu, choose Block. 

6 Choose Import. 

7 At the filename prompt, type symbols and press J. 

A box appears on the screen. The box represents the clipped part of the 
SYMBOLS.PIX file, the plugs. The cursor is at the upper-left corner of the box. 

8 Use the arrow keys to move the box to the left. Place the box in a location near the 
one shown below. Don't move it quite all the way to the edges of the screen. 

When the box is in the correct position, press J. The box disappears and the image 
of the plugs appears. 

9 Press Esc. You are now at the Edit Menu. 
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Editing the Image 
Now you can turn the image of the plugs into a letterhead. First you'll draw a rectangle 
around the plugs, next you'll add text, and then you'll save the edited image to a new 
pix file. 

1 At the Edit Menu, choose Red. 

2 At the Fill with pattern? prompt, press J to accept the default, No. 

3 Move the cursor close to the upper-left corner of the drawing and press J. 

4 Use the PgDn key to move the cursor. Notice the rectangle that moves with the 
cursor. Use the arrow keys to make the rectangle surround the plugs evenly. 
When the rectangle surrounds the plugs, press J. 

5 Press Esc to return to the Edit Menu 

6 Choose Text. 

7 Choose Enter. 



8 Move the cursor to the right of the rectangle as shown below. 

g Type S & A Electrical Services. Don't press J. If you make a mistake, you can 
use the Backspace key to back up. If you want to adjust the position of the 
entire piece of text, use the cursor movement keys. 

10 When you finish typing the text, press Esc. 

1 1  Choose Accept. (If you want to erase the text and start it again, choose Undo 
instead and go back to step 7.) 

72 Press Esc twice to return to the Main Menu. 

13 Choose Save. At the prompt, type logo and press J. Inset saves the entire 
image with text to a new file named LOGO.PIX. 

Modifying the Image 
Next, you need to clip the image so that each time you insert it in a document, you 
won't insert all the extra blank space on the screen. The image may be printed in dif- 
ferent sizes on different printers, so you'll set its size in inches. Then you'll save the 
modified image. 

1 At the Main Menu, choose Modify. 

2 Choose Clip. 

3 The cursor, with the top and left clip lines, is at the upper-left corner of the 
screen. Press J to accept this position as the upper-left corner of the clipped 
image. 
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4 Move the cursor with the bottom and right clip lines. Position the clip lines so 
they surround the image and text and leave a little extra space. Press J when 
the clip lines are where you want them. 

S t B Elrrctrical Services 

5 At the Modify Menu, choose Expand. This command allows you to set the size 
of the printed image. 

6 Choose Inches. 

7 At the Enter Width: prompt, type 5.5 and press J. 

8 At the Enter Aspect Ratio: prompt, type 100 and press J. Any other number will 
alter the proportions of the printed image. 

9 Press Esc to return to the Main Menu. 

10 Choose Save. 

1 1  At the filename prompt, press J to accept the default filename, LOGO.PIX. 
Press J again to replace the LOGO.PIX file you saved earlier with a new one 
containing the modifications. 



Printing the Image 
If your printer is set up, you can print the image now. You'll use the lnset printing 
command. 

1 Choose Print at the lnset Main Menu. 

2 Choose Go. In a few seconds, your printer prints the image. It should look like the 
one shown below. (The appearance of the printed image varies slightly for different 
printers.) 

S & i3 Electrical Services 

3 After printing is complete, the lnset Main Menu appears. Press Esc to exit. 

Using the Image with WordStar 
If you want, you can use what you've learned in these lessons to use the LOGO.PIX file 
with WordStar. You can open a new file, or make room in an old one, and insert a pix 
tag for LOGO.PIX. 

Summary 
In these lessons, you've learned the main lnset operations. You're ready to start captur- 
ing your own graphics and printing them in your letters, memos, newsletters, and other 
documents. 

Any time you need to know more about Inset, use "lnset Reference." It contains com- 
plete instructions for everything you can do with Inset. 



Inset Reference 
"lnset Reference" gives detailed explanations of the lnset features, functions, and com- 
mands. Topics are arranged in alphabetical order. 

Borders 

.i 
P I 

I 

-#w 
Image w i t h  

Border 

You can put a border around 
any image. The border i s  a 
rectangular box one dot 
wide. It i s  placed around 
the image when you print, 
but is not shown onscreen. 
The actual border printed is 
one dot outside the image's 
edges, which are defined by 
the clip lines specified with 
the Clip command. If the w- 
image is  not clipped, its Image without 
edges are the edges of the Border 
screen when the- image is 
displayed. 

When you insert an image into a document, the space left for the image takes into 
account the border width if you are using a border with the image. To add or delete a 
border, first choose Modify at the lnset Main Menu. Then choose Border at the Modify 
Menu. lnset displays two options, Yes and No. The current setting is  highlighted. If 



you haven't used Border previously for this file, the current setting is the same as the 
setting in effect when you first saved the file. Choose Yes to print a border, or choose 
No to stop using a border. 

When you add or delete a border, be sure to save the modification. 

T I  p If you've inserted an image in a document, you can add or delete a border 
without displaying the image on your screen. While editing the document, display the 
pix tag for the image you want. Make sure it is the uppermost pix tag on the screen. 
Then start lnset and choose Modify. A box representing the image appears in the text, 
and a menu appears at the bottom of the screen. Choose Image. The Modify Menu 
appears. Choose Border. If you add or delete a border in this manner, your change is 
automatically saved; don't use the Save command. 

Capturing an image 
You can capture any image you can display on the screen. The image may be created 
with a graphics program, with Inset, or with a spreadsheet program. You must use lnset 
to capture an image before you can use the image in a document. Each captured image 
is stored in a pix file with the .PIX filename extension. 

To capture an image, use the Save command. First use your program to display the 
image on the screen. Then start lnset and choose Save at the lnset Main Menu. lnset 
asks you to enter the filename for the screen image. (If you've looked at a pix file since 
you loaded Inset, the name of the last file you saw is  displayed as the default.) Type 
the filename you want to use and press J. lnset saves the file and returns you to the 
Main Menu. 

When you type the filename, keep in mind the following rules: 

Include a drive letter or directory path if necessary. If you don't include the path, 
the file is saved in the current drive and directory (or the one chosen as the default 
pix file directory with the Setup program). 

You don't need to include the .PIX extension; lnset automatically adds it. You can 
also use the .SIC extension for a password-protected signature file (see Signature 
files). If you type an extension other than .PIX or .SIC, lnset substitutes .PIX. 

If you type a filename that is already in use, lnset asks if you want to replace the 
contents of that file with the image on the screen. Answer R (for Replace) to save 
the screen into the file, or C (for Cancel) if you don't want to replace the file. If you 
answer C, you are returned to the Main Menu, and you have to start the Save opera- 
tion again. 
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The capture-only version of lnset i s  useful for capturing images if the regular version 
doesn't fit in your computer's memory. To load capture-only Inset, type inset /c and 
press +I. When you start Inset, two options appear: Screen and Printer. Screen works 
like the Save command described above. Printer is  for use only with the Hewlett- 
Packard LaserJet printer and the Hijaak program. It saves output to the printer in an 
.HPC file for use with HiJaak. 

When you first capture an image into a pix file, the settings for the Modify Menu com- 
mands Rotate, Expand, Ink, Pass, and Border are the same settings as in the file you 
most recently saved. Before you save or print the new file, you may want to check 
these settings and change them as necessary, and you may also want to clip the image. 
You can quickly check the current settings for all these modifications by using the 
Status command on the Modify Menu. See Modifying an image. 

Clip art 
Clip art is a term used to describe a library of graphic images, which can contain logos, 
symbols, and other drawings. You can select, or clip, any of the images and use it in a 
document. lnset comes with several files of clip art: SYMBOLS.PIX, LOGOS1 .PIX, 
LOGOS2.PIX, LEISURE.PIX, EGALOGOS.PIX, DINGBATS.PIX, and BORDERS.PIX. 

Clip art packages for specific graphics programs are commercially available. If you 
have a graphics program, you may already have some clip art files and additional clip 
art is probably available. As with any graphics, if you can display clip art on your 
screen, you can capture it with lnset and insert it in your documents. Keep in mind 
that with Inset, you capture one screen of graphics at a time. If a clip art file is larger 
than one screen, you'll need to capture it in several files, one screenful at a time. 

Note: The lnset clip art files were created on a color screen, and EGALOGOS.PIX was 
created on a high-resolution color screen. These files may appear unclear on a 
monochrome screen or, with EGALOGOS.PIX, on a medium-resolution color screen. 
However, you can still clip and print these images at their original resolution. 

See Clipping an image and Importing an image for more information on how to use 
clip art. 

Clipping an image 
You can change the boundaries of an image with the Clip command. Only the area 
inside the boundaries is imported into other files, previewed, or printed. This area is 
always a rectangle, and it includes the area covered by the clip lines. 



The illustration above shows a file of clip art with one drawing clipped. The illustra- 
tion at the right shows how the clipped file looks when inserted in a document. 

T 1 P By changing the boundaries of the rectangle, you can change the height, width, 
and amount of white space surrounding the picture on the page. 

Before you clip an image, display the image on your screen and start Inset. Then use 
these steps: 

1 Choose Modify at the Inset Main Menu. 

2 Choose Clip at the Modify Menu. The menu disappears so you can see the entire 
image, and intersecting horizontal and vertical lines appear. The portion of the 
image between these clip lines is  the image to be imported or printed. The cursor is 
at the upper-left corner of the clip lines. 

3 Use the cursor movement keys to move the top and left clip lines to the positions 
you want. You can move these lines separately using the arrow keys or as a pair 
using the Home and PgDn keys. When both lines are in the positions you want, 
press J. The cursor moves to the lower-right corner of the clip lines. 

4 Use the cursor movement keys to move the bottom and right clip lines to the posi- 
tions you want, and press J. The Modify Menu reappears. 

T I  P If you change your mind after setting the upper-left corner, press Esc to move the 
cursor from the lower-right corner back to the upper-left corner. Pressing Esc when the 
cursor is at the upper-left corner returns you to the Modify Menu. 

You can change an image's clip lines as often as you want. When you change the clip 
lines, be sure to save the modification. 
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Note: Dots on the image that are covered by the clip lines are considered part of the 
clipped image. 

You can make a separate file that contains a portion of an existing pix file. This i s  use- 
ful, for example, if you expect to use one piece of art from a clip art library file often. 
There are two ways to save a clipped image in a separate file: 

Clip the existing pix file to include only the image you want. Then, when you're 
asked whether to save the file with modifications, answer yes and give it a different 
filename. 

Clip the pix file to include only the image you want, and save your modification, 
keeping the same filename. Return to the Main Menu, and choose Edit and Blank. 
Use Block and Import to insert the clipped image, then save it as a new file. This 
method allows you to change the size of the image. See also Importing an image. 

Colors 
If you have a color screen, you can capture, create, and edit graphics in color. You can 
choose the onscreen colors while you edit. 

You can also choose the color or shade of gray that will be printed for each screen 
color. For more information, see Printing with colors or shades of gray. For informa- 
tion on printing with a color printer, see Printers. 

When you draw graphics, you work with two colors, the Draw (primary) color and the 
Erase color, which is  used as a secondary drawing color and used for erasing areas. 
See Drawing for information on how to switch between the Draw and Erase colors. 
You can choose the Draw and Erase colors from a palette of available colors. 

On a CGA (color) screen, you can display up to four colors on the screen at a time. 
You can choose your Draw and Erase colors from the four colors on your current 
palette. You have the choice of six palettes of different color combinations. 

On an EGA (high-resolution color) screen, you can display up to sixteen colors at a 
time. You can choose your Draw and Erase colors from all sixteen colors. 

The Draw and Erase colors 
Changing the Draw or Erase color doesn't affect any graphics that are already dis- 
played. The new color is used only for new graphics that you draw. 

Follow the procedure below to change the Draw color or the Erase color: 

1 Display the Options submenu. You can either choose Options at the Edit Menu or, 
if you're already using an Edit Menu command for drawing, press F2. F2 allows 
you to change the color while drawing without losing your place. 

2 Choose Draw-Clr or Erase-Clr. Inset displays the choices you have for the color 
and prompts you to choose one. The current color is highlighted. 



The actual colors displayed depend on your graphics board, screen mode, and cur- 
rent palette (see "The palette" below). On the CGA using medium resolution, four 
colors are available on each palette; using high resolution, only black and white are 
available. On the EGA in high-resolution color mode, sixteen colors are available. 

Each of the sixteen EGA colors has several additional colors associated with it. 
When you highlight an EGA color, you can scroll through the associated colors 
using the up and down arrow keys. You can choose any of these colors by 
pressing J when it is displayed. 

3 Choose the color you want. After you choose the color, the Options submenu 
appears. 

4 Press Esc to return to the Edit Menu or to editing, depending on where you were 
when you displayed the Options submenu. 

Note: You can also use the Draw-Clr or Erase-Clr commands to change the back- 
ground color (normally black). Move the cursor to 0, then use the up and down arrow 
keys to scroll through the available background colors. Choose one of these colors by 
pressing J when the color is displayed. 

The palette 

A palette is a group of colors that can be shown on the screen at one time. The palette 
determines the colors you can use in your images for the Draw and Erase colors. 

The number of palettes available and the colors in the palettes depend on your graphics 
board and screen mode. On the CGA using medium resolution, six palettes are avail- 
able, each with four colors. If you have a black and white monitor, or if you're using 
the CGA in high-resolution mode, you have no choice of color combinations and can't 
use the Palette command. In this case, the palette is always two colors, black (0) and 
white (1). 

The chart below shows the four palettes available with the CGA in medium resolution: 

PALETTE COLOR 0 COLOR 1 COLOR 2 COLOR 3 

0 * Green Red Yellow 

1 * Brt. Green Brt. Red Brt. Yellow 
2 * Cyan Magenta White 
3 * Brt. Cyan Brt. Magenta Brt. White 
4 * Cyan Red White 
5 * Brt. Cyan Brt. Red Brt. White 

* Color 0 is the background color, generally black. 

With CGA color mode, you can change from one palette to another. When you 
change palettes, all the colors on the screen change to correspond to the new palette. 
Follow the steps below to change from one palette to another. 
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1 Display the Options submenu. You can either choose Options at the Edit Menu or, 
if you're already using an Edit Menu command for drawing, press F2. F2 allows 
you to change the color while drawing without losing your place. 

2 Choose Palette. lnset displays the choices, with the current palette highlighted. 

If you have an image onscreen, you can look at the different palettes available by 
using the arrow keys to move through the choices. As you highlight each palette 
number, the onscreen colors change to that palette's colors. You can see as many 
of the colors as are used in the image; if the current Draw, Erase, and Fill colors are 
not all the colors in the palette, or if the image doesn't include all the colors, you 
don't see all the palette's colors. 

3 Choose the palette you want, and press Esc to return to the Options submenu. 
Notice that the onscreen image is now made up of the colors in the new palette. 

4 Press Esc to return to the Edit Menu or to editing, depending on where you were 
when you displayed the Options submenu. 

The chart below shows the colors in the EGA palette in high-resolution color mode. 
You can modify this palette using the Display command on the Ink submenu of the 
Modify Menu. When you do this, the onscreen colors change to reflect your changes. 

0 Black 4 Red 8 Dark Gray C Light Red 
1 Blue 5 Magenta 9 Light Blue D Light Magenta 
2 Green 6 Brown A Light Green E Yellow 
3 Cyan 7 Light Gray B Light Cyan F White 

Converting a text screen to graphics 
You can capture a screen that was created in text mode. However, you can't use 
WordStar page preview to display a page that contains the image and you can't use the 
lnset editing commands on the image unless you first convert the image to graphics 
mode. 

To convert a text screen to graphics, first display the screen. Start lnset and choose Edit 
at the Main Menu. If the currently displayed screen is a text screen, three choices 
appear: View, Blank, and Convert. Choose Convert. lnset clears the screen, and con- 
tents of the screen reappear section by section in graphics mode. The Edit Menu 
appears at the bottom of the screen. You can now use lnset to edit the screen or to 
save it in a pix file. 

Note: If your graphics board does not support high-resolution color, some color infor- 
mation may be lost. 

For more information on text and graphics modes, see Screen modes. 

Copying a block 
When you're editing an image, you can copy a rectangular area, called a block, to 
another location on the screen. 



You can also copy a block from another pix file into your current graphics screen. See 
Importing an image. 

When you copy a block, it replaces any graphics at its new location. 

Before you copy a block of graphics, display the image and choose Edit at the lnset 
Main Menu. Then follow the steps below to mark and copy the block. 

1 Choose Block. 

2 At the Block submenu, choose Copy. The menu disappears so that you can define 
the block. 

3 Move the cursor to the point you want to be one corner of the block and press J. 

4 Move the cursor to the point you want to be the opposite corner and press J. lnset 
displays a border that shows you the defined area. 

Note: If you want to change the block borders before copying the block, press Esc. 
The marked block disappears, and you can mark both corners again. 

5 Move the cursor to the point where you want to move the upper left corner of the 
copy of the block. Notice that a copy of the block border moves with the cursor to 
show you the new location. When the cursor i s  in the correct location, press J. 
The block is  copied. 

Marked block 

L 
Copied block 

6 You can continue to move the cursor to make additional copies of the block; just 
press J at the location for each copy. 
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block to copy or press Esc again to return to the Block submenu. At the Block sub- 
menu, press Esc to return to the Edit Menu. 

After you copy a block, be sure to save the modification before you exit Inset. 
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Creating an image 
lnset allows you to create your own images. You can create an image with the lnset 
Edit Menu drawing commands or by importing an image from another pix file and, if 
you want, editing it. 

To create a new graphic image, you first must clear the screen. Depending on where 
you start, you use one of two commands to clear the screen. Use Blank when the cur- 
rent screen is a text screen; for example, when you are starting lnset and don't have a 
pix file displayed. Use Clear when the screen is  already in graphics mode; for exam- 
ple, when you are editing an image and want to quit without saving it and create a new 
image. Each of these commands is described below. 

Note: You can't create an image if you've loaded the small version of Inset. (See 
"Q Version" in "Changing the Setup Options.") The small version is  loaded automati- 
cally if you have a monochrome screen without graphics editing capabilities. 

To clear a text screen, choose Edit at the lnset Main Menu. Three choices appear: 
View, Blank, and Convert. Choose Blank. A menu of the available screen resolutions 
appears, with the most recently chosen resolution highlighted. Choose the appropriate 
resolution (see "A Screen" in "Changing the Setup Options" if you need more informa- 
tion about your available resolutions). A blank screen appears, with the Edit Menu dis- 
played at the bottom of the screen. 

To clear a screen while you're editing without leaving editing mode, choose Options at 
the Edit Menu (or press F2 while drawing). Choose Clear at the Options submenu. A 
menu of the available screen resolutions appears, with the most recently chosen resolu- 
tion highlighted. Choose the appropriate resolution (see "A Screen" in "Changing the 
Setup Options" if you need more information about your available resolutions). A 
blank screen appears, with the Options submenu at the bottom of the screen. Press Esc 
to return to the Edit Menu. 

C A U T 1 0  N Don't use the Clear command while you are editing an image if you 
want to save your changes to the image. When you use Clear, you can't save the cur- 
rent screen. 

Note: The Clear command does not explicitly change the current colors, but it may do 
so indirectly through palette changes. For example, if you move from a color mode to 
a monochrome mode and back, the default palette is used. If you were using a palette 
other than the default, the colors displayed are different. You need to choose the 
appropriate palette to return to the colors you were using. See Colors. 

Once your screen is cleared, you can use the appropriate Edit Menu commands to 
create or import your graphics. For more information, see Drawing, Editing graphics, 
and Importing an image. 

When you first create a pix file, the settings for the Modify Menu commands Rotate, 
Expand, Ink, Pass, and Border are the same settings as in the file you most recently 
saved. Before you save or print the new file, you may want to check these settings and 
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change them as necessary, and you may also want to clip the image. You can quickly 
check the current settings for all these modifications using the Status command on the 
Modify Menu. See Modifying an image. 

Displaying an image 
Before you edit or clip an image in a pix file, you must display it on the screen. 

To display the image in a pix file, choose View at the lnset Main Menu. lnset asks you 
to enter the filename of the image and displays the filename of the last file viewed or 
saved as the default. If you haven't viewed or saved any pix files since you loaded 
Inset, lnset displays a list of the .PIX files in the current directory (or the directory 
chosen as the default pix file directory with the Setup program). 

Press J to accept the default filename, move the cursor to the filename you want and 
press J, or type the filename you want and press J. The image appears on the screen. 
You can use any lnset commands to edit and modify the image. 

T I  P If the directory contains more files than fit on the bottom line o f  the screen, you 
can use the left and right arrow keys to scroll horizontally through the additional 
filenames. 

Use the following guidelines for entering filenames: 

Include a drive letter or directory path if necessary. If you don't include the path, 
lnset looks for the file in the current drive and directory (or the one chosen as the 
default pix file directory with the Setup program). 

You don't need to include the .PIX extension; lnset adds it automatically. The only 
other extension allowed is .SIG. You can't view a file with any other extension. 

If you're not sure of a filename, you can use the wild-card characters * and ? to dis- 
play a list of filenames. For example, to see the names of all the .PIX files in the 
current directory, press * and press J (Inset adds the .PIX extension). To see all the 
pix filenames that begin with D and are in the \CHARTS directory, type \charts\d* 
and press J. To see all the pix filenames that begin with TEST and have two more 
characters, type test?? and press J. lnset displays a list of matching filenames, and 
you can choose one of the files. 

If you need to edit a displayed filename, you can use the t, +, Del, Backspace, 
Home, and End keys. Press when you're ready to enter the filename or press Esc 
to exit. 
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If the pix file you name was created with a higher-resolution screen mode than is  avail- 
able on your screen, a prompt tells you that screen conversion is required and asks if 
you want to proceed. If you answer yes, you must specify next what screen resolution 
you want it converted to (if you have a choice of resolutions on your system). lnset 
converts the file and displays it section by section in the new lower resolution. 

If an image was created with a higher-resolution screen mode and you convert i t  to dis- 
play it on your screen, you can use the Modify Menu commands for the image without 
losing the higher resolution. When you save the modified image using the image's 
original filename, lnset saves the new Modify settings to the original higher-resolution 
image. 

C A U T lo N Be careful making changes to an image you convert to lower resolution 
to display. If you choose Edit, a warning message appears. If you use any Edit Menu 
commands and save the image with the editing modifications, the new pix file wi l l  
have lower resolution than the original one and will also print with lower resolution. 

If you choose a file with the .SIC extension, you must enter a password before you can 
view the file. Type the password and press J. If the password is incorrect, the image 
that appears is incorrect. (See Signature files for details on .SIG files.) 

Note: If you choose Edit at the Main Menu and the current screen is not a graphics 
screen, the menu that appears contains the View command. You can choose View at 
this menu to view a file with the Edit Menu already displayed for editing. 

T I  P While you're using an lnset Edit Menu command, you can View another file by 
pressing F9. However, when you display another file, you lose any modifications you 
have made to the first image, so use F9 with caution. 

Drawing 
With Inset, you can draw lines, rectangles, circles, and ovals, and you can draw with 
individual dots. You can draw within an existing image, or you can clear the screen 
and create a new image. 

To start drawing on an existing image, display the image. Be sure you've already cap- 
tured the image in a pix file. Then start Inset, choose Edit, choose View, and choose 
the file to view. The image appears with the Edit Menu. 

To create a new image, start Inset, choose Edit, choose Blank, and choose the screen 
mode you want to use. lnset clears the screen and displays the Edit Menu. 

You can choose the colors and line widths you use for drawing, using the Options sub- 
menu commands. When you change colors or line width, the changes are in effect for 
all the Edit Menu drawing choices until you change them again. For more information 
on colors, see Colors. Line widths are explained later in this section. 



Drawing lines 
Follow these steps to draw lines: 

1 Choose Line at the Edit Menu. The mew disappears. 

2 Move the cursor to the point where you want to start the first line and press J. 

3 Move the cursor to the point where you want the line to end. Notice that a flexible 
line is displayed to show you how the line will look. (This line is always white, no 
matter what color you're using.) When the cursor i s  in the correct position, press J. 

PICK STlRTING POINT T, MOUE VIEW FLEXIBLE CURSOR BND LINE 

'.t 

PICH END POINT 
TO FREEZE LINE 

4 Repeat this process for as many lines as you want to draw, then press Esc to return 
to the Edit Menu. 

Lines are always drawn in the Draw color. 

Drawing rectangles 

Follow these steps to draw rectangles: 

1 Choose Rect at the Edit Menu. lnset displays a prompt asking whether you want to 
fill the rectangle with a pattern. 

2 If you don't want to fill the rectangle, choose No. 
If you want to fill the rectangle, choose Yes. lnset displays 16 choices of patterns. 
You can move the cursor between the choices to see a description of each pattern. 
Choose a pattern and press J. lnset prompts you to choose the primary and secon- 
dary (background) colors for the pattern. The default or current colors are 
bracketed. Choose the colors you want and press J. 
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3 Move the cursor to the point where you want one of the corners of the rectangle 
and press J. 

- - - - - -  - . 
PICK FIRST CORNER POINT 

MOVE CURSOR 
AND VIEW 
FLEXIBLE BOX 

PICK SECOND 
CORNER POINT 

4 Move the cursor to the point where you want the opposite corner of the rectangle. 
Notice that flexible lines are displayed to show you how the rectangle will look. 
(These lines are always white, no matter what color you're using.) When the cursor 
i s  in the correct position, press J. 

5 Repeat this process for as many rectangles as you want, then press Esc to return to 
the Edit Menu. 

Rectangles are always drawn in the Draw color. 

Drawing circles and ovals 

Follow these steps to draw circles and ovals: 

I Choose Circle at the Edit Menu. lnset displays a prompt asking whether or not yo11 
want to fill the circle with a pattern. 

2 If you don't want to fill the circle, choose No. 

If you want to fill the circle, choose Yes. lnset displays 16 choices of patterns. You 
can move the cursor between the choices to see each pattern. When you choose a 
pattern, lnset prompts you to choose the primary and secondary colors for the pat- 
tern. (The default or current colors are highlighted.) Choose the colors you want 
and press J. 

3 Move the cursor to the point where you want the center of the circle or the oval and 
press J. 



4 Move the cursor to a point on the circle or oval. Notice that a circle or oval is dis- 
played to show you how the final one will look. (This circle is always white, no 
matter what color you're using.) If the second point you chose is approximately the 
same distance horizontally and vertically from the center, the shape is a circle. If 
the horizontal and vertical distances are different, the shape i s  an oval. When the 
cursor is in the correct position, press J. 

PICM CENTER POlNT 

MOVE CURSOR bND 
UIEW FLEXIBLE 
CIRCLE 

PICK END POlNT 
TO FREEZE CIRCLE 

5 Repeat this process for as many circles as you want, then press Esc to return to the 
Edit Menu. 

Circles are always drawn in the Draw color. 

Drawing with dots 

You can place individual dots on your graphics screen and you can draw continuously 
with a series of dots. The continuous drawing i s  especially useful with a mouse. 

This sand was 
drawn with 
individual dots. 

I I 

j j LOW, 
i i 
I ' 

j j 

/ i 

This signature was drawn with 
continuous dots , 
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A dot is the smallest unit of space you can use on a graphics screen. It is the same as a 
pixel and is actually a tiny square. The number of dots on a screen depends on your 
graphics board and current screen resolution. The dots you draw with the Edit Menu 
Dots command can be bigger than one dot, depending on the current width setting. 
For example, if the current width is 3, the dots you draw are small squares with sides 
three dots long. 

Follow these steps to draw with dots: 

1 Choose Dots at the Edit Menu. The menu disappears. 

2 Move the cursor to the point where you want the first dot. To enter a dot in the 
Draw color, press J. The dot appears at the point you chose. To enter a dot in the 
Erase color, press the Spacebar. 

To draw continuously in the Draw color, press +, then move the cursor wherever 
you want to draw. A continuous line of dots appears wherever you move the cur- 
sor. To change from continuous drawing to single dots, press + again. To draw 
continuously in the Erase color, press - (hyphen or minus sign). To change back to 
single dots, press - again. 

3 When you're finished entering dots, press Esc to return to the Edit Menu. 

If any of the dots you enter are out of place or if you want to change the color of some 
dots, you can use the Magnify command for detailed dot-by-dot editing. See Magnify- 
ing an area. 

Changing the line width 
You can change the size of the dot or line used to draw dots, lines, rectangles, and 
circles. Follow these steps: 

1 Display the Options submenu. You can either 
choose Options at the Edit Menu or, if you're 
already using an Edit Menu command for drawing, 
press F2. F2 allows you to change the width while 
drawing without losing your place. 

2 Choose Width. 

Inset displays the eight available widths, 1 through 
8. The width is the number of screen dots in the line 
or dot. The default i s  1, which produces a line 1 dot 
wide. If you change it, for example, to 4, a dot you 
enter with the Dot command is 4 dots tall and 4 dots 
wide, and a line is 4 dots wide. 

3 Choose the width you want. After you choose the 
width, the Options submenu appears. 

r 

LINE C(1I)THS 

1 
2 

3 

4- 

5- 

6- 

7- 

8- 

4 Press Esc to return to the Edit Menu or to editing, depending on where you were 
when you displayed the Options submenu. 
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When you draw with a line width other than 1, the flexible line you see when you 
move the cursor is still one dot wide. After you press J to accept the cursor position, 
the line, rectangle, or circle appears in the width you chose. 

Editing graphics 
lnset includes complete graphics editing functions. You can create your own images 
and edit existing images, including those created with other graphics programs. 

The commands for editing are on the lnset Edit Menu. To display the Edit Menu, start 
lnset and choose Edit. 

You can't use lnset to edit a text screen, so if you choose Edit when your screen is in 
text mode, lnset displays three choices: View, Blank, and Convert. You must use one 
of these commands to display a graphics screen. Once you display a graphics screen 
with one of these commands, the Edit Menu appears. See Converting a text screen to 
graphics, Creating an image, and Displaying an image, for further information. 

The Edit Menu commands enable you to draw lines, rectangles, circles, and dots; view 
and edit a magnified section of an image; enter text; copy, move, and import blocks of 
graphics; fill an area; erase an area; and change your drawing colors and line width. 
For more information, see Colors, Copying a block, Drawing, Erasing an area, Filling 
an area, Importing an image, Magnifying an area, Moving a block, and Text. 

If you don't use lnset for editing, you can install the Small version of Inset, which has 
no editing capabilities. You can choose the Small version by changing a setup option. 
See "Q Version" in "Changing the Setup Options." 

If you have a monochrome screen without graphics capabilities, you can't edit 
graphics. 

Erasing an area 
You can erase the graphics contained in a rectangular area of an image you're editing. 
Use the Erase command. 

The Erase command fills the enclosed area in the Erase color. The default Erase color i s  
black, your screen background. You can use the Erase-Clr command on the Options 
submenu of the Edit Menu to change the Erase color. See also Colors. 
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marked to be is erased. 

T I  P While you're erasing, you can change the Erase color quickly by pressing F2, 
choosing Erase-Clr, and choosing the new color. 

Before you use the Erase command, display the image and the Edit Menu. Then choose 
Erase. Move the cursor to one of the corners of the area to be erased and press J. 
Move the cursor to the opposite corner of the area to be erased. Notice that flexible 
lines are displayed to show you the area. When the cursor is in the correct position, 
press J. The area is erased. 

Repeat this process for all the areas you want to erase, then press Esc to return to the 
Edit Menu. You can also erase graphics dot by dot by using the Magnify command and 
changing the dots to the background color. See Magnifying an area. 

Exiting lnset 
To exit Inset, press Esc at the Main Menu. The menu disappears and you're returned to 
where you were before you started lnset (WordStar, another program, or the operating 
system). 

If you want to exit while at one of the other menus, first press Esc as many times as 
necessary to display the Main Menu. 

If you've been editing an image and haven't saved your changes, lnset displays a 
prompt, and you must say whether you want to save the image with modifications. 

lnset remains in memory after you exit, unless you loaded it with the WordStar com- 
mand Utilities, lnset (Alt+U,I) or AP&. To remove lnset from memory, start from the 
DOS prompt in the directory or drive where the lnset files are located. At the DOS 
prompt, type r i  (for remove inset) and press J. A message tells you that lnset i s  freed 
from memory. 

Note: You can't remove lnset from memory if you've loaded any other memory- 
resident program since you loaded Inset. In this case, you must either remove the other 
program from memory before removing lnset or reboot your computer. 



Filling an area 
You can use lnset to fill an enclosed area of an image, or to fill the background around 
any enclosed areas. You can fill an area using any color available on your current 
palette (see Colors). 

Before you fill an area, display the image on the screen and choose Edit to display the 
Edit Menu. Make sure the area you plan to fill is totally enclosed. Even a one-dot gap 
in the outline will cause the filling to leak outside the area. If you're not sure whether a 
gap exists, magnify the outline to make sure all the dots in the outline are adjacent to 
each other, either horizontally, vertically, or diagonally (see Magnifying an area). 

Follow the steps below to fill the area: 

1 Choose Fill at the Edit Menu. lnset displays the choices for the fill color. 

Note: You can change the fill color only by choosing Fill; changing the Draw or 
Erase color has no effect on the Fill color. 

2 Choose the color you want and press J. The menu disappears. 

3 Move the cursor to a point on the line where you want the fill to start and press J. 
If you want to fill an enclosed area, make sure the cursor i s  within the area. If you 
want to fill outside an enclosed area, make sure the cursor is outside the area. 

lnset fills the area with the color you chose. It fills one line at a time, moving 
downward. If the area extends above where you started, it then starts to fill 
upward. 

If you want the filling to stop before the area is  entirely filled, press A. If you use J 
to stop the filling, the last line of the fill i s  considered a boundary line for subse- 
quent fill operations. 

4 After you finish filling, you can move the cursor to another location to fill, or you 
can press Esc to return to the Edit Menu. 
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The Fill command allows you to fill an area only with a solicl color. You can also fil l 
rectangles and circles with patterns when you create them. See Drawing. 

Fonts 
When you use lnset to add text to an image, you have your choice of several fonts. See 
Text. 

Function keys 
Several function keys can make using lnset easier: 

F1 Pressing F1 while an lnset menu IS on the 
screen displays help for the menu. 

F2 While you're edltlng an Image uslng an 
lnset Edit Menu command such as Rec- 
tangle, Line, or Circle, F2 takes you to the 
Optlons submenu of the Edlt Menu. You 
can change the Draw or Erase color, the 
color palette, or the line width, or you can 
clear the screen. When you're finished 
w ~ t h  your changes, press Esc to return to 
where you were before you pressed F2. 

F9 While you're editlng an Image uslng an 
lnset Edit Menu command, F9 allows you 
to qu~ckly d~splay another pix file. A prompts asks you to enter a filename. As 
soon as you name the frle, the screen you were edltlng disappears, and the new 
file IS d~splayed. Be caretul when you use F9: you lose any changes you made to 
the original screen and didn't save. F9 IS useful for going back to the most 
recently saved version of a file, if you decide not to save the editing changes 
made slnce the last time you saved the file. 

F10 While you're editing a graphics image using an lnset Edit Menu command, F10 
allows you to quickly save the current image. It's useful with F9 for saving 
changes you want and discarding changes you don't want. 



Help 
For detailed help at any lnset menu, press F1. To display an overview of the lnset help 
system, choose Help at the lnset Main Menu. 

Press any key to leave a help screen and return to the menu you started from. 

Importing an image 
You can import (insert) part or all of another pix file into your current graphics screen. 
The image you import is called a block. 

When you import a block, you give the filename of the pix file to import. The clipped 
area of the file is considered the block to import. This allows you to import only the 
part of the file you want. 

An imported block replaces any graphics at its new location. 

Before you import a block, make sure the clip lines in the pix file to import mark the 
portion of the file you want. (The area imported includes the area covered by the clip 
lines.) Next, display the file you want to import the block into, and choose Edit to dis- 
play the Edit Menu. Then follow these steps: 

1 Choose Block. 

2 At the Block submenu, choose Import. lnset asks for the name of the file to import. 

3 At the filename prompt, type the name of the file to import and press J. A box rep- 
resenting the image appears on the screen. 

4 Use the arrow keys to move the box to the appropriate location. 

5 If the box is the correct size, press J. The block is inserted. 
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If you want to change the size of the image, press the Spacebar to set the location 
of the upper-left corner of the image. The cursor moves to the lower-right corner. 
Use the cursor movement keys to change the box so it is the correct size, then 
press J. lnset inserts the block. 

Note: When you change the size of the block, you can change the proportions of 
the image. If you don't want to distort the image, be careful when changing the 
size. 

6 You can press J to import another block or press Esc to return to the Edit Menu. 

After you import a block, be sure to save the modification. 

If you import a pix file that was created with a different graphics board or screen mode, 
lnset automatically converts the image information to fit the current hardware and 
screen mode. 

The Block Import command gives you easy access to clip art libraries and any other 
graphics you can capture or create with Inset. See Lesson 2 in "Learning Inset" for an 
example using clip art from the SYMBOLS.PIX file. 

Inserting an image into a pix file 
See Importing an image. 

Inserting an image into text 
Before you can insert an image into text, you must use lnset to capture the image into a 
pix file. See Capturing an image. 



To insert an image into a WordStar document, first put the cursor where you want the 
upper-left corner of the image. Choose Insert, Graphic (Alt+l,G) or use the "P* classic 
command. WordStar prompts you for the name of the pix file and displays the names 
of the pix files in the lnset directory. Move the highlighting to the filename you want or 
type the filename and press J. Include a drive letter or directory path if the file is not in 
the lnset directory. You don't need to include the .PIX filename extension. WordStar 
places a pix tag in the text. The pix tag consists of the name of the pix file (including 
the path) enclosed in brackets. Three sample pix tags are shown below: 

[\WS\INSET\MAP.PIX] 

[\ws\art\chart2.PIX] 

[b:newgraph.PIXl 

When you use WordStar to print the document, each time WordStar finds a pix tag, it 
calls lnset to print the image. 

Use the following guidelines to place the image correctly: 

If you want text next to the image, leave blank space where you want the image. 
You can use margin changes, tabs, and hard carriage returns to adjust the text. 

w If you don't want text next to the image, insert enough blank lines to make space for 
the image. 

m If you want the image superimposed on the text, just put the pix tag where you 
want the upper-left corner of the image. 

w Be sure the entire image is  contained on one page. If a page break falls in the 
middle of the image, move the pix tag or insert a page break before the pix tag. 

w With non-page printers (including all dot matrix printers), you can insert only one 
image in the same horizontal space. If two pix tags are inserted so that both images 
are on any line, only the first image will be printed. With laser printers, lnset can 
print side-by-side images. 

After you type the pix tag and adjust the text, it's a good idea to check the image place- 
ment with page preview in WordStar. If the image doesn't look the way you expect, 
you can start lnset and change the image. First make sure the entire pix tag is on the 
screen. If necessary, scroll the text so you can see the entire area where the image 
appears. Then choose Utilities, lnset (Alt+U,I) or use the "P& classic command to start 
Inset. The lnset Main Menu appears, and a box appears where the image is inserted. 
The image's size in rows and columns is shown with the pix tag at the top of the box. 
You can change the image in a number of ways, including its size. See Modifying an 
image and Size. 

Note: The box on the screen may not be in exactly the same position relative to the 
text as it is in page preview. Differences can be caused by onscreen commands or 
proportionally spaced fonts. 
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If no image appears in page preview, check the pix tag. You may need to correct the 
filename or add a path. If a message tells you the file i s  improper and you can't 
preview the page, you probably captured the image in text mode. Before you can 
preview the page, you must use the Inset Convert command to convert the image to 
graphics mode. See Converting a text screen to graphics. 

With some dot matrix and other non-page printers, the line height of the text next to an 
image may be changed when you print. With these printers, text next to images must 
have a line height of 6 lines per inch or multiples of that (3, 2, or 1 lines per inch). If 
you specify another line height, the closest available line height will be used. 

Magnifying an area 
You can enlarge a section of your graphics image to examine or edit dot by dot. This 
capability allows you to make your image look exactly as you want it. 

First, start Inset, display the image, and display the Edit Menu. Then use the following 
steps: 

I Choose Magnify at the Edit Menu. The menu disappears and a square 21 dots high 
by 21 dots wide appears. 

2 Use the cursor movement keys to move the square to enclose the area you want to 
magnify, then press J. The area appears magnified on the screen, with each dot of 
the image clearly shown. The cursor is inside the magnified area so that you can 
edit it. 

I ndependent Associates 

Income Composition 

Sales Costs 

Product Costs 
2 2 %  

Profit 
1 1 %  



3 Make any changes you want. To change a dot to the current Draw color, place the 
cursor on the dot and press J. To change a dot to the current Erase color, place the 
cursor on the dot and press the Spacebar. To change every dot you place the cur- 
sor on to the Draw color, press +. To change back to single dots, press + again. To 
change every dot you place the cursor on to the Erase color, press - (hyphen or 
minus sign). To change back to single dots, press - again. 

To delete dots, make sure the secondary color is the same as the background color 
(usually black), then use the Spacebar or the - key as described above. 

You can change the current colors while editing a magnified area. Just press F2 to 
display the Options submenu and choose Draw-Clr or Erase-Clr. (For more infor- 
mation, see Colors.) 

4 When you're finished editing, press Esc. You can use the cursor movement keys to 
move the Magnify square to another location and press J to magnify the area, or 
you can press Esc again to return to the Edit Menu. 

Menus 
The lnset commands are on menus. The lnset Main Menu pops up at the bottom of the 
screen each time you start Inset. You use the Main Menu to access any commands you 
need. 

Some commands display submenus of other commands. The menus and submenus are 
in a tree structure, which is  shown in "The lnset Menus" in "Getting Started." The most 
important submenus of the Main Menu are the Modify Menu and the Edit Menu. For 
more information about these menus, see Editing graphics and Modifying an image. 

Each menu takes up the bottom two lines of the screen. The top line of each menu 
shows the commands you can choose. The bottom line shows a description of the 
highlighted command. 

You can clear the lnset menus from the screen whenever you want to see the two bot- 
tom lines of an image. Choose Modify at the Main Menu, then choose NoMenu. The 
menu disappears. You can look at the image, but you can't use any commands. When 
you're finished looking at the image, press Esc or J to return to the Modify Menu. 

Modifying an image 
There are two types of modifications you can make to an image, graphics editing 
changes and modifications for printing. 

The graphics editing changes are visible on the screen and actually change the image. 
The editing changes are summarized under Editing graphics. 

The modifications you can make with the Modify Menu commands affect how the 
image will be printed. They don't change the onscreen appearance of the image. 

To display the Modify Menu, choose Modify at the lnset Main Menu. 
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If a pix tag is  on the screen, lnset first displays a menu with three commands: Image, 
ReSize, and Preview. For an explanation of ReSize, see Size. For an explanation of 
Preview, see Previewing. If you choose Image, the Modify Menu appears. You can 
use the Modify Menu commands for the uppermost image on the screen. 

The Modify Menu commands allow you to clip an image; rotate an image; change the 
size of an image; change the colors or shades of gray for the printed image; tell the 
printer to make two passes for the image; and add or delete a border around the image. 
All these modifications take effect when you print. Clipping also takes effect when you 
import the image into another file. 

For more information on these commands, see Clipping an image, Rotating an image, 
Size, Printing in colors or shades of gray, Printing, and Borders. 

Another Modify Menu command, Status, displays the current settings of these modifica- 
tions. Use it if you want to check the status of the image. 

The Modify Menu also contains the NoMenu command, which removes the menu from 
the screen until you press J or Esc. This allows you to view the bottom of the image, 
which is usually covered by the lnset menus. 

T I  P You can modify the image represented by an onscreen pix tag without displaying 
it. After you choose Image just choose the command you want to use. You can, for 
example, add a border or change the gray levels for printing. The only Modify Menu 
command you can't use like this is Clip, since you can't change the clip lines without 
displaying the image. When you modify an image in  this manner, your change is 
automatically saved. Don't use the Save command to save a modification unless the 
image is on the screen. 

Mouse 

If you have a mouse, you'll find that using it with lnset can 
increase your speed and your editing capabilities. lnset 
supports the use of the Microsoft, Logitech, Manager 
Mouse, Mouse Systems, or equivalent mouse. If you use a 
mouse, you must run your mouse driver before you load 
Inset. 

After you start Inset, you can move the mouse horizontally 
to move to the menu selection you want. In menus and 
while editing graphics, the mouse buttons have the follow- 
ing functions: 

left button: J 
right button: Esc 
middle button (three-button mouse only): Spacebar 



Moving the mouse has the same effect as using the arrow keys to move the cursor. This 
feature is especially useful when drawing graphics with the Dots command (see 
Drawing). 

Moving a block 
When you're editing an image, you can move a rectangular area, called a block, to 
another location on the screen. 

When you move a block, it replaces any graphics at its new location. 

Before you move a block of graphics, display the image and choose Edit from the lnset 
Main Menu. Then follow the steps below to mark and move the block: 

1 At the Block submenu, choose Move. The menu disappears so you can define the 
block. 

2 Move the cursor to the point you want to be one corner of the block and press J. 

3 Move the cursor to the point you want to be the opposite corner and press J. lnset 
displays a border that shows you the defined area. 

Note: If you want to change the block borders before moving the block, press Esc. 
The marked block disappears and you can mark both corners again. 

4 Move the cursor to where you want to move the block. Notice that a copy of the 
block border moves with the cursor to show you the new location. When the cur- 
sor is in the correct location, press J. The block is moved. 

Marked block Moved hlock 

5 If you want to adjust the location of the block, move the cursor to the new location 
and press J. 

6 When you're finished moving the block, press Esc. You can now mark another 
block to move or press Esc again to return to the Block submenu. At the Block sub- 
menu, press Esc to return to the Edit Menu. 

After you move a block, be sure to save the modification before you exit Inset. 
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Offsetting an image 
Within a WordStar document, the position of an image is determined by the position of 
the pix tag. If you need to adjust the position, you can generally just move the pix tag. 

If you're printing an image that isn't in a document, you can offset the image from the 
left edge of the paper by using the Offset command. Choose Output at the lnset Main 
Menu, then choose Offset at the Output submenu. Specify the page offset (the col- 
umns left blank at the left side of the page) you want to use for the image and press J. 

T I  P The Offset command is useful if the image appears too far to the right or to the 
left when you print the screen. Assigning a negative offset moves the image to the left; 
assigning a positive offset moves the image to the right. 

Pitch 
The lnset pitch setting determines the width of columns when you specify image size in 
columns. The default pitch i s  10 characters per inch (CPI). This is standard for most 
printers. If you set the size of images in columns, or if you use column numbers to 
determine where to place pix tags, you need to make sure that the lnset pitch setting is  
the same as your printer pitch setting. For example, if an image's width is set to 24 
columns and if the pitch is 10 CPI, the image will be 2.4 inches wide; if the pitch is 12 
CPI, the image will be 2 inches wide. 

You can set your usual pitch using the lnset Setup program. See "I Pitch" in "Changing 
the Setup Options." You can also change the pitch using the Pitch command. Choose 
Output at the lnset Main Menu, then choose Pitch at the Output submenu. Specify the 
pitch in characters per inch and press J. 

Pix files 
You must capture an image with the lnset Save command before you can use the image 
in a document. When you capture an image, the file you save it in i s  called a pix file. 
A pix file has the .PIX filename extension. 

If you keep most or all of your pix files in one drive or directory, you can have lnset use 
that drive or directory as the default for viewing and saving pix files. If you haven't 
already viewed a file since loading Inset, when you choose View, a list of files in the 
default directory is displayed. When you save a file, it is saved in the default directory 



unless you type another path. If you don't name a default directory, files are viewed 
and saved in the current drive or directory. The pix files supplied with lnset are usually 
in the \WS\INSET directory, and WordStar displays the pix files in that directory when 
you use Insert, Graphic (Alt+l,G) or the A P *  classic command to insert an image. You 
may want to use the \WS\INSET directory as the default. See "J Pix directory path" in 
"Changing the Setup Options." 

You can password-protect a pix file. A password-protected pix file has the .SIG exten- 
sion and is called a signature file. See Signature files. 

Note: Pix files are stored in compressed format to conserve disk space. These files are 
not compatible with the BSAVEIBLOAD file dumps of screen memory used in BASIC 
and many other graphics packages. You must use lnset to load compressed pictures 
into programs that use the BLOAD format. However, lnset can read the BLOAD format 
files, so you don't need to convert all your files immediately for use in documents. 
Only lnset pix files contain information about rotation, size, or clipping, so you must 
save a file with lnset to include these modifications. 

Pix tags 
To insert an image into a document, you use the WordStar Insert, Graphic (Alt+l,G) or 
the A P *  classic command, which inserts a pix tag in your text. The pix tag consists of 
the name of the pix file, including the drive letter or directory path, enclosed in brack- 
ets. 

Note: You must use the Insert, Graphic (Alt+l,G) or the "P* classic command to enter 
a pix tag; you cannot type a pix tag directly into the text. 

When you use WordStar to print the document, each time it finds a pix tag, it calls lnset 
to print the image at the location of the pix tag. The tag itself is not printed. 

For more information, see Inserting an image into text. 

Pixels 
A pixel is the smallest unit of space available on a graphics screen. The number of 
pixels on a screen depends on the screen resolution. For example, with a color 
graphics adapter set to medium resolution, the screen is 320 pixels wide by 200 pixels 
high. For more information on screen resolution, see Screen modes. 

When you use lnset to edit an image, you can change the screen pixel by pixel using 
the Edit Menu commands Dots and Magnify. See also Drawing and Magnifying an 
Area. 

Pop-up keys 
The pop-up keys (sometimes called hot keys) are two or three keys you press at the 
same time to start Inset. Generally, they are LShift and Ctrl; these are the keys you use 
to start lnset from your operating system and from many other programs. (The LShift 
key is the Shift key on the left side of the keyboard.) From within WordStar, you use 
Utilities, lnset (Alt+U,I) or the "P& classic command to start Inset. 
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Some programs don't tell lnset what screen mode is being used. So that you can use 
lnset in these programs, lnset can override the current screen mode and change it to the 
appropriate mode. The override pop-up keys, Alt, LShift, and I, tell lnset to change the 
screen mode. If you use LShift-Ctrl in a program and something happens, but the lnset 
Main Menu doesn't appear properly, you can try Alt-LShift-I. If Alt-LShift-l doesn't 
work the first time you press it, try using it several times in a row. When you try it 
several times, it rotates through the available screen modes, trying each mode in turn. 
When you find the correct mode, lnset saves it as the new default. (See also "13 Screen 
Mode" in "Changing the Setup Options.") 

If you prefer to use different keys for the pop-up keys or the override pop-up keys, you 
can change the pop-up keys. See "L Default Pop-up Keys" and "M Override Pop-up 
Keys" in "Changing the Setup Options." 

See also Printing. 

Previewing 
After you insert an image into your text, you have two ways to preview the text and 
graphics on your screen, WordStar page preview and the lnset PreView command. 
With page preview, you can preview a full page; with the Preview command, you can 
preview the current screen of text and images. 

If you use page preview, you cannot display a page that contains an image created in 
text mode. However, you can use the lnset Convert command to convert the text 
image to graphics mode so you can preview it. See Screen modes and Converting a 
text screen to graphics. 

Note: The first time you preview an image with page preview, WordStar creates a file 
that contains information about the image. The file has the same filename as the pix 
file with the extension .WSG and is  stored in your lnset directory. If you zoom in on 
the image, WordStar also creates a file for each zoom level. These files have the exten- 
sion .Gn$, where n is a number indicating the zoom level, and are stored in the CRT 
directories created by page preview. The .WSG and .Gn$ files are used whenever you 
preview a page that contains that image. You can delete these files when you're 
finished with them to save disk space. 

Before you use the lnset PreView command, be sure the entire image area is on the 
screen. Then choose Utilities, lnset (Alt+U,I) or the AP& classic command to start In- 
set. lnset displays a box to mark the image's location. (If the entire box isn't on the 
screen, exit lnset and scroll your display so the box will fit, and then start lnset again.) 
Then choose Modify. 

lnset displays a menu with three commands: Image, ReSize, and Preview. Choose 
PreView. lnset clears the screen and redisplays it in graphics mode, one section at a 
time. After the screen is displayed with the pix tag, the actual image is inserted on the 
screen, one section at a time. For a black and white printer, the screen i s  shown in 
black and white, and the image is shown in the shades of gray that will be used for 
printing it. 



When you're finished examining the screen, press any key to return to the menu. Press 
Esc twice to return to editing the document. 

Printers 
Most printers that work with WordStar also work with Inset. lnset has its own software, 
or printer driver, for working with each printer. When you install Inset, you choose the 
printer you most often use, indicate whether it's black and white or color, and indicate 
which port it's connected to. You can change these settings using the lnset Setup 
program. 

When you print a document with graphics, WordStar uses the lnset printer driver that is 
associated with the WordStar PDF used for the document. Most printers you install for 
WordStar are preset to use the appropriate PDF. If a WordStar PDF is not associated 
with an lnset printer driver, the printer driver you chose with the lnset Setup program or 
Driver command (described below) i s  used. You can add or change an lnset printer 
driver for a PDF using PDFEDIT. For information on which lnset printer driver i s  used 
with your printer, see the Printers and Monitors List. 

When you print graphics using the lnset Print command, lnset uses the printer driver 
you chose during installation or with the Setup program. You can change this driver 
before printing, using the Driver command. This command is useful if you use more 
than one printer for different purposes. Choose Output at the Main Menu and choose 
Driver at the Output submenu. lnset displays a prompt that shows the name of the cur- 
rent driver. Type the name of the printer driver you want and press J. For information 
on printer driver names, see "Deleting Unnecessary Printer Files" in "Getting Started." If 
you're not sure which driver to use with your printer, see the Printers and Monitors List. 

At the next prompt, choose B&W for a black and white printer or Color for a color 
printer. At the prompt for the printer port, choose 1 for LPT1, 2 for LPT2, or 3 for LPT3. 
(If the printer is connected to a serial port, you must run the operating system's MODE 
command before using the Driver command. See "F Port" in "Changing the Setup 
Options.") After you choose the port, the Main Menu appears. 

Printing 
To print a WordStar document that contains one or more pix tags, use the WordStar 
print command. Answer the prompts in the usual manner. WordStar monitors all the 
output to the printer. When it detects a pix tag, WordStar calls Inset, which replaces 
each pix tag with the printing instructions for the image. 

You can print the current screen in graphics mode using the commands on the lnset 
Print submenu. The screen can be a graphics screen or a text screen. The Print sub- 
menu includes commands for setting up your printer so that the printout is located cor- 
rectly on the paper. 
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Choose Print at the lnset Main Menu. lnset displays a menu of six commands: Go, 
Margin, Formfeed, Down, Up, and Top. If you need to put the paper in the correct 
position before printing, use the appropriate menu commands. Formfeed immediately 
advances the paper in the printer to the top of the next page. Down sends a line feed 
to the printer (advances the paper one line). Up sends a reverse line feed to the printer 
(if the printer supports reverse line feeds). Top sets the printer so that it considers the 
current line to be the first line of a new page. Margin lets you set a distance (in tenths 
of an inch) from the left margin where the left edge of the images should be printed. 
When you're ready to print, choose Go. lnset prints the screen. If you want to stop 
printing before it's finished, press Ctrl-Break. 

Note: Be sure your printer is online before you choose one of the Print commands. If 
nothing happens after 15 seconds, you should see an error message. Otherwise, check 
your printer and cable. 

When you use the Print command to print a pix file, the file's settings for the Modify 
commands Rotate, Expand, Ink, Pass, and Border become the current settings for new 
files you capture or create. 

The first time you print an image, lnset creates a fast file containing information that 
speeds up subsequent printings of the image. This file has the same filename as the pix 
file with the .FST extension and i s  in the same directory as the pix file. You can turn 
fast file creation off and on using the Fast command on the Output submenu or using 
the Setup program. When you edit and modify the image or change between draft and 
letter quality printing, lnset doesn't use the existing fast file for printing, but creates a 
new one. To save disk space, you can delete fast files you no longer need. 

If you print in landscape mode, be sure to run the lnset Setup program and change the 
paper width setting to 132 columns. See "G Width" in "Changing the Setup Options." 

When you print graphics, either with WordStar or with the lnset Print command, you 
can choose draft or letter quality, and you can print with either one or two printer 
passes. These capabilities are explained below. You can also choose the printed 
colors or shades of gray for each onscreen color; see Printing with colors or shades of 
gray. 

Printing in letter or draft quality 

With most printers, lnset can print with the highest available resolution, called letter 
quality printing, or it can print with a lower resolution, called draft quality printing. 

T I  P Draft quality printing may take less time than letter quality, and you may want to 
use i t  for preliminary printouts. 

You can set the print quality using the Setup program. See "H Quality" in "Changing 
the Setup Options." You can also change the print quality setting using the Quality 
command. Choose Output at the lnset Main Menu and choose Quality at the Output 
submenu, then choose Draft or Letter. The new setting wil l  be in effect for all printing 
until you change it again. 



Printing in double-pass mode 

If vertical lines are not straight when you print your graphics, using the Pass command 
may help. 

Display the image on your screen. Choose Modify at the lnset Main Menu and choose 
Pass at the Modify Menu. Two options, Single and Double, appear. If you haven't 
used Pass previously for this file, the current setting is the same as the setting in effect 
when you first saved this file. 

Choose Single to print the image in one pass. In this mode, each line of graphics prints 
once. Although this is the fastest method of printing, vertical lines may appear. 

Choose Double to print each line of graphics twice. This produces a darker image and 
makes the passes line up correctly. While it is slower than the single-pass setting, you 
may find that printing two passes is necessary to produce high-quality graphics on your 
printer. (If your printer prints only in one direction, the double-pass setting has no 
effect.) 

Note: If you've inserted an image in a document, you can choose double or single pass 
without displaying the image on your screen. While editing the document, display the 
text where the image is inserted. Make sure the image is the uppermost image on the 
screen and start Inset. A box representing the image appears in the text, and a menu 
appears at the bottom of the screen. Choose Image. The Modify Menu appears. 
Choose Pass. If you change the Pass setting in this manner, your change is automati- 
cally saved; don't use the Save command. 

Printing with colors or shades of gray 
You can control how each screen color i s  handled by your printer by using the Ink 
command. If you have a black and white printer, you can specify the shade of gray that 
will be printed for each color. If you have a color printer, you can specify colors. 

Choose Modify at the Main Menu, and choose Ink at the Modify Menu. lnset displays 
six options: Std, Invert, B&W, Table, Contrast, and Display. You can set Ink to any of 
the first four options. If you haven't used Ink previously for this file, the current setting 
is the setting that was in effect when you first saved the file. The Contrast option, 
described below, lets you choose between three sets of shades of gray used for the 
other settings. The Display option, described in Colors, affects the onscreen colors. 
Choose the Ink option you want. 

Std (Standard) instructs lnset to print each color exactly as it appears on the screen 
or, for a black and white printer, in the standard gray levels, except that black prints 
as white and white prints as black. This means that a black screen background isn't 
printed, and white graphics are printed. Standard i s  also useful if you previously 
changed other Ink settings and want to reset them back to the original (default) 
colors. 
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Invert is the same as Standard except that black prints as black and white prints as 
white. Be careful with this option, because a black background prints as black, and 
any portions of your onscreen graphics that are white aren't printed. 

B&W (Black and White) instructs lnset to print all colors except black as black and 
not to print black. If the image on the screen is on a black background, all the 
colors print as black and the background isn't printed. 

Table allows you to set each screen color to a printer gray level (or, for color 
printers, color). It is described below. 

If you choose Std, Invert, or B&W, the Modify Menu reappears. 

If you choose Table, lnset displays a menu of the colors on the palette used for the 
image. This menu has 2 colors for a monochrome image, 4 colors for a CGA color 
image, and 16 colors for an EGA image. You can choose and set as many colors as you 
want. 

To choose a color, either use the cursor keys to move the highlighting to the color num- 
ber and press J, or type the color number. For each color you choose, lnset displays a 
menu of the 16 gray levels (for black and white printers) or colors (for color printers). 
The menu choices are numbered 0 through F (hex code for 16). The bottom menu line 
shows the current gray level or color for this screen color. Gray levels are expressed in 
percentages. With a gray level of SO%, for example, half the dots in the image are 
printed. (There are three available sets of gray levels; you can change to another one 
using the Contrast command described below.) 

You can move the highlighting among the choices to see the gray level or color each 
choice represents. Press J at any choice to choose a new gray level or color. When 
you're finished setting colors, press Esc to return to the Ink submenu. Press Esc again to 
return to the Modify Menu. Be sure to save your modification with the image. 

If you choose Contrast, lnset displays a menu with three choices: Random, Gray, and 
High. Gray i s  the default for graphics images. Gray is a set of gray scales with grad- 
uated percentages; the dots in these grays are very regular, printing as graduated shades 
of gray. Random is another set of gray scales, the ones used with previous versions of 
Inset. The dots in these grays form different patterns when printed. For example, both 
Random and Gray include a 12% gray value, but these two shades appear different 
when printed. Gray is the best choice for most graphic images, but Random sometimes 
gives interesting effects. High i s  the default contrast for text images. It has fewer 
shades and is good for images that look best with high contrast. 

To change the contrast setting, move the highlighting to the choice you want and 
press J. The values used in the tables for Std and Invert change to the new contrast 
setting values. 



The following table shows the possible screen colors, their lnset numbers, and their 
default gray levels for black and white printers for all three contrast settings. 

SCREEN GRAY LEVELS 
NUMBER COLOR RANDOM GRAY HIGH 

0 Black 0% 0% 0% 
1 Blue 94% 88% 75% 
2 Green 88% 81 % 50% 
3 Cyan 63% 75% 50% 
4 Red 56% 68% 50% 
5 Magenta 50% 62% 50% 
6 Brown 38% 56% 25% 
7 White 19% 50% 0% 
8 Gray 87% 43 % 100% 
9 Lt. Blue 62% 36% 75% 
A Lt. Green 5 5 O/O 31 % 5 0% 
B Lt. Cyan 49% 25% 50% 
C Lt. RedIPink 37% 18% 50% 
D Lt. Magenta 25% 12% 50% 
E Yellow 12% 6% 25% 
F White 100% 100% 100% 

Note: If you've inserted an image in a document, you can change the colors or gray 
levels without displaying the image on your screen. While editing the document, dis- 
play the text where the image is  inserted. Make sure the pix tag for the image is  the 
uppermost pix tag on the screen and start Inset. A box representing the image appears 
in the text, and a menu appears at the bottom of the screen. Choose Image. The 
Modify Menu appears. Choose Ink. If you change the Ink settings in this manner, your 
change is  automatically saved; don't use the Save command. 

Rotating an image 
You can rotate an image when it is printed. The rotation doesn't show on the screen, 
except when you preview the text and image using either page preview or the lnset 
Preview command. 

To rotate an image, choose Modify at the lnset Main Menu. Choose Rotate at the 
Modify Menu. lnset displays a menu that contains the three orientations, Left, 
Horizontal, and Right. The current orientation is  highlighted. If you haven't chosen a 
rotation previously for this file, the default is the same setting that was in effect when 
you first saved the file. Horizontal is the same orientation as on the screen. Left and 
Right cause the printed image to be rotated 90 degrees in the direction specified. 
Choose the orientation you want. The Modify Menu reappears. 
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The illustration at the right shows the three orienta- 
H o r i a o n t  a1 tions. 

T I  P Rotating can be useful if you have a spreadsheet 
that is too wide for the printed page; it may fit sideways. 

Note: If you've inserted an image in a document, you 
can change the rotation without displaying the image on 
your screen. While editing the document, display the 
text where the image is inserted. Make sure the image is  
the uppermost image on the screen and start Inset. A box representing the image 
appears in the text, and a menu appears at the bottom of the screen. Choose Image. 
The Modify Menu appears. Choose Rotate. If you change an image's rotation in this 
manner, your change is  automatically saved; don't use the Save command. 

Saving an image 
Each time you edit or modify an onscreen image, you need to save your changes. After 
you finish making your changes, choose Save at the lnset Main Menu. Otherwise, 
when you try to exit Inset, answer yes to the prompt that asks if you want to save your 
modifications. In either case, you must then enter the filename for the image. Press J 
to accept the default filename, or type another filename you want to use and press J. 
Include a drive letter or directory path if necessary. You don't need to include the .PIX 
extension; lnset automatically adds it. (You can use the .SIG extension to password- 
protect a file. See Signature files.) 

If you use the same filename the file had before you changed it, lnset asks if you want 
to replace the contents of that file with the image on the screen. Answer R for Replace 
to replace the image in the file with the changed image, or C for Cancel if you don't 
want to replace the file. If you answer C, you are returned to the Main Menu, and you 
have to start the Save operation again. 

lnset saves the file. You are returned to the Main Menu if you chose Save, or to the 
operating system or the program you were running if you saved the image while exiting 
Inset. 

When you save a file, the file's settings for the Modify commands Rotate, Expand, Ink, 
Pass, and Border become the current settings for new files you capture or create. 

T I  P You can easily save a file while you're using one of the Edit Menu commands. 
lust press F10 and the filename prompt appears. It's a good idea to use F 10 after you 
make changes you want to keep and before you make further changes. Then, if you 
decide not to keep your later changes, -it's easy to go back to the most recent version. 



C A U T I  0 N Don't use the Save command unless the image is on the screen. When 
you modify an image when the image's pix tag is onscreen (but not the image itseln, 
lnset automatically saves your modification with the same filename. If you use the 
Save command and the image was created in graphics mode, an error message appears 
and you can't save the file. However, if the image was created in text mode (for exam- 
ple, a spreadsheet) and you choose Save, then choose to replace the file, the text screen 
with the pix tag is saved as a pix file. In this case, you may lose your image by replac- 
ing the original pix file with the saved text screen. 

See also Capturing an image. 

Screen modes 
When you type words on your computer (in the operating system, WordStar, or another 
program), the screen is normally in text mode. In text mode, the screen is divided into 
areas the size of one character (on most screens, 80 columns and 24 rows). The com- 
puter comes with a set of predefined characters. You choose the characters to put on 
the screen by typing them on the keyboard. 

Graphics programs, including the lnset editing functions, work with the screen in 
graphics mode. In graphics mode, the screen is divided into individual dots, or pixels. 
When you use lnset to edit an image, you change the screen dot by dot. 

The actual number of dots on the screen varies for different screens and graphics adapt- 
ers and is  called the screen resolution. Your screen may always have the same resolu- 
tion, or you may have several resolutions available. For example, the standard color 
graphics adapter (CGA) has two resolutions, medium for color graphics and high for 
black-and-white graphics. In medium resolution, the screen is  320 dots wide by 200 
dots high; in high resolution, the screen is  640 dots wide and 200 dots high. For infor- 
mation about the resolutions available with other screen adapters, see "A Screen" in 
"Changing the Setup Options." 

When lnset captures a graphic image, it stores the contents and color of each dot on 
the screen. If you try to display an image on a screen with lower resolution or fewer 
colors than the one on which it was captured, lnset must first convert the image to an 
available resolution. 

You can capture a text screen with Inset, but you can't edit that screen or preview it 
with WordStar page preview unless you first convert it to graphics mode using the lnset 
Convert command. (See Converting a text screen to graphics.) 
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Signature files 
You can password-protect a file when you save it by using the .SIG filename extension, 
which stands for signature file. A signature file can contain an image of your signature, 
which you can insert into letters and memos. Protecting the signature file with the .SIC 
extension prevents anyone from using your signature without your approval. You can 
password-protect any image; it doesn't have to be a signature. It just needs to have the 
.SIG filename extension. 

The example at the right shows a signature file named 
JSMITH.SIG. 

When you capture or save a file, if you type a filename 
with the .SIG extension, lnset prompts you for the 
password. Type a password of up to eight characters 
and press J. You don't see the password as you type it; 
X's are displayed instead. After you press J, lnset asks 
you to retype the password for verification. Retype the password and press J. If you 
type the password exactly as you did originally, lnset saves the image in a protected 
file, using your password as the key. If your verification is not correct, you can repeat 
the procedure. 

To view or print a protected file, you must type the password. If anyone tries to view or 
print the file without using the correct password, the image will be unrecognizable. 

See also Capturing an image and Saving an image. 

Size 
lnset provides two ways to change the size of your printed image, the Expand com- 
mand and the ReSize command. You can use the Expand command to set a size in 
inches, in columns and rows, or relative to the screen size of the image. You can use 
ReSize to adjust the size (in columns and rows) of an image that is already inserted in a 
document. 

The Expand and ReSize commands are described below. These commands allow you 
to change the size of the printed or previewed image. They have no effect on the size 
of the image when you display it on the screen. 

The Expand command 

You can use the Expand command when the image is displayed on the screen, or you 
can use it when you're using WordStar to edit a page that contains a pix tag (in this 
case, the image you want to change must be the uppermost pix tag on the screen). 

To use Expand, start lnset and choose Modify at the Main Menu. (If you're editing a 
page with an image, start lnset and choose Image.) Choose Expand at the Modify 
Menu. lnset displays eight settings: l x ,  2x, 3x, 4x, 5x, 6x, Col/Row, and Inches. The 
current setting is  highlighted. Choose the setting you want. 



The I x  through 6 x  settings set the number of dots to print for each dot on the screen. 
For example, if you choose 2x, each screen dot prints as two rows of two dots each, 
doubling the length and width of the printed image. If you use these settings, note that 
the size of the printed dot varies from printer to printer. Thus the same image with the 
same expansion setting is printed smaller on a printer with high resolution, such as a 
laser printer, than it i s  on a printer with low resolution, such as a dot matrix printer. 

The Col/Row choice allows you to set the size in terms of text columns and rows, and 
the Inches choice allows you to set the size in inches. These two options are useful 
whenever you want to set an exact size for the printed image. 

Note: If you set the size in columns, the column width is determined by the pitch; the 
default is 10 columns per inch. You can change the pitch with the Setup program or 
with the Pitch command on the Output submenu. See also Pitch. 

If you choose Col/Row or Inches, a prompt asks for the width of the picture in columns 
or inches. Type the width you want and press J. The next prompt asks you for the 
aspect ratio. 

The aspect ratio is the relationship of the vertical aspect of the image to its horizontal 
aspect. If you specify a number from 1 through 99, the image will be compressed verti- 
cally when it is printed, so it i s  shorter than it is on the screen. The number 1 produces 
the shortest image, while with 99, the compression is barely noticeable. If you choose 
100, the image will be printed on a I-to-I ratio. If you choose a number over 100, the 
image will be taller when printed, so that it appears elongated. Type the number you 
want and press J. 
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Instead of specifying an aspect ratio, you can specify exactly how long you want the 
image (in rows or inches, depending on your original choice). Just type 0 at the aspect 
ratio prompt and press J, then type the number of rows or inches and press J. 

After you change the size of an onscreen image, be sure to save your modification 
before exiting Inset. If you use Expand without the image on the screen (that is, when 
the pix tag is onscreen), don't use the Save command; the change is automatically 
saved. 

The ReSize command 

The ReSize command allows you to modify an image to fill the space you want it to 
take up in your text. You can use ReSize only when you're using WordStar to edit a 
page that contains an inserted image, and only for the image represented by the upper- 
most pix tag on the screen. 

To use ReSize, display the text on the screen. Make sure the image you want i s  the 
uppermost image on the screen and that the entire area left for the image is on the 
screen, and then start Inset. lnset displays a box that marks the image's location. (If the 
entire box isn't on the screen, you can exit lnset and scroll your display so the box will 
fit, then start lnset again.) 

lnset displays a menu with three commands: Image, ReSize, and Preview. Choose 
ReSize. You have two choices, Natural and Scale. Natural allows you to adjust the 
image dimensions in multiples only; for example, you can make the image twice as 
wide or four times as high. Scale allows you to adjust the dimensions by rows and 
columns; it gives you more exact control over the size, but can cause distortion in the 
printed image, especially with color patterns. Choose either Natural or Scale. 

Now you can adjust the size of the image. Use the up and down arrow keys to adjust 
the height, the left and right arrow keys to adjust the width, and the plus and minus 
keys next to the arrow keys to adjust the height and width at the same time. The size of 
the image box changes onscreen with your changes, and the row and column numbers 
next to the filename at the top of the box show the new dimensions in rows and 
columns. When the image is the size you want, press J. The new size is  automatically 
saved with the image; don't use the Save command. lnset returns you to the menu. 
Press Esc twice to exit Inset. 

Text 
You can add text to a graphic image. lnset provides several text styles and sizes. To 
add text, start Inset, display the image, and choose Edit. Choose Text at the Edit Menu. 
lnset displays a submenu of commands you can use to add text to a graphics image and 
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to modify the text. The submenu contains eight commands: Enter, Accept, Undo, 
Direction, Height, Width, Italics, and Font. Each of these commands is  described 
below. 

Note: The text you add to an image is  in graphics mode; it doesn't match your printer's 
text characters. (See Screen modes for information on text mode and graphics mode.) 
You can use this contrast to call attention to the image accompanying the graphics text. 

Enter 

Use Enter to type the text you want. When you choose Enter, the menu disappears and 
a cursor appears. Use the arrow keys to move the cursor to where you want to begin 
typing, and type the text you want. You can use any characters on your keyboard. 
With any of the three ASCll fonts (see "Font" below), you can use characters from the 
ASCll extended character set by holding down the Alt key and typing the decimal value 
of the character you want. You can press J to start a new line of text directly below the 
first character of the previous line. Pressing Backspace erases the previous character. 
You can use the arrow keys to move the entire block of text you typed since choosing 
Enter. 

When you're finished entering text, press Esc. The text remains on the screen and the 
menu reappears. You can choose Accept to save the text as it is, Undo to erase the 
text, or any of the other Text commands to change the style of the text before saving it. 

If you try to leave the Edit Menu while the screen contains text you haven't accepted, 
Inset prompts you to either accept or undo the text. 

Note: When you enter text, the colors in which it appears onscreen are determined by 
the colors already onscreen. However, when you accept the text, it changes to the 
Draw color. When entering text, be sure the Draw color is different from the back- 
ground color(s) on which you enter the text. 

Accept 

Use Accept when the text on the screen looks exactly the way you want. Just choose 
Accept from the Text submenu. 

After you use Accept, the block of text you just entered is frozen. You can't change 
any characters or the text's direction, height, width, italics, or font. You can modify it 
only by using the graphics editing functions, such as Magnify and Erase. 

After you use Accept, you can use the other Text commands to enter and modify addi- 
tional text. These commands affect only the current block of text that has not yet been 
accepted. 

Undo 

Use Undo to erase the current block of text (the text that you haven't yet accepted). 
Just choose Undo at the Text submenu. All the text disappears except text that you pre- 
viously accepted. 



I N S E T  R E F E R E N C E  

Direction 

You can change the orientation of the current block of text with the Direction com- 
mand. When you choose Direction, lnset displays a submenu with four choices, Right, 
Down, Left (Upside-down), and Up. 

Right is standard horizontal text. Left causes text to turn upside- 
down and read from right to left. Up and Down let you type 
vertically up or down from the cursor position. Choose the direc- 
tion you want. The current block of text, if any, turns in the 
direction you chose, and subsequent text you type is in the new 
direction. 

Before you change the direction of the text again, be sure all the text that i s  to remain in 
the current direction is exactly the way you want, then choose Accept to save it. 

If you want to change the direction of only a few words, remember to first accept the 
text you want in the current direction. 

Height 

Height allows you to make the characters in the current block of text taller. You can 
use it alone to make characters appear taller and thinner than the usual characters, or 
you can use it together with Width to make the characters larger. 

When you choose Height, lnset displays a submenu with six choices, l x  through 6 x .  
l x  is normal height, 2 x  is double normal height, 3 x  i s  triple normal height, and so on. 
Choose the height you want. The current block of text, if any, changes to the height 
you chose, and subsequent text you type i s  in the new height. 

Before you change the height of the text again, be sure all the text that is to remain in 
the current height is exactly the way you want, then choose Accept to save it. 

If you want to change the height of only a few words, remember to first accept the text 
you want in the current direction. 

Width 

Width allows you to make the characters in the current block of text wider. You can 
use it alone to make characters appear darker (2x makes a good boldface), or you can 
use it together with Height to make the characters larger. 

When you choose Width, lnset displays a submenu with six choices, l x  through 6 x .  
l x  is normal width, 2 x  i s  double normal width, 3 x  is triple normal width, and so on. 
Choose the width you want. The current block of text, if any, changes to the width you 
chose, and subsequent text you type i s  in the new width. 

Before you change the width of the text again, be sure all the text that is to remain in 
the current width is exactly the way you want, then choose Accept to save it. 



If you want to change the width of only a few words, remember to first accept the text 
you want in the current direction. 

Italics 

The ltalics command lets you italicize (slant) all the characters in the current block of 
text. When you choose Italics, lnset displays two 
choices, Normal and Italic. Choose Italic. The 
current block of text, if any, appears in italics, and 1 subsequent text you type is italicized. 

Before you change back to normal text, be sure all the italicized text is exactly the way 
you want, then choose Accept to save it. 

To turn italics off, choose Italics at the Text submenu, then choose Normal. 

If you want to italicize only a few words, remember to first accept the text you don't 
want to appear in italics. 

Font 
The Font command allows you to change fonts. You can either use the standard IBM@ 
system font (the default) or choose one of the other available fonts. 

Before you change to a different font, save the text you want to remain in the current 
font by accepting it. 

When you choose Font, lnset displays two choices, PC-Font and Load (to load a font 
from disk). The PC font i s  the default font. The other fonts are type styles that come 
with Inset. They are stored in files with the .INF filename extension. 

To choose a font other than the default, choose Load. lnset displays a menu of the 
available fonts. Because each font is a file, the menu i s  in Inset's file selection format. 
If the list isn't displayed and a font filename is  on the top menu line, you can press * or 
the Spacebar to erase the name and display the list. 

Choose the font you want. The current block of text, if any, appears in the new font, 
and subsequent text you type is in the new font. 

T I  P You can see how all the fonts look by typing your text on the screen but not 
accepting it, then choosing each font in turn. 

To return to the default font, choose Font at the Text submenu, then choose PC-Font. 



Changing the 
Setup Options 

If you need to change the choices you made when you installed lnset or you want to 
change some of the current lnset settings, you can run a program called Setup, which is 
in a file named SETUP.COM. Log on to your lnset directory and follow the steps 
below: 

1 Type setup and press J. The Hardware Configuration Setup screen appears. 

2 Examine the current settings for the setup options. Type the letter of the option you 
want to change. 

3 Use the cursor keys to move the highlighting to the answer you want, then press J 
to choose the,answer. Information about each option is given after this procedure. 

4 When all the settings are correct, press F10 to save them. You are returned to the 
system prompt. 

5 If lnset was loaded in your computer's memory before you ran Setup, type ri and 
press J to remove lnset from memory, then type inset to reload Inset. (Otherwise 
the setup changes will not take effect.) 

The setup options are listed below in the same order as they appear on the Hardware 
Configuration Setup screen. 



A Screen 
You choose an lnset screen driver when you install Inset. You can change to another 
screen driver using this option. To run Inset, your computer must have one of the 
screen adapters (graphics boards or cards) listed on the screen or an equivalent one. 
Screen adapters that can be used with lnset are described below. 

IBM Color Graphics Adapter The CGA has four different display modes. Two of the 
modes-80-column text and 40-column text-are text modes. While the screen is in 
text mode, no graphics images can be displayed. The other two modes display 
graphics. In medium resolution mode, the screen is 320 pixels wide by 200 pixels 
high, and four colors can be used. In high resolution mode, the screen is 640 by 200 
pixels, and two colors can be used. 

IBM Enhanced Graphics Adapter The EGA displays the same four screen modes as the 
CGA plus three additional modes, 640 by 350 pixels and 640 by 200 pixels, both with 
16 colors, and 640 by 350 with 4 colors. The EGA driver supports all the CGA modes 
and the two 16-color modes. The 640x350~4 mode is actually a monochrome mode 
with blinking. To use this mode, you must choose the EGAMONO screen driver. 

Video Graphics Adapter The VGA supports the CGA and EGA modes plus two addi- 
tional modes, 640 by 480 pixels with either 2 or 4 colors. 

MCGA The MCGA monochrome adapter is used with the IBM PSI2 Models 25 and 30 
computers. It supports the CGA graphics modes (emulating colors with gray) and has a 
high-resolution mode of 640 by 280 pixels with 2 colors. 

Hercules Monochrome Graphics Adapter The Hercules Monochrome board allows 
you to display graphics on an IBM monochrome screen. The Hercules board comes 
with software (the HGC file) that identifies the board to the computer. The board has 
two different memory pages where graphics are displayed. They are called page 0 and 
page 1. lnset performs the equivalent of the HGC FULL command as a default. To run 
lnset in HGC HALF mode, choose the HERCHALF screen option. (If you choose the 
wrong screen option, pressing Alt-LShift-I twice when starting lnset will automatically 
change this setting.) With the Hercules Monochrome board, to start Inset, you must 
use LShift-Ctrl while in text mode and Alt-LShift-l while in graphics mode. 

Note: If you have the Hercules Plus board, you can't use lnset and RAMfonts at the 
same time. When you load Inset, it turns the RAMfonts off. To use them again, you 
need to remove lnset from memory and turn the RAMfonts on again. 

Hercules Color Graphics Card lnset works with the Hercules Color board the same 
way as with the CGA board. Choose the CGA screen option. 

ATT Display This adapter is similar to the EGA adapters. Two drivers are provided for 
the ATT, one for color and one for monochrome. 

Toshiba The Toshiba 31 00 has a monochrome monitor with three graphics modes, 
including a high-resolution mode of 640 by 400 pixels. 
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The Genius You can use two modes with the The Genius monochrome monitor, 640 
by 200 pixels and 736 by 1008 pixels. Use Alt-LShift-I to start lnset when your screen 
is  in graphics mode. 

Wyse 700 or Amdek 1280 The WYSE driver lets you display 4-color graphics using 
shades of gray in two resolutions, 320 by 200 pixels (CGA) and 640 by 800 pixels. It 
also has three 2-color modes, 640 by 200, 640 by 400, and 1280 by 800. Use 
Alt-LShift-I to start lnset when your screen is in graphics mode. 

IBM Monochrome Display The IBM monochrome monitor can display only text; it 
doesn't have graphics capabilities. If you choose this screen option, the Small version 
of lnset is automatically used (see the "Q Version" setup option). 

QuadEGA+ Board The QuadEGA+ offers CGA and EGA support and also supports the 
graphics modes of the Hercules Monochrome adapter. When you use this board, you 
must know which of these three modes you're using. If you're in Hercules mode, use 
the HERC screen option (or HERCHALF if you use this mode), and treat the adapter the 
same as the Hercules Monochrome adapter. In any color mode, use the EGA screen 
option and treat it like the EGA adapter. (If you're using CGA mode, the EGA option 
will work and you can use both medium resolution and high resolution.) 

Tecmar Graphics Master For the Tecmar Graphics Master adapter, choose the CGA 
screen option. The Tecmar Graphics Master also has enhanced graphics capabilities, 
but lnset does not support it in its enhanced modes at this time. 

Tecmar EGA Master For the Tecmar EGA Master, choose the EGA screen option. This 
adapter works with lnset the same way as the EGA board does. 

B Screen Mode 
To start lnset from most programs other than WordStar (or from the system prompt), you 
press the regular pop-up keys, LShift and Ctrl. But certain other programs, such as 
Lotus 1-2-3, don't tell lnset what graphics mode (screen resolution) i s  being used. 
When you try to start lnset from inside one of these programs, the lnset Main Menu 
doesn't appear. You need to use the override pop-up keys Alt, LShift, and I to start 
these programs. When you press the override pop-up keys, lnset automatically sets the 
graphics mode to the mode selected at this option. For example, two graphics modes 
are available for the CGA adapter: medium resolution for colors and high resolution for 
black and white. 

If you need to change the graphics mode for another program, you can find out what 
mode the program i s  using and set this option to that mode. If you aren't sure, just run 
the program and try Alt-LShift-I several times in succession. lnset rotates through the 
available modes. When you find the correct mode, lnset automatically sets this Setup 
option to the correct mode. 



C Printer 
To find the correct printer driver for your printer, you can use the PgDn key to move 
the highlighting down the list quickly. If you're not sure which driver to choose, refer 
to the Printers and Monitors List. 

If you have more than one printer, you can change printers without using the Setup 
program. See Printers in "lnset Reference." 

D Color/Black and White 
This option tells lnset if you plan to print in black and white or in colors. 

E 4K Buffers 
This option sets the number of pages (4K per page) set aside in memory before using 
disk space. These pages are called buffers. The default setting i s  the minimum needed 
for your system. A higher number of buffers generally increases the speed of operation, 
but takes up more memory. If you're using a printer with very high resolution, such as 
a laser printer or a color printer, you may want to increase the number of buffers by 
one or two. 

F Port 
Your printer i s  connected to your computer through a port. The parallel ports are LPT1, 
LPT2, and LPT3. The lnset default is LPT1. If your printer is connected to LPT2 or 
LPT3, choose that port. 

You can change the printer port while running Inset. See Printers in "lnset Reference." 

Serial printers, such as the HP Laserlet printer (but not the HP Laserjet Plus), are con- 
nected to a computer through the COMl  or COM2 port. Before you can print a docu- 
ment containing pix files on a serial printer, you must reroute the printer output through 
one of the LPT ports. You can do this by using the MODE system command after you 
exit the Setup program and before you load lnset into memory. 

At the DOS prompt, type these commands: 

MODE COMl  :96,N,8,1 ,P  
MODE LPTI :=COMl : 

Note: The commands shown above work if the serial printer i s  connected to the com- 
puter through the COMl  port and you want to reroute it through LPT1. If your printer 
is connected through COM2, or if you want to reroute it through LPT2 or LPT3, you 
can edit SERIAL.BAT and substitute the appropriate numbers. Be sure the LPT port is 
the one selected in the Setup program. 
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G Width 
Choose 80 columns for standard width (8'12-inch) paper or 132 columns for wide 
(1 1 -inch) paper or for printing in landscape mode. 

H Quality 
If you choose letter quality, lnset wil l  print graphics in the highest possible resolution 
(number of dots per inch) for your printer. Choosing draft wil l  result in an increase in 
the speed of graphic printing, but with a corresponding reduction in resolution. 

If you're not sure which quality to print in, you can experiment with printing in  both 
draft and letter quality and compare results. See also Printing in "lnset Reference." 

I Pitch 
The pitch setting determines the width of a column when you specify image size in 
columns. If you want to set image size in columns, be sure the pitch setting agrees 
with the printer pitch or font you're using, so the image wil l  be printed correctly. The 
default setting for most printers is 10 characters per inch, which i s  also the lnset 
default. See also Pitch and Size in "lnset Reference." 

/ .PIX Directory Path 
This option allows you to name the directory where you normally keep your pix files. 
This directory is the default when lnset asks you for a filename for saving or viewing a 
file. 

The default for this option is no path. Your pix files are saved in the disk or directory 
where you're working and lnset searches the current directory when it looks for a pix 
file. 

K Temporary Directory Path 
If lnset creates temporary overflow files when you're short of disk space, they are put in 
the directory you name here. Make sure you name a valid directory. The default for 
this option is the directory that contains the lnset files. 

If you name a new directory, the following question appears: 

Is this a Virtual (RAM) Disk? 

lnset needs to know if the directory for your temporary files is located on a RAM disk. 
A RAM disk is a portion of memory that you set aside for use as a disk drive. You don't 
have a RAM disk unless you set it up. If you have not created a RAM disk, press N for 
no. (If you want to create a RAM disk, refer to your computer manual.) 

L Default Pop-up Keys 
The pop-up keys are used to start lnset and display the Main Menu. They are the LShift 
key and the Ctrl key. You can change the pop-up keys with this option. 



To change the pop-up keys, press N for no, type the number of characters you're 
choosing (from 1 to 3), and press the keys you want to select. The first key must be 
either Ctrl, LShift (the left Shift key), RShift (the right Shift key), or Alt. You must hold 
down the first key (and the second, if you choose three keys) while you press the 
second (or third) key. 

M Override Pop-up Keys 
The alternate (override) pop-up keys are used to start lnset and display the Main Menu 
in programs that require a screen mode that is not apparent to Inset. They are Alt, 
LShift (the left Shift key), and I. You can choose different override pop-up keys with 
this option. 

To change the override pop-up keys, press N for no, type the number of characters 
you're choosing (from 1 to 3), and press the keys you want to select. The first key must 
be either Ctrl, the left Shift key, the right Shift key, or Alt. You must hold down the 
first key (and the second, if you choose three keys) while you press the second (or third) 
key. 

N Default Macro 
At this screen, you can create a macro for running a frequently used lnset function. A 
macro consists of a series of lnset commands. The commands represented by the 
macro will run automatically every time you press the pop-up keys to start Inset; you 
won't have to enter them from the keyboard. 

The format of the macro is  simply whatever you'd type at the lnset menus to do what 
you want to do; this might include the letters for the commands you want to run or a 
filename. All letters must be in uppercase. You can also use the following characters: 

; Jkey 

A Esc key 

# Pause until J is pressed. This allows you to, for example, type a filename after 
the View or Save command and have the macro resume. 

( Move the cursor one place to the left 

I Move the cursor one place to the right 

For example, if you always view a graphics file immediately after you start Inset, you 
can set up the macro to choose the View command, ask you the filename, and display 
the file. For this macro, you'd type V. Another example of a macro is shown below in 
"0 Override Macro." See also "Starting lnset Using Macros" in "More About Inset." 
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0 Override Macro 
lnset has a preset override macro, which is a series of commands that runs when you 
press Alt-LShift-l to start lnset in a program such as Lotus 1-2-3. This macro automati- 
cally chooses the medium resolution option for graphics display mode. (Lotus 1-2-3 
changes the display mode without informing the operating system.) 

This option allows you to change the override macro. If you do so, take into account 
that you may need to change the screen mode whenever you start lnset by pressing 
Alt-LShift-I. 

This macro is in the same format as described in "N Default Macro." For example, the 
only reason you ever start lnset while you're in Lotus 1-2-3 may be to capture the cur- 
rent screen. You can set up this macro to automatically start Inset, change to medium 
resolution screen mode, run the Save command, type the directory in which you save 
these files, pause to allow you to type a filename, and exit Inset. If you save your Lotus 
pix files in the \SSPIX directory, this macro would be S\SSPIX\#A. 

P Keyboard Mode 
Some programs may prevent lnset from receiving the keystrokes that start it and display 
the Main Menu. At this screen, you can set lnset to "grab" keystrokes before other 
programs can get them. Three choices are available: 

Passive This i s  the default mode. Inset receives all keystrokes and is started by 
Shift-PrtSc. This mode does not interfere with other programs, so it is 
preferable whenever possible. 

Semi-active If lnset doesn't start in Passive mode, you can try Semi-active. Semi- 
active mode i s  almost as safe as Passive, and it can be useful in programs 
such as Lotus 1-2-3 and Symphony. However, it can occasionally cause 
problems with other memory-resident programs, so if you have a 
problem, change back to Passive as soon as possible. 

Active When you can't start Inset with LShift-Ctrl or Alt-LShift-I, choose Active. 
Change this setting back to Passive as soon as possible, because lnset set 
for Active may not run with other memory-resident software. 

Q Version 
You can install lnset to run with (full) or without (small) its graphics editing capabilities, 
which let you create your own computer graphics or edit existing graphics. If you don't 
install the graphics editing capabilities, the Edit command doesn't appear on the lnset 
Main Menu. The memory saved by not installing graphics editing is about 15K. 

If you set lnset up for an IBM monochrome monitor, the version i s  automatically set to 
Small, because you can't edit graphics on this type of monitor. 



R Maximum .PIX Size 
This option sets the maximum size of your pix file images. A smaller size decreases the 
amount of memory that lnset uses. The minimum size that you can specify is 15K, and 
the maximum is 447K. The default is 11 OK. You probably don't need to change this 
unless you work with very large or very high-resolution images. 

S Fast Files 
The first time you print an image, lnset creates a fast file with the same filename as the 
pix file but with the .FST extension. This files makes subsequent printing of the image 
three to sixteen times faster that the first time you printed it. If you modify the image or 
print it with a different printer, the .FST file is not used for printing and lnset creates a 
new .FST file reflecting the changes. 

This option allows you to turn creation of fast files on and off. The default is on. You 
might want to set it to off if you have disk space limitations. You can also switch fast 
file creation on and off while running Inset, using the Fast command on the Output 
submenu. 

The disk space that a fast file requires depends on the size of the printed image. If you 
are printing an image that takes up a full page, the fast file may take up more space 
than the original pix file; if you are clipping a part of the pix file and printing it an inch 
wide, the fast file will probably take up considerably less space than the pix file. 



More About lnset 
Error Conditions 

This section describes problems you may have while working with lnset and tells you 
how to solve them. 

You can't load lnset from DOS. 

Be sure you're logged on to the drive or directory that has the lnset files. Be sure 
the appropriate lnset printer driver file (PRD) is in this directory. 

The lnset menu doesn't appear when you press LShift-Ctrl or Alt-LShifi-I. 

If nothing happens when you press the pop-up keys, lnset is not loaded, or your 
program is blocking the LShift-Ctrl or Alt-LShift-l sequence, or (if you hear a beep) 
your program is in the middle of a DOS function. 

If lnset isn't loaded, load it. If your program is  running a DOS function, you can 
just press J. If a DOS disk read is  in progress, you must wait until the disk read is 
complete before you can start Inset. 

If your program is blocking the sequence, try the other sequence (if LShift-Ctrl 
doesn't work, try Alt-LShift-I, and vice versa). If that doesn't work, try setting the 
keyboard mode to Semi-active (if the pop-up keys sometimes work) or Active (if 
they never work). See "P Keyboard Mode" in "Changing the Setup Options." 

If you can see some response on the screen when you press the pop-up keys but the 
menu isn't displayed correctly, lnset may be using the wrong display mode for the 
current screen. Use the Alt-LShift-l keys several times. lnset rotates through the 
available screen modes, and one of them should make the menu appear. You can 
also set this screen mode using the Setup program. See "B Screen Mode" in 
"Changing the Setup Options." 



With a few computers, lnset may have trouble popping up because it can't tell that 
no mouse is attached to the computer. This can cause operating system error mes- 
sages. If when you load Inset, it displays a "Mouse Installed" message and you 
don't have a mouse, try the NOMOUSE.COM program. Log on to your lnset disk or 
directory and, at the operating system prompt, type nomouse J. 

A beep sounds while you're in an lnset menu. 

You pressed an invalid key. Try to enter the command again. lnset may also be 
signaling to you that it has completed either disk 110, clipping, or printing. This i s  
not an error. 

Nothing happens when you try to print with the Print Go command. 

lnset can't find your printer. Check to make sure the printer is online, that the 
cables are all secure, and that you have selected the right printer driver and port. 

The lnset Main Menu doesn't appear when you use Utilities, lnset (Alt+U,I) or "P&. 

WordStar may not know where to find Inset. (This should not happen if you 
installed lnset using WSSETUP or the Add a feature option in WINSTALL.) Use 
WINSTALL to check the assignment of WordStar search paths. 

WordStar may not have enough available memory to load Inset. If you are running 
any memory-resident programs, exit WordStar and remove them from memory. 

Be sure that you have run the lnset Setup program as described in "Installing Inset" 
and that the INSET file and the appropriate lnset printer driver file (PRD) are in the 
same directory as the lnset program files. 

An image in a document is not printed. 

Check the pix tag to make sure the pix filename is correct and the correct path is 
included. If the pix tag is correct, open your document and be sure Utilities, lnset 
(Alt+U,I) or the "P& classic command starts Inset. If you cannot start Inset, see the 
explanation above for "The lnset Main Menu doesn't appear . . ." 

An image is not printed correctly. 

If the image appears too tall and thin or too short and wide, change the aspect ratio 
using either the Col/Row or Inches options of the Expand command. If the image is 
still incorrect, and it is in a document, try using a different line height or line spac- 
ing. If you are printing the image larger than its original size when captured, try 
printing it at its original size. On a few printers, enlarged graphics may not be 
printed correctly. 

If too much white space shows around the image, use the Clip command on the 
Modify Menu to move the clip lines closer to the actual image. 

If you were required to change any switch settings on your printer to make it com- 
patible with the driver, make sure the changes are made. 
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You may be using the wrong lnset printer driver. See the Printers and Monitors List 
for the name of the correct driver. If you are printing the lnset Print command, 
check your printer using the Driver command on the Output submenu. If you are 
printing with Wordstar, you can use PDFEDIT to make sure your PDF is set up for 
the correct lnset printer driver. 

If the graphics appear fuzzy, check the image's screen colors and its settings for the 
corresponding printer shades of gray. See Printing in colors or shades of gray in 
"lnset Reference." 

If the horizontal lines that make up the image are staggered to the left and right then 
you print the image in a document, try choosing a different font before the pix tag, 
or try using a different line height or line spacing (6 lines per inch is  the most reli- 
able height). 

An image printed on a dot matrix printer appears wavy. 

Use double-pass printing. See Printing in "lnset Reference." 

An image is printed in the wrong position in a document 

If the image is too far too the left or right, be sure the pix tag is in the correct posi- 
tion on the line. If it is, try choosing a different font before the pix tag. If you are 
printing the image larger than its original size when captured, try printing it at its 
original size; with a few printers, enlarged graphics may not be printed correctly. 

If the image is too high or low, adjust the position of the pix tag. If necessary, you 
can use superscript or subscript. 

Check how the image is clipped; you can sometimes adjust the position by moving 
the clip lines. 

Only part of an image is printed 

The .FST file for the image may be damaged; try deleting this file. If the right por- 
tion of the image is cut off, try running the lnset Setup program and changing the 
width to 132 columns (this may help even on 8'/2-inch wide paper). 

On a laser printer, if printing stops before the entire image is printed, the printer 
doesn't have enough memory for the whole page. To get more memory, you can 
remove downloaded fonts that you're not using, or you can purchase additional 
memory, if available. Otherwise, you can work around this problem by reducing 
the size of the image or printing fewer images on a page. The rest of the page is 
printed on the next piece of paper (you may need to reset the printer first), SO you 
can also cut and paste if necessary. For preliminary printouts, you can use less 
memory by setting Quality (on the Output submenu of the Modify Menu) to Draft. 



The text next to an image is spaced incorrectly 

You may need to change the line height to 6, 3, 2, or 1 lines per inch. See 
Inserting an image into text in "Inset Reference." This problem may also cause 
incorrect page breaks. 

Using Inset with Other Programs 
The information below shows how lnset works with some of the more popular spread- 
sheets and graphics programs. 

AutoCA D 
When capturing AutoCAD drawings, you may need to use Alt-LShift-I to start Inset. 

Diagraph 
To use Inset with the Diagraph CAD program, you must set the lnset keyboard mode to 
Active. See "P Keyboard Mode" in "Changing the Setup Options." You should reset 
the keyboard mode to Passive when you leave Diagraph. 

-1.7477,-8.0?71 

Loaded menu P :\DW\INGLSUCAD .m 

Dr. Halo 

LUTOCLD 
Y Y Y Y  
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To use lnset with the Dr. Halo graphics program, you may need to set the lnset 
keyboard mode to Active. See "P Keyboard Mode" in "Changing the Setup Options." 
You should reset the keyboard mode to Passive when you leave Dr. Halo. 

Collrnand : 
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EnerGraphics 
If you use the EnerGraphics program on an EGA board with 640x350~16 resolution, 
you must choose the EGA high resolution screen mode for lnset (see "A Screen" in 
"Changing the Setup Options"). Use Alt-LShift-I to start lnset from EnerGraphics. 

Rcme Widgets, Inc. 
Volume Cornearlson Over Last 2 Yrs 

Quart cr 
Widget3 + Cops Q 6uperWidpet9 

To capture graphics from Lotus 1-2-3 Version 1, you must start lnset using the 
Alt-LShift-l keys. This sets the display mode to medium resolution graphics and dis- 
plays the lnset Main Menu on the bottom of your screen. With Lotus 1-2-3 Version 2, 
you can use LShifi-Ctrl. 

When you're in the spreadsheet itself, use LShift-Ctrl to start Inset. 

PC- Paint 
To use lnset with PC-Paint, you must not load any of PC-Paint's screen printing 
programs (such as EPSON.COM or 0KIDATA.COM) after you load Inset. If you do 
load one of these programs, lnset will be unable to pop up inside PC-Paint. 



If you're using PC-Paintbrush and lnset in the EGA high resolution mode, you must use 
Alt-LShift-l to start Inset. If you use LShift-Ctrl by mistake, press Esc and then press 
Alt-LShift-I. 

Symphony 
To run lnset with Symphony, set the lnset keyboard mode to Semi-active. See 
"P Keyboard Mode" in "Changing the Setup Options." 

Windows 
To use lnset with Microsoft Windows, you must set the lnset keyboard mode to Active. 
See "P Keyboard Mode" in "Changing the Setup Options." 

You must load lnset before you run the Windows environment. lnset i s  a memory- 
resident program, so you can't run it as an application from inside Windows. 



M O R E  A B O U T  I N S E T  

Starting Inset with Macros 

lnset includes a program called AUTOIN.COM that is an alternative to the pop-up key 
method of starting Inset. AUTOIN.COM lets you start lnset at the DOS prompt with a 
command that includes a macro. The macro, which can be up to 80 characters long, 
issues lnset commands. This method of starting lnset is useful in batch files where you 
want to perform lnset tasks automatically. 

Before you use AUTOIN.COM, you must load lnset into your computer's memory. To 
use AUTOIN.COM, type autoin macro and press J. An example of an AUTOIN.COM 
command line is  autoin vsarnple;pgAy. This command pops up Inset, views and prints 
SAMPLE.PIX, and returns to DOS. 

For more information on using lnset macros, see "N Default Macro" in "Changing the 
Setup Options." 
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Accept command (freeze text), IN-22, IN-64 
Active keyboard mode, IN-73, IN-75 
add 

borders, IN-25 to IN-26 
text to graphic images, IN-21 to IN-22, 

IN-63 to IN-66 
Alt-LShift-l keys 

change, IN-72 
correct menu display, IN-53, IN-75 to 

IN-76 
macro for, IN-73 
not working, IN-53, IN-69, IN-73, 

IN-75 to IN-76 
start lnset with, IN-9, IN-53, IN-69, IN-72 

Amdek 1,280 graphics adapter, IN-69 
arrow keys, IN-I 0 

See also cursor movement 
ASCII extended character set, IN-64 
aspect ratio, IN-62 to IN-63 

one hundred (loo), IN-23, IN-62 
zero (O), IN-1 6, IN-63 

asterisk (*) 
with Load command, IN-66 
with View command, IN-1 8 
as wild-card character, IN-34 

ATT Display graphics adapter, IN-68 
AutoCAD, IN-78 
AUTOIN.COM, IN-81 

background color, change, IN-30 
Backspace key, delete text with, IN-22, IN-64 
B&W command (black and white printing), 

IN-54, IN-56 to IN-57, IN-70 
BASIC commands, and pix files, IN-52 
batch files, starting lnset in, IN-81 
beep sound 

and lnset menus, IN-76 
and pop-up keys, IN-75 

black and white monitors. See monochrome 
monitors 

black and white printing, IN-54, IN-56 to 
IN-57, IN-70 

Blank command, IN-29, IN-33 
BLOAD (BASIC command), and pix files, 

IN-52 
block operations 

COPY block, IN-31 to IN-32 
import block, IN-20, IN-29, IN-32, 

IN-44 to IN-45 
mark block, IN-32 
move block, IN-50 

boldface text, IN-65 
Border command, IN-25 to IN-26 

settings for, IN-27, IN-33 to IN-34, IN-55, 
IN-59 

BORDERS.PIX file, IN-27 
brackets ( I  I), macro cursor movement 

characters, IN-72 
BSAVE (BASIC command), and pix files, 

IN-52 
buffers, set number of, IN-70 

/c parameter, IN-9, IN-27 
cancel 

file replace, IN-26, IN-59 
printing (Ctrl-Break), IN-55 
text changes, IN-22, IN-64 

Cancel command (C) (cancel file replace), 
IN-26, IN-59 

capture images, IN-14 to IN-15, IN-26 to 
IN-27, IN-51 to IN-52 

with capture-only Inset, IN-9, IN-27, 
IN-40, IN-73 

default settings, IN-27, IN-33 to IN-34, 
IN-55, IN-59 

defined, IN-I 3 
from other programs, IN-78 to IN-80 

capture-only Inset, IN-9, IN-27, IN-33, 
IN-40, IN-73 

caret ("), macro Esc key character, IN-72 



CGA graphics adapters, IN-68 to IN-69 
screen resolution types, IN-60 

CGA monitors, color control for, IN-29 to 
IN-31, IN-57 

change 
colors 

background color, IN-30 
with Clear command, IN-33 
of dots, IN-48 
Draw color, IN-29 to IN-30, IN-43 
Erase color, IN-29 to IN-30, IN-40 to 

IN-41, IN-43 
with F2 key, IN-43 
Fill color, IN-42 
palette, IN-30 to IN-31, IN-33, IN-43, 

IN-58 
dot color, IN-48 
dot size, IN-39 to IN-40, IN-43 
fonts, IN-66 
gray levels, IN-58 
line width, IN-39 to IN-40, IN-43 
pop-up keys, IN-71 to IN-72 
print quality setting, IN-55, IN-71 
printer driver, IN-54 
setup options, IN-67 to IN-74 
text height, IN-65 
text width, IN-65 to IN-66 
See also add; edit images; modify images 

CHART.PIX file, IN-1 5, IN-1 7 
circles, drawing, IN-37 to IN-38 
Clear command, IN-20, IN-33 
clear menus, IN-48 
clip art, IN-27, IN-45 
clip images, IN-1 5 to IN-1 6, IN-1 9, IN-22 to 

IN-23, IN-27 to IN-29, IN-49 
and BSAVE/BLOAD BASIC commands, 

IN-52 
defined, IN-1 5 
and insert into a pix file, IN-20, IN-29, 

IN-32, IN-44 to IN-45 
clip lines, IN-1 5, IN-19, IN-22 to IN-23, 

IN-28 
Col/Row command, IN-61 to IN-62, IN-76 
colors, IN-29 to IN-31 

background color, IN-30 

colors (continued) 
CGA monitors, IN-29 to IN-31, IN-57 
change, IN-29 to IN-30 

with Clear command, IN-33 
with F2 key, IN-43 

display 
with Display command, IN-31, IN-56 
with Table command, IN-57 

distortion in printed image, IN-63 
EGA monitors, IN-29 to IN-31, IN-57 
Fill color, IN-31, IN-42 
and gray levels, IN-58 
palette, IN-30 to IN-31, IN-33, IN-43 
printing with, IN-54, IN-56 to IN-58, 

IN-70 
screen, IN-29 to IN-31 
text, IN-64 
See also Draw color; Erase color 

commands, IN-1 I, IN-48 
compatibility of Inset with other programs, 

IN-78 to IN-80 
compress images vertically, IN-62 
configuration, IN-7 to IN-9, IN-67 to IN-74 
console. See monitors 
Contrast command (gray level options), 

IN-56 to IN-58 
convert 

screen resolution, IN-35 
text mode to graphics mode, IN-31, 

IN-60 
COPY block, IN-31 to IN-32 
create images, IN-33 to IN-34 
curly brackets (1 I) ,  macro cursor movement 

characters, IN-72 
cursor movement 

arrow keys disabled, IN-1 0 
in Block Import command, IN-44 
by Home and PgDn keys, IN-1 5, IN-19 
by mouse, IN-50 
clip line marking, IN-1 5, IN-19, IN-22 to 

IN-23, IN-28 
drawing lines and shapes, IN-36 to IN-38 
drawing with dots, IN-39 
in Erase command, IN-41 
macro characters for, IN-72 
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cursor movement (continued) 
in Magnify command, IN-47 
to mark blocks, IN-32 
in menus, IN-1 0 
in Move command, IN-50 
in pix file listings, IN-34 
in ReSize command, IN-63 
speeding up, IN-1 5, IN-1 9 

customization, IN-67 to IN-74 

delete 
borders, IN-25 to IN-26 
clip lines, IN-1 9 
dots, IN-41, IN-48 
text from graphic images, IN-22, IN-64 
unnecessary files, IN-8 to IN-9, IN-53, 

IN-55, IN-74 
See also Erase command 

description line (menus), IN-1 0 
Diagraph, IN-78 
DlNGBATS.PIX file, IN-18, IN-27 
Direction command (rotate text), IN-65 
directories, IN-51 to IN-52, IN-71 
display 

another pix file (F9), IN-35, IN-43 
colors 

with Display command, IN-31, IN-56 
with Table command, IN-57 

fonts, IN-66 
images, IN-1 5, IN-1 7 to IN-18, IN-34 to 

IN-35 
Modify menu command settings, IN-27, 

IN-34, IN-49 
distorted images, IN-45, IN-63 
DOS 

MODE command, IN-70 
start Inset at DOS prompt, IN-81 

dot matrix printers 
and line height of text, IN-47 
and multiple pix tags on one line, IN-46 

dot matrix printers (continued) 
and wavy images, IN-77 
See also printers 

dots 
change color, IN-48 
change size, IN-39 to IN-40, IN-43 
clip lines covering, IN-29 
defined, IN-39 
delete, IN-41, IN-48 
drawing with, IN-38 to IN-39 
printing, IN-62 
and screen resolution, IN-60 

double-pass mode, IN-56, IN-77 
Down command (line feed), IN-55 
Down command (rotate text), IN-65 
Dr. Halo, IN-78 
draft quality printing, IN-55, IN-71, IN-77 
Draw-Clr command, IN-29 to IN-30, IN-48 
Draw color 

change, IN-29 to IN-30, IN-43 
defined, IN-29 
lines and shapes always drawn in, IN-36, 

IN-37, IN-38 
select, IN-30 to IN-31 
and text entry, IN-64 

drawing, IN-35 to IN-40 
and changing line width, IN-39 to IN-40 
with dots, IN-38 to IN-39 
lines and shapes, IN-35 to IN-38 
overview of, IN-35 

Driver command, IN-54, IN-77 
See also printer drivers 

E 

edit images, IN-21 to IN-22, IN-40, IN-52 
converted images, IN-35 
graphics mode required to, IN-31, IN-40, 

IN-60 
See also block operations; change; 

modify images 
EGA graphics adapters, IN-68 to IN-69 



EGA monitors, color control for, IN-29 to 
IN-31, IN-57 

EGACHART.PIX file, IN-1 8 
EGALOGOS.PIX file, IN-1 8, IN-27 
EnerGraphics, IN-79 
Enter command (add text to image), IN-64 
Enter key (J) 

macro character for, IN-72 
mouse button for, IN-49 

erase. See delete 
Erase-Clr command, IN-29 to IN-30, IN-40, 

IN-48 
Erase color 

change, IN-29 to IN-30, IN-40 to IN-41, 
IN-43 

default, IN-40 
defined, IN-29 
fill enclosed area in, IN-40 
select, IN-30 to IN-31 

Erase command (erase graphics), IN-40 to 
IN-41 

error conditions, IN-75 to IN-78 
Esc key 

cancel clip line settings, IN-1 5, IN-1 9, 
IN-28 

exit lnset, IN-1 2 
exit menu, IN-1 2 
macro character for, IN-72 
mouse button for, IN-49 

exit 
Inset, IN-1 2, IN-41 
menus, IN-1 2, IN-28 

Expand command (enlarge image), IN-1 6, 
IN-23, IN-61 to IN-63 

settings for, IN-27, IN-33 to IN-34, IN-55, 
IN-59 

F1 (help), IN-43, IN-44 
F2 

change color while drawing, IN-29 

clear screen, IN-33 
summary of functions, IN-43 

F9 (display another pix file), IN-35, IN-43 
F10 

save configuration settings, IN-67 
save current image, IN-43, IN-59 

Fast command, IN-55, IN-74 
fast files, IN-55, IN-74 
filenames, IN-26, IN-34 to IN-35 
files 

delete unnecessary files, IN-8 to IN-9, 
IN-53, IN-55, IN-74 

directories, IN-71 
overflow, IN-71 
See also pix files 

Fill color, IN-31, IN-42 
Fill command, IN-42 to IN-43 
filling areas, IN-36 to IN-37, IN-42 to IN-43 
Font command, IN-66 
Formfeed command, IN-55 
freeze text, IN-22, IN-64 
.FST file extension, IN-55, IN-74 
function keys listed, IN-43 
fuzzy images, IN-77 

Genius graphics adapter, IN-69 
.Gn$ file extension, IN-53 
Go command, IN-24, IN-55, IN-76 
graphic images. See images 
graphics adapters 

setting up, IN-7 
starting lnset using specific boards 

(Alt-LShift-I), IN-9, IN-69, IN-72 
supported by Inset, IN-68 to IN-69 

GRAPHICS.DOC file, IN-1 7 
graphics mode 

convert text mode to, IN-31, IN-60 
described, IN-60 



graphics mode (continued) 
high-resolution, IN-60, IN-69 
medium-resolution, IN-52, IN-60, IN-69 

gray shading, IN-56 to IN-58 

hard disk systems 
installing Inset, IN-7 to IN-9 
loading Inset, IN-1 4 

hardware configuration setup, IN-7, IN-67 to 
IN-74 

hardware requirements, IN-6 to IN-7 
Height command (change text height), IN-65 
help (F l ) ,  IN-43, IN-44 
HERCHALF screen option, IN-68, IN-69 
Hercules graphics adapters, IN-68 
Hewlett-Packard LaserJet printers, IN-26, 

IN-70 
See also laser printers 

HGC program, IN-68 
High command (high-contrast gray scale), 

IN-57 to IN-58 
high-resolution colors, IN-29, IN-30, IN-31 
high-resolution files, IN-18, IN-27, IN-35 
high-resolution graphics mode, IN-60, IN-69 
Hijaak, IN-27 
Home key 

cursor movement with, IN-1 5, IN-1 9 
set clip lines with, IN-1 5, IN-19, IN-28 

Horizontal command (rotate image), IN-58 to 
IN-59 

hot keys. See pop-up keys 
.HPC file extension (Hijaak files), IN-27 

I20C.EXE, IN-9 
I20F.EXE, IN-9 
I20S.EXE, IN-9 
IBM graphics adapters, IN-68, IN-69 

IBM Monochrome Display, IN-69, IN-73 
Image command, IN-49 
images 

capture, IN-9, IN-14 to IN-1 5, IN-26 to 
IN-27 

capture from other programs, IN-78 to 
IN-80 

clip, IN-1 5 to IN-16, IN-19, IN-22 to 
IN-23, IN-27 to IN-29 

clip art, IN-27, IN-45 
compress vertically, IN-62 
create, IN-33 to IN-34 
display, IN-1 5, IN-1 7 to IN-1 8, IN-34 to 

IN-35 
display with F9 key, IN-43 
distorted, IN-45, IN-63 
erase enclosed area in, IN-40 to IN-41 
fill enclosed area in, IN-42 to IN-43 
fuzzy, IN-77 
merge into pix files, IN-20, IN-29, IN-32, 

IN-44 to IN-45 
merge into text files, IN-1 6 to IN-1 7, 

IN-45 to IN-47, IN-52 
check placement, IN-46 
preview, IN-53 to IN-54 

modify, IN-1 5 to IN-1 6, IN-22 to IN-23, 
IN-48 to IN-49 

modify without displaying, IN-26, IN-49 
move within a document, IN-51 
offset for printing, IN-51 
password-protect, IN-26, IN-35, IN-52, 

IN-59, IN-61 
position of, IN-77 
print, IN-1 3, IN-24, IN-47, IN-54 to 

IN-58 
printing problems, IN-55, IN-56, IN-59, 

IN-63, IN-76 to IN-78 
rotate, IN-58 to IN-59 
save, IN-14 to IN-1 5, IN-26 to IN-27, 

IN-59 to IN-60 
and BSAVE/BLOAD BASIC 

commands, IN-52 
quick key (F1 O), IN-43 

very high-resolution, IN-74 
very large, IN-74 
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images (continued) 
wavy, IN-77 
zooming in on (WordStar), IN-53 
See also edit images; pix files; size images 

Import command, IN-20, IN-29, IN-32, 
IN-44 to IN-45 

IN.SET file, IN-76 
Inches command, IN-1 6, IN-23, IN-61 to 

IN-62, IN-76 
.INF file extension, IN-66 
Ink command, IN-56, IN-58 

settings for, IN-27, IN-33 to IN-34, IN-55, 
IN-59 

insert images into pix files. See merge images 
into pix files 

insert images into text files. See merge images 
into text files 

lnset 
compatibility with other programs, IN-78 

to IN-80 
overview of, IN-5 to IN-7 

installation, IN-7 to IN-9 
See also configuration 

Invert command (black and white printing), 
IN-56 €0 IN-57 

inverted text, IN-65 
Italics command, IN-66 

keyboard modes, IN-73, IN-75, IN-78 to 
IN-80 

AL, cursor left, IN-I 0 
landscape mode, IN-55, IN-71 
laser printers 

Hewlett-Packard LaserJet printers, IN-26, 
IN-70 

and incomplete printed images, IN-77 

laser printers (continued) 
and number of buffers, IN-70 
side-by-side images printable on, IN-46 
See also printers 

LaserJet printers. See laser printers 
leading. See line height 
left arrow key (t) 

cursor movement in menus, IN-10 
macro character for, IN-72 

Left command (rotate image), IN-58 
Left command (rotate text), IN-65 
LEISURE.PIX file, IN-1 8, IN-27 
letter quality printing, IN-55, IN-71 
letterhead, tutorial for creating, IN-1 7 to 

IN-24 
.Ih (line height). See line height (Ah) 
line feed, IN-55 
line height (Ah) 

changes when printing text, IN-47, IN-78 
and staggered horizontal image lines, 

IN-77 
line spacing, and staggered horizontal image 

lines, IN-77 
line width, change, IN-39 to IN-40, IN-43 
lines, drawing, IN-36 
list pix files, IN-34 to IN-35 
Load command (load font), IN-66 
load Inset, IN-9 to IN-I 0, IN-14 

/c parameter, IN-9, IN-27 
capture-only version, IN-9, IN-27, IN-33, 

IN-40, IN-73 
"Mouse Installed" message, IN-76 
not working, IN-75 to IN-76 
from WordStar, IN-9, IN-10, IN-14, 

IN-52, IN-76 
LOGO.PIX file, IN-22, IN-23, IN-24 
LOGOS1 .PIX file, IN-1 8, IN-27 
LOGOS2.PIX file, IN-1 8, IN-27 
Lotus 1-2-3, IN-69, IN-73, IN-79 
LShift-Ctrl keys 

with Hercules graphics adapter, IN-68 
not working, IN-69, IN-73, IN-75 to 

IN-76 
starting lnset with, IN-9, IN-14, IN-52 to 

IN-53, IN-71 to IN-72 
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macros, IN-72 to IN-73 
start Inset with, IN-81 

Magnify command (enlarge screen image), 
IN-39, IN-41, IN-47 to IN-48 

Main Menu, IN-48 
MAN.PIX file, IN-1 8 
Margin command (for printing), IN-55 
mark block, IN-32 
MCGA monochrome adapter, IN-68 
medium-resolution colors, IN-29, IN-30 
medium-resolution graphics mode, IN-52, 

IN-60, IN-69 
memory. See RAM 
menus 

and beep sound, IN-76 
choosing a command, IN-1 0 
clear from screen, IN-48 
correct improper display of, IN-53, 

IN-75 to IN-76 
exit, IN-1 2 
Main Menu, IN-48 
overview of, IN-1 0, IN-48 
tree structure of, IN-1 1 

merge images into pix files, IN-20, IN-29, 
IN-32, IN-44 to IN-45 

merge images into text files, IN-1 6 to IN-1 7, 
IN-45 to IN-47, IN-52 

check placement, IN-46 
preview, IN-53 to IN-54 

Microsoft Windows, IN-80 
minus key (-), IN-39, IN-48, IN-63 
MODE command (DOS), IN-70 
modify images, IN-1 5 to IN-1 6, IN-22 to 

IN-23, IN-48 to IN-49 
without displaying, IN-26, IN-49 
See also Border command; change; clip 

images; edit images; rotate 
images; size images 

Modify Menu commands, IN-49 
monitors 

CGA, IN-29 to IN-31, IN-57 
EGA, IN-29 to IN-31, IN-57 

monitors (continued) 
monochrome 

palette for, IN-30, IN-57 
without graphics adapters, IN-6 to 

IN-7, IN-9, IN-33, IN-40 
monochrome graphics adapters, IN-68, IN-69 
monochrome mode, IN-33 
monochrome monitors 

palette for, IN-30, IN-57 
without graphics adapters, IN-6 to IN-7, 

IN-9, IN-33, IN-40 
"Mouse Installed" message, IN-76 
mouse support, IN-49 to IN-50 
move 

block, IN-50 
clip lines, IN-1 5, IN-19, IN-22 to IN-23, 

IN-28 
movement. See cursor movement 

Natural command (enlarge image), IN-63 
NoMenu command, IN-48, IN-49 
NOMOUSE.COM, IN-77 
non-page printers 

and line height of text, IN-47 
and multiple pix tags on one line, IN-46 

Normal command (italics off), IN-66 

Offset command, IN-51 
AOP (Advanced Page Preview). See preview 
Options command, IN-20 
Output command, IN-54 
ovals, drawing, IN-37 to IN-38 
override macro, IN-73 
override pop-up keys, IN-9, IN-53, IN-72 

See also Alt-LShift-I keys 
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"P& (start Inset from within Wordstar), IN-9, 
IN-1 0, IN-1 7, IN-41, IN-52, IN-76 

AP* command (pix tag), IN-I 6 to IN-1 7, 
IN-46 to IN-47, IN-52 

page breaks, IN-46, IN-78 
Page Down key. See PgDn key 
page preview. See preview 
palette, IN-30 to IN-31 

change, IN-30, IN-31 
with Clear command, IN-33 
with F2 key, IN-43 

Pass command, IN-56 
settings for, IN-27, IN-33 to IN-34, IN-55, 

IN-59 
Passive keyboard mode, IN-73 
password, entering, IN-61 
password-protected files, IN-26, IN-35, 

IN-52, IN-59, IN-61 
paths (directory), IN-71 
pause, macro character for, IN-72 
PC-Font command (default font), IN-66 
PC-Paint, IN-79 
PC-Paintbrush, IN-80 
PC.PIX file, IN-1 8 
PCMAN.PIX file, IN-1 8 
PDF file. See printer drivers 
PDFEDIT program, IN-54, IN-77 
PgDn key 

cursor movement with, IN-1 5, IN-I 9 
drawing rectangles with, IN-21 
set clip lines with, IN-15, IN-19, IN-28 

Pitch command, IN-51, IN-62, IN-71 
.PIX file extension, IN-1 4 to IN-1 5, IN-26, 

IN-34, IN-51, IN-59 
pix files, IN-26, IN-51 to IN-52 

and BSAVVBLOAD BASIC commands, 
IN-52 

capture images in, IN-1 4 to IN-1 5, 
IN-26 to IN-27, IN-51 to IN-52 

compressed format of, IN-52 
defined, IN-1 4 

pix files (continued) 
directories, IN-51 to IN-52, IN-71 
display, IN-1 7 to IN-1 8, IN-34 to IN-35 
display with F9 key, IN-43 
high-resolution, IN-1 8, IN-27 
list, IN-34 to IN-35 
password-protected, IN-26, IN-35, IN-52, 

IN-59, IN-61 
screen mode conversion for, IN-35 
size of, IN-74 
supplied with Inset, IN-1 8 
See also images 

pix tag command ("P*), IN-1 6 to IN-1 7, 
IN-46 to IN-47, IN-52 

pix tag defined, IN-6, IN-16, IN-52 
pixels, IN-52, IN-60 
placement check for images, IN-46 
plus key (+), IN-39, IN-48, IN-63 
pop-up keys 

change, IN-71 to IN-72 
default (LShift-Ctrl), IN-9, IN-14, IN-52 to 

IN-53, IN-71 to IN-72 
not working, IN-53, IN-69, IN-73, 

IN-75 to IN-76 
override (Alt-LShift-I), IN-9, IN-53, IN-69, 

IN-72 
port for printer, IN-54, IN-70 
position of images, IN-77 
pound sign (#), macro pause character, IN-72 
preview 

Advanced Page Preview (AOP), IN-1 7, 
IN-31, IN-46 to IN-47, IN-53 

graphics mode required for, IN-1 7, IN-31, 
IN-53 

Preview command, IN-53 to IN-54 
printer description file (PDF). See printer 

drivers 
printer drivers, IN-8, IN-54, IN-70, IN-77 

change, IN-54 
Printer option (capture-only Inset), IN-27 
printers 

setup, IN-54, IN-70 to IN-71 
See also dot matrix printers; laser printers; 

non-page printers 
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printing 
in black and white, IN-54, IN-56 to 

IN-57, IN-70 
with colors or shades of gray, IN-54, 

IN-56 to IN-58, IN-70 
in double-pass mode, IN-56 
draft quality, IN-55, IN-71, IN-77 
in landscape mode, IN-55, IN-71 
letter quality, IN-55, IN-71 
problems with, IN-55, IN-56, IN-59, 

IN-63, IN-76 to IN-78 
in single-pass mode, IN-56 
speeding up, IN-70, IN-74 
stop (Ctrl-Break), IN-55 

QuadEGA+ Board, IN-69 
Quality command (printing), IN-55, IN-71 
question mark (?I, as wild-card character, 

IN-34 
quit 

printing (Ctrl-Break), IN-55 
See also exit 

/\R, cursor right, IN-1 0 
RAM 

and capture-only Inset, IN-9, IN-40, 
IN-73 

insufficient memory for printing, IN-77 
insufficient memory to load Inset, IN-76 
and "P& command, IN-76 
page buffer use of, IN-70 
remove lnset from (ri command), IN-8, 

IN-9, IN-1 2, IN-41 
remove lnset from (while in WordStar), 

IN-9, IN-1 2 
required by Inset, IN-6, IN-74 

RAM disk, for overflow files, IN-71 

RAM-resident programs, and Inset, IN-1 2, 
IN-41, IN-73 

RAMfonts, IN-68 
Random command (gray scale), IN-57 to 

IN-58 
rectangles, drawing, IN-36 to IN-37 
remove lnset from memory 

ri command, IN-8, IN-9, IN-12, IN-41 
while in WordStar, IN-9, IN-1 2, IN-41 

Replace command (R) (replace file), IN-26 
IN-59 

reroute printer output, IN-54, IN-70 
ReSize command, IN-61, IN-63 
resolution. See screen resolution 
restore deleted text. See Undo command 
Return key. See Enter key (J) 
reverse line feed, IN-55 
ri (remove lnset from memory), IN-8, IN-9, 

IN-12, IN-41 
right arrow key (+) 

cursor movement in menus, 20 
macro character for, IN-72 

Right command (rotate image), IN-58 
Right command (rotate text), IN-65 
Rotate command, IN-58 to IN-59 

settings for, IN-27, IN-33 to IN-34, IN-55, 
IN-59 

rotate images, IN-58 to IN-59 
and BSAVE/BLOAD BASIC commands, 

IN-52 
rotate text (Direction command), IN-65 

SAMPLE.PIX file, IN-81 
Save command, IN-1 4 to IN-I 5, IN-26 to 

IN-27, IN-59 to IN-60 
for borders, IN-26 
and BSAVE/BLOAD BASIC commands 

IN-52 
for captured images, IN-14 to IN-1 5, 

IN-26, IN-51 to IN-52 
for clipped images, IN-1 9, IN-28 
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Save command (continued) 
for edited images, IN-22, IN-52 
quick key (FlO), IN-43, IN-59 
for sized images, IN-23 
when not to use, IN-49, IN-58, IN-60, 

IN-63 
Scale command (enlarge image), IN-63 
screen colors, IN-29 to IN-31 
screen drivers, IN-68 to IN-69 
screen modes 

described, IN-60 
See also graphics mode; screen 

resolution; text mode 
Screen option (capture-only Inset), IN-27 
screen resolution 

convert, IN-35 
starting lnset when resolution unknown, 

IN-53, IN-69, IN-72 
types described, IN-52, IN-60 

Semi-active keyboard mode, IN-73, IN-75 
semicolon (;), macro Enter key (J) character, 

IN-72 
SETUP.COM, IN-67 
setup options, IN-67 to IN-74 
Shift key (speed cursor movement), IN-1 5, 

IN-1 9 
Shift-PrtSc keys, IN-73 
show. See display 
signature files (.SIC file extension), IN-26, 

IN-34, IN-35, IN-59, IN-61 
single-pass mode, IN-56, IN-77 
size images 

and BSAVVBLOAD BASIC commands, 
IN-52 

Expand command, IN-1 6, IN-23, IN-61 to 
IN-63 

Magnify command, IN-39, IN-41, 
IN-47 to IN-48 

ReSize command, IN-61, IN-63 
too wide images, IN-59 
See also clip images 

size of pix files, IN-74 
small version of Inset. See capture-only lnset 

Spacebar 
with Dots command, IN-39 
with Font Load command, IN-66 
with Import command, IN-45 
with Magnify command, IN-48 
mouse button for, IN-49 

speeding up 
cursor movement, IN-1 5, IN-1 9 
printing, IN-70, IN-74 

spreadsheets 
capture image from, IN-26 to IN-27 
too wide for printing, IN-59 
See also specific spreadsheet programs 

SSPlX directory (Lotus 1 -2-3), IN-73 
Standard command (standard colors or gray 

levels), IN-56 to IN-57 
start lnset 

with macros, IN-81 
not working, IN-69, IN-73, IN-75 to 

IN-76 
with specific graphics boards 

(Alt-LShift-I), IN-9, IN-69, IN-72 
standard procedure (LShift-Ctrl), IN-9, 

IN-14, IN-52 to IN-53, IN-71 to 
IN-72 

from within WordStar ("P&), IN-9, IN-1 0, 
IN-14, IN-52, IN-76 

Status command, IN-27, IN-34, IN-49 
Std command (standard colors or gray levels), 

IN-56 to IN-57 
stop 

printing (Ctrl-Break), IN-55 
See also exit 

SYMBOLS.PIX file, IN-1 8, IN-27 
Symphony, IN-73, IN-80 

Table command (menu of colors or gray 
levels), IN-57 

Tecmar graphics adapters, IN-69 
terminate-and-stay-resident programs, and 

Inset, IN-1 2, IN-41, IN-73 
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TEST.PIX file, IN-1 8 
text 

add to graphic images, IN-21 to IN-22, 
IN-63 to IN-66 

boldface, IN-65 
color of, IN-64 
delete from graphic images, IN-22, IN-64 
freeze, IN-22, IN-64 
height of, IN-65 

changes when printing, IN-47, IN-78 
italics, IN-66 
rotate, IN-65 
width of, IN-65 to IN-66 
See also merge images into text files 

text mode 
convert to graphics mode, IN-31, IN-60 
described, IN-60 
editing not possible in, IN-31, IN-40, 

IN-53 
previewing not possible in, IN-17, IN-31, 

IN-53 
Top command, IN-55 
Toshiba 31 00 graphics adapter, IN-68 
troubleshooting 

general, IN-75 to IN-76 
printing, IN-55, IN-56, IN-59, IN-63, 

IN-76 to IN-78 
TSR programs, and Inset, IN-1 2, IN-41, IN-73 

Undo command (erase text), IN-22, IN-64 
Up command (reverse line feed), IN-55 
Up command (rotate text), IN-65 
upside-down text, IN-65 

versions of Inset, IN-73 
See also capture-only lnset 

vertical compression of images, IN-62 

vertical text, IN-65 
video. See monitors 
Video Graphics Adapter (VGA), IN-68 
View command (display images), IN-1 5, 

IN-1 7 to IN-1 8, IN-34 to IN-35 
virtual disk, for overflow files, IN-71 

wavy images, IN-77 
Width command (line or dot width), IN-39 to 

IN-40 
Width command (text width), IN-65 to IN-66 
width of paper for printing, IN-55, IN-59, 

IN-71 
width of printed image, IN-62 to IN-63 
wild-card characters, IN-34 
Windows (Microsoft), IN-80 
WordStar 

Advanced Page Preview ("OP), IN-1 7, 
IN-31, IN-46 to IN-47, IN-53 

insert images into documents, IN-1 6 to 
IN-1 7, IN-24, IN-45 to IN-47, 
IN-52 

load and start lnset from within ("P&), 
IN-9, IN-10, IN-14, IN-52, IN-76 

move images within documents, IN-51 
print documents with pix tags, IN-46, 

IN-52, IN-54 
remove lnset while within, IN-9, IN-12, 

IN-41 
and zooming in on images, IN-53 

worksheets. See spreadsheets 
.WSG file extension, IN-53 
Wyse 700 graphics adapter, IN-69 

z 
zooming in on images (WordStar), IN-53 
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Introduction 
Wordstarn includes MailList, a program that makes it easy to work with mailing lists. 
You can use merge printing to insert information from your mailing list into personal- 
ized letters for mass mailings. You can also print reports, labels, and envelopes with 
the information from a mailing list. 

With MailList, you can create one or more mailing lists. You just display a form on the 
screen and type information in the blanks. Besides keeping names and addresses in 
your mailing list, you can also keep telephone numbers and other information you may 
want to save. MailList gives you a choice of two forms, one for mailing lists and the 
other for lists such as inventories. You can update your lists any time and sort them in 
any order you want. 

The MailList documentation is organized into three chapters: 

"Creating and Updating a Mailing List" covers the basic operations for creating and 
maintaining mailing lists. 

"Creating Form Letters" gives guidelines for using the WordStar merge print commands 
to create form letters for use with a mailing list. 

"Printing Envelopes, Labels, and Lists" contains instructions for easy printing of 
envelopes, labels, and reports using the information in a mailing list. 

If you didn't copy MailList when you installed WordStar, do so now. See the Installing 
and Customizing booklet for information on adding a feature. 



Creating and Updating 
a Mailing List 

MailList enables you to create lists of names, addresses, and other information. Each 
list i s  kept on disk in a file called a data file. The following pages give step-by-step 
procedures for creating and maintaining your mailing lists. 

Starting Mail1 ist 
Follow these steps to start using MailList. 

1 To start MailList using pull-down menus, select Additional at the WordStar Opening 
screen, then choose Maillist. 

To start MailList using classic menus, press A at the WordStar Opening Menu, then 
press M for MailList. 

The MailList Menu appears. 

2 Press C to choose a data file. MailList displays a list of the data files (files with the 
.DTA extension) in the directory that contains the MailList files. 

MailList comes with a data file named WSLIST.DTA, which is  empty. WSLIST.DTA 
is  the default data file; if you don't choose a data file, this is the file you will work 
with. 



T I P  You can use WSLIST.DTA as your main mailing list file. Just choose i t  as the 
data file when you're ready to start your mailing list, then enter your list as 
described below in %dding Names and Addresses." If you do this, you won't have 
to choose a new data file each time you start working on your mailing list. 

If you want to display a list of data files in a different directory, first type \ and 
press J to display a list of directory names, then move the highlighting to the direc- 
tory you want and press J. 

3 Type the name of the data file you want to create or update and press J. Include 
the drive letter or directory path if necessary. You don't have to type the .DTA 
extension; MailList automatically adds this extension. (If you're updating a mailing 
list, you can move the highlighting to the filename and press J instead of typing 
the name.) 

C A U T I  0 N To choose a file that you entered using the inventory form rather 
than the mailing list form, you must first choose the inventory form. Otherwise, 
when you type the filename, an error message appears. See "Using Another Data 
Entry Form" in  this chapter. 

Running Maillist from Another Directory 

If you try to run MailList from a directory other than the one that contains your MailList 
data files (WSLIST.DTA), you get the message Can't find WSLIST.DTA on drive x. If 
you press J , WordStar creates a new WSLIST.DTA file in the current directory, allow- 
ing you to run MailList. Keep in mind that if you ran MailList previously from a dif- 
ferent directory, any data you entered in the WSLIST.DTA file in that directory is not 
contained in the new WSLIST.DTA file. 

Adding Names and Addresses 
You add names, addresses, and other information to your mailing list by filling in an 
onscreen data entry form. You fill in the form once for each person on the list; the 
entry for each person is called a record. Each piece of information in a record, such as 
first name or phone number, is called a field. The information that you enter in a field 
is  called data. The data for the entire mailing list i s  kept on disk in a data file. 

You assign a number, usually 1, to the first record in each MailList data file. MailList 
sequentially numbers the rest of the records for you. 

I Press A at the MailList Menu. The data entry form appears, with the Add New 
Records Menu at the top of the screen. If this is the first record in a new mailing 
list, the cursor is in the Record Number field. Otherwise, the record number is the 
first available number, and the cursor i s  in the First Name field. 
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The example below shows the mailing list data entry form, WSLIST.DEF. (Another 
form, INVNTORY.DEF, i s  also available. You work with it in the same way as with 
the mailing list form. It is shown in "Using Another Data Entry Form.") 

Note: If you keep data files on any disks or directories other than the MailList direc- 
tory, copy WSLIST.DEF and 1NVNTORY.DEF to each of these disks or directories. 

2 For a new data file, type the number you want the first record to have (generally 1) 
and press J. 

3 Fi l l  in the data entry form for the first person on your list or the next person you 
want to add. At each field, type the information and press J. The cursor moves to 
the next field. 

All the fields are optional; you are not required to fill in any field. To skip a field 
and go on to the next one, press J. 

Always start typing in the first space of a field; if the data in the field begins with a 
blank space, you won't be able to sort it properly. 

- 

- 

FORM:- I *  I *  

e o p y  from previous record W r i t e k a u e  record in file [jll Help 

=ape 

Type data and press w. 

Record Number: : : : : r b Date: 
Mr./Hs.: mm/dd/yy 

First, Init., Last: Jr.4i.D.: - 
Title: 

Company: I 
Clddress Line 1: m m 
Address Line 2: - I 

City, State, Zip: - rn 
Country: 
Phone-1: 
Phone-2: 

User Fields- Re~arks-  
1: - 
2: - 
3: - 



If you make a typing error, you can erase characters with the Backspace key. You 
can move the cursor around the form using these commands: 

Left one character 
Right one character 
Previous field 
Next field 
Top (first) field 
Last field 

or t 
AD or + 
A A o r A t  
AF or A + 
AT or Home 
AL or End 

4 When the form is completed, press J after the last field or press "W from any other 
field. Then press J again to save the data as a record. 

A blank form appears, with the next record number already entered. 

5 Enter the rest of your records in the same way. Be sure to save each record (using 
step 4 above) as you complete it. You can't save records in groups. 

T I P  At any field, you can copy the same information you previously typed for the 
field by pressing AC. For example, if you're adding several records and they all 
have the same date, type the date in the 'first record. Then when you get to the Date 
field in each subsequent record, just press "C, and the same date is automatically 
inserted. 

6 After you enter and save all your records, press Esc to return to the MailList Menu. 

Updating and Correcfing a Mailfng List 
After you create your mailing list, you can look at your records and make changes. To 
change any information, use the steps below to display the record on the screen, make 
your changes, and save the updated record. 

1 Press V at the MailList Menu. The View and Edit Records Menu appears with the 
first record in your mailing list. 

2 Make any changes you want. Use the same cursor commands as you do to add a 
record. 

3 Press AW. Then press J to save the updated record. The next record appears. (If 
you press AW and then decide you don't want to save the changes, you can press 
Spacebar to return to the record without saving the changes, or you can press Esc to 
abandon the changes and return to the MailList Menu.) 

4 Continue editing your records. If you don't want to change a record, you can press 
AN to display the next record or AP to display the brevious record. 

5 After you save the last record you want to change, press Esc to return to the MailList 
Menu. 
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Normally, you view and edit your records in order of record number. However, if 
you've sorted your mailing list in another order, the records appear in the sorted or- 
der. See "Sorting Mailing Lists." You can also view and edit particular records 
without going through all the records in order. See "Working with a Specific Group 
of Records" and "Finding a Particular Record." 

6 After you finish editing records, sort your mailing list. See "Sorting Mailing Lists." 

Working with a Specific Group of Records 
You may want to view or update a specific part of your mailing list, such as all records 
with the name "Weiss" or all records with the city of "Summertown" in the state of "TN." 
You can use a record filter to display only certain records. The record filter "filters out" 
the records you don't want. 

1 At the MailList Menu, press V to display the View and Edit Records Menu. 

2 Press AC for Create or Change Filter. The data entry,form appears with asterisks in 
place of the data in each field. The Record Filter Menu is at the top of the screen. 

3 Move the cursor to a field you want to use as the filter, and type the information 
you want to match in that field. If you want to use more than one field, move the 
cursor to each field you want to use and type the information to match. 

- 

Record Number: 
Mr./Hs. : M U / ~ ~ / Y Y  

First, Init., Last: Jr./M.D.: 
Title: 

I 

FORM:- m!5lH5m 

Type data in the fieldcs) you uant to match and press $. 

@ r a s e  filter M s e  this filter [g Help 

[ZQape 



In the above example, two fields are used as the filter, "CA" for state and "95" for the 
first two digits of the ZIP code. 

4 Press AU to start using the filter. The View and Edit Records Menu appears with the 
first record that matches the data in the filter. 

You can keep viewing and editing records as usual, except that only the records 
that match the filter are displayed. 

While you are using a filter, you can press "C again at the View and Edit Records Menu 
to change the filter. To stop using the filter, press "E at the Record Filter Menu. Other- 
wise, the filter is automatically erased when you exit the current View session. 

Finding a Particular Record 
You can select a specific record to view or edit by giving its record number. 

1 At the MailList Menu, press 1. The Locate Records by Number Menu appears with 
a blank data entry form. The cursor is in the Record Number field. 

2 Type the number of the record you want to see and press J . The matching record 
appears. 

3 You can either edit the record or view other records in numerical order beginning 
with the record on the screen. 

To edit the record, make changes the same way you do when adding or viewing a 
record. After you finish editing, press AW, then J . A blank record appears again 
with the cursor in the Record Number field. You can enter another record number 
to display another record. 

To view other records, press "P to display the previous record or AN to display the 
next record. 

4 When you finish locating and editing records, press Esc. The MailList Menu 
appears. 

Erasing Records 
You can erase a record only when it is displayed on the screen. 

1 Use either V (View) or L (Locate) at the MailList Menu to display the record you 
want to erase. 

2 Press "E. 

3 Press R to confirm that you want to remove the record. MailList removes the record 
from the mailing list. 

4 After you finish erasing records, sort the mailing list (see "Sorting Mailing Lists" on 
the next page). 
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sorting Mailing Lists 
When you view your mailing list, records normally appear in the order in which you 
entered them. You can sort the mailing list to make records appear in any order you 
want. After you sort the list, records appear in the sorted order until you sort them 
again. You can save up to 32 different orders for sorting mailing lists; for example, 
sometimes you may want to sort by name and other times by date, by state, or ZIP 
code. (You can also save up to 32 sort orders for the inventory data entry form.) 

After you update or erase records, you should sort your list to put the records in the or- 
der you want and to use disk space more efficiently. Sorting the mailing list puts the 
updated records back into place in the data file and erases information left from before 
you updated the mailing list. 

Ti P When you merge print with your mailing list, the form letters (or labels, en- 
velopes, etc.) are printed in the sorted order. Sorting your mailing list before printing 
enables you, for example, to print labels in ZIP code order. 

To sort your mailing list without changing the sort order, use the following steps: 

1 Press S at the MailList Menu. The Sort Records Menu appears with a data entry 
form that shows the current sort order, which is  the order you used the last time you 
sorted a mailing list. If you haven't used any sort orders, the default sort order is in 
order of record numbers. 

2 Press W. MailList sorts the mailing list. When sorting is  finished, a message ap- 
pears. 

3 Press Esc to return to the MailList Menu. 

C A U T 0 N If you sometimes use leading spaces or zeros in a field, remember that 
MailList wil l  consider these spaces and zeros when it sorts. Be sure to use these 
characters consistently so that you can sort the records in the way you want. 

You may want to sort your mailing list into different orders for different purposes. For 
example, you may want to edit records in order of record number, print out phone lists 
in alphabetical order, and print labels in ZIP code order. The following sections tell 
you how to create a new sort order and how to change between sort orders. 

Creating a Sort Order 
Follow the steps below to create a new sort order. 

1 Press S at the MailList Menu. The Sort Records Menu appears at the top of the 
screen. 

Below the menu is a data entry form that shows the current sort order. This i s  the 
order you used last time you sorted a mailing list. If you haven't created any sort 
orders, the form looks like the one on the next page. This form shows the default 
sort order, RECORDNO. The 11 1 1 A in the Record Number field means that the list 
will be sorted in order of record number. 



2 Press "C to choose a new sort order. A list of the available sort orders appears. If 
you haven't created any sort orders, the only one listed is RECORDNO. 

- 

- 

3 Type the name you want to give to the new sort order and press J . A sort order 
name can have up to eight letters and numbers. The data entry form appears for 
you to enter the sort order. 

The sort order is based on up to nine fields called keys. The first key is  the first field 
that is  checked when sorting. If several records have the same information for the 
first key, the second key is checked, and so on. For example, if the first key is the 
State field, all the records with AK will be first, those with AL will be next, and so 
on. If the second key is  Last (last name), the records within each state will be in al- 
phabetical order by last name. If the third key is First (first name), whenever more 
than one record has the same state and last name, those records will be in al- 
phabetical order by the first name. 

SORT ORDER ml5am 

4 Move the cursor to the field you want to be the first key. Use the same keys you 
use when editing records: "F or A+ to move to the next field and "A or A t  to 
move to the previous field. 

ase order e this order 
ey field cend&scend 
aue sort order r I! oose/Create sort order 

5 When the cursor is in the field you want, press "K. The field fills with the number 
1, except for the last character in the field, which is  an A for ascending order. 

N! Help 

W a p e  

When MailList sorts, it uses this order for characters: first spaces, then digits starting 
with 0, then letters starting with A (for each letter, lowercase immediately follows 
uppercase). This is considered ascending order. You can have MailList sort any 

Press a highlighted letter or number. 

Record Nu~ber: M M M M M  Date: 

First, Init.. Last: 

Address Line 1: 
Address Line 2: 

City, State, Zip: 

Use 
1: 
2: 
3: 
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key in descending order, which is the opposite order. In descending order, for ex- 
ample, Z is the first letter of the alphabet and A is  the last, and letters come before 
numbers. Just put the cursor in the key field and press D. The A that is the last 
character in the key changes to a D. To change a key back to ascending order 
when it is in descending order, move the cursor to the key field and press A. 

6 Move the cursor to the second key field and press AK. The field fills up with the 
number 2, with A as the last character. 

Mark the rest of your keys in the same way. When you're finished, your screen 
should look similar to the following example, in which four keys are used, State, 
Last, First, and Initial. 

I I  ' 
I 

Press a highlighted letter or number. 

- 

Record Nunber: Y ~ Y Y Y Y Y ~ ~ Y Y ~ w ~ ~ ~ w ~ ~ ~ ~ ~ ~ w w w n ~ w ~ ~ w  ~ ~ t ~ :  
tlr.4~. : an/dd/yy 

First. Init., Last: 
Title: -7 J~./H.D.: 

Company: 
fiddress Line 1: 
Address Line 2: 

City, State, Zip: 
Country: 
Phone-1: 
Phone-2: 

Us 1: 1 RE 

2: 
P 

3: 
system fields: [**I Cwrww****wl Sort this field for yynndd -->C*www**I 

SORT ORDER 

7 You can press AU to save the new sort order and sort your mailing list, or you can 
press AS to save the sort order without sorting. 

ase order e this order 
ey field 
ue sort order oose/Create sort order 

8 Press Esc to return to the MailList Menu. 

[g Help 

D a p e  

Note: To sort by date, you need to choose a special date field. When you enter the 
date in a record, you enter it as month, day, and year. This date also appears on the 
bottom right of the sort screen as year, month, and day. This extra field i s  the one you 
must use as a key for sorting. 



Choosing a Sort Order 
To change from one sort order to another, press AC (Choose sort order) at the Sort 
Records Menu. A list of the available sort orders appears. Choose the order you want. 
A data entry form appears showing the order you choose. 

Note: The sort orders you create are stored in a file named MAILSORT.OVR in the cur- 
rent disk or directory. If you don't see the list of sort orders you expect, you may need 
to copy this file from the disk or directory where you created it. 

When the sort order is  on the screen, you can use it to sort the mailing list or you can 
edit or erase the sort order as described below: 

w To sort the mailing list using the displayed sort order, press AU. 

You can edit a sort order to add keys or to change a key from ascending order to 
descending order or vice versa. You can't change the order of keys that are already 
in the sort order, and you can't delete keys. For example, if you have a sort order 
that has two keys, ZIP code and last name, you can add first name as the third key, 
or you can change from ascending ZIP code order to descending order. To edit the 
displayed sort order, just use AK and the A and D commands as you do when creat- 
ing a sort order. When you finish editing, press AS to save the sort order or AU to 
save the sort order and sort the mailing list. 

If you have created the maximum 32 sort orders and want to create another one, 
you need to erase an existing sort order. You can also erase sort orders you no 
longer use. To erase the displayed sort order, press "E, then answer Y to confirm 
that you want to erase the sort order. After you erase a sort order, it no longer ap- 
pears in the list you see when you press AC to choose a sort order. 

Exiting MailList 
When you finish working with your mailing list, press Q at the MailList Menu to return 
to WordStar. Be sure to exit WordStar before you turn off your computer. (Using pull- 
down menus, select File at the Opening screen, then choose Exit WordStar. Using 
classic menus, press X at the Opening Menu.) 

C A U T I  0 N If you exit incorrectly, your data file may be damaged. 

M a i l ~ i s t  Index Files 
When you create or update a mailing list data file, MailList also creates or updates an 
index file. The index file has the same filename as the data file with the .NDX exten- 
sion. For example, if you name your data file CLIENTS.DTA, the index file is named 
CLIENTS.NDX. 
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Data files and index files go together. MailList needs to use the index file whenever 
you work with your mailing list. If you've erased your index file, when you try to work 
on your mailing list, a message appears telling you that the index file is missing and in- 
structing you to press R to rebuild the index file. 

Backing Up Mailing Lists 

Make frequent backup copies of your data and index files. Always keep at least one ex- 
tra copy of your mailing list on a floppy disk. This i s  your insurance against accidental 
erasures, damaged disks, and other problems. 

Using   not her Data Entry Form 

In the examples so far, the mailing list data entry form was used. MailList also provides 
an alternate data entry form called the inventory form. You can use the inventory form 
for any list that doesn't include name and address information. The data entry forms 
are stored in files with the .DEF extension. The mailing list form is WSLIST.DEF. The 
inventory form, shown below, i s  INVNTORY.DEF. ' 

Each time you start MailList, the WSLIST.DEF form is the current form. This form is  
used for any mailing list you create unless you select the inventory form. 

- 

- 

roRn:r-w 

~ P Y  f r a  previous record mite/save record in file [3j Help 

m p e  

Type data, and press m. 
Record NI Date: 
Item: L - Code: b- Status: 1 - 1 

Description: 1 - - - 
Account: -1 - -1 
Quantity: m-1 - - 

Price: - -1 -1 
User Fields- Remarks- 
1: - I 
2 : 
3 : 

I 
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Follow the steps below to change to the inventory form, or from the inventory form 
back to the mailing list form. 

7 Press U at the MailList Menu. A list of the form files appears. 

2 Type the name of the form you want or move the highlighting to the name. Press J. 

The form name you choose is now the current form until you exit MailList or choose 
another form. If you try to edit a mailing list that uses a form different from the current 
one, an error message appears, and you must select the correct form before you can 
edit the list. 



Creating Form Letters 
You can use information from your mailing list in form letters and other documents. 
You do this by creating a master document, which contains both the text of the letter 
and the merge print commands and variables. Before you create a master document for 
your mailing list, read the Merge printing section of the Reference manual. 

Starting the Document 

Use the following steps to create a master document to use with your MailList list. 

1 Open a WordStar document file. For the filename, type the name you want to give 
the file and press J. 

T I  P You may want to give all your master documents the same filename exten- 
sion (for example, .MRG) so that you can easily identify them. 

2 Choose the File command on the Insert menu (Alt+l,F) or use the "KR classic com- 
mand to insert a file. At the Insert File dialog box, type the filename maillist.dot. If 
necessary, include a directory path for the MAILLIST.DOT file. (To create a master 
document for an inventory list, type invntory.dot and press J.) 

Your master document should look like the one on the next page. The document i s  fol- 
lowed by brief explanations of the commands. For more information on these com- 
mands, refer to the information on merge printing in the Reference manual. (If you 
used INVNTORY.DOT, the dot commands contain different information.) 



. OP . df wslist . dta 

.rv x, number, full-name, first, mi, last, Mr-Ms, title 

.rv company, addrl, addr2, city, state, zip, country 

.rv phonel, date, Jr-MD, 

.rv userl, phone2, user2, x, user3, remarkl, remark2, remark3, ymd 

(Type text and variable names here.) 

The .op command omits page numbers, since most form letters don't need page num- 
bers; you can delete this command if you want to print page numbers. 

The .df command defines the data file as WSLIST.DTA. If you are not using 
WSLIST.DTA, substitute the name of your data file. If your data file i s  in a different 
directory from your document, include the path. 

The .rv command loads the data from your file into the variable names shown. The 
names in this command correspond to the MailList fields. Four commands are used so 
all the fields can be named. All the fields must be named here even if you use only a 
few of them in your letter. 

The line of text i s  a reminder for you. Be sure to remove this line before you type your 
letter. 

The .pa command causes each letter to print on a separate page. 

Typing the Document 

After you open the document, you can type your text. In each place where you want to 
use information from your mailing list, type the corresponding variable name, enclosed 
in ampersands (&). When you finish typing your master document, save it as you 
would any document. For more detailed information on using variables, see the infor- 
mation on merge printing in the Reference manual. 

The variable names you can use to enter mailing list information are the same names 
used in the .PV dot commands. These names refer to the fields on your MailList data 
entry form. The list on the next page shows the variable names in the MAILLIST.DOT 
file and the names of their corresponding MailList fields. 
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VARIABLE 
N A M E  

MAlLLlST 
FIELD 

Record Number 
First, Initial, 
and Last 
First 
Initial 
Last 
Jr.1M.D. 
Mr./Ms. 
Title 
Company 
Address Line 1 
Address Line 2 
City 

VARIABLE 
N A M E  

MAlLLlST 
FIELD 

State 
Zip 
Country 
Phone-1 
Phone-2 
Date 
User Field 1 
User Field 2 
User Field 3 
Remark 1 
Remark 2 
Remark 3 
* 

* The &ymd& variable represents the date in year, month, date format (for example, 
900826). MailList generates this field automatically, and you can use it for sorting 
and with MailMerge conditions. 

The variable names for the inventory form and their corresponding fields are shown 
below. 

VARIABLE 
N A M E  

MAlLLlST 
FIELD 

Record Number 
Date 
Item 
Code 
Status 
Description Line 1 
Description Line 2 
Description Line 3 
Account 1 
Quantity 1 
Price 1 
Account 2 

VARIABLE 
N A M E  

MAlLLlST 
FIELD 

Quantity 2 
Price 2 
Account 3 
Quantity 3 
Price 3 
User Field 1 
User Field 2 
User Field 3 
Remark 1 
Remark 2 
Remark 3 
* 

* The &ymd& variable represents the date in year, month, date format (for example, 
900826). MailList generates this field automatically, and you can use it for sorting 
and with MailMerge conditions. 



Printing Form Letters 
To print a form letter, choose the Print command (Alt+F,P). At the Print dialog box, 
type the filename of your master document. Change any print options you want. Make 
sure you select the Merge option, and then press F10 or AK to start printing. 

The examples that follow include a master document and two printed letters. 

. OP 

.df wslist.dta 

.rv x, number, full-name, first, mi, last, Mr-Ms, title 

.rv company, addrl, addr2, city, state, zip, country 

.rv phonel, date, Jr-MD 

.rv userl, phone2, user2, x, user3, remarkl, remark2, remark3, ymd 

.oj off 

Sonoma Textbooks 
30 School St. 

Take City, WI 53701 

November 18, 1990 

Dear &Mr-Ms& &last&: 

Sonoma Textbooks introduces Newsletter, the reading and editing 
game that adds creativity to computerized learning. 

Newsletter is a learning game that takes the excitement of 
computers out of the arcade and puts it into the classroom. It 
combines the enrichment of language skills with the fun and 
imagination of the high tech world. 

We are sure that you and your students at &company& will be 
pleased with this product. 

Newsletter is available from your Sonoma representative and at 
quality bookstores everywhere. 

Sincerely, 

Susan Skinner 
Sonoma Textbooks 
.Pa 
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- 

Sonoma Textbooks 
30 School St. 

Lake City, WI 53701 

November 18, 1990 

Albert G. Alvarez 
Wright School 
2330 Lark Ave. 
Buena Vista, CA 95912 

Dear Mr. Alvarez: 

Sonoma Textbooks introduces Newsletter, the reading and editing 
game that adds creativity to computerized learning. 

Newsletter is a learning game that takes the excitement of 
computers out of the arcade and puts it into the classroom. It 
combines the enrichment of language skills with the fun and 
imagination of the high tech world. 

We are sure that you and your students at Wright School will be 
pleased with this product. 

Newsletter is available from your Sonoma representative and at 
quality bookstores everywhere. 

Sincerely, 

Susan Skinner 
Sonoma Textbooks 

I 



I I November 18, 1990 I 

- 

Mary E. Bowen 
Dogwood School 
1 Schoolhouse Rd. 
Lynville, OH 47308 

Sonoma Textbooks 
30 School St. 

Lake City, WI 53701 

I I Dear Ms. Bowen: I 
I I Sonoma Textbooks introduces Newsletter, the reading and editing 

game that adds creativity to computerized learning. 

Newsletter is a learning game that takes the excitement of 
computers out of the arcade and puts it into the classroom. It 
combines the enrichment of language skills with the fun and 
imagination of the high tech world. 

I 1  We are sure that you and your students at Dogwood School 
will be pleased with this product. 

Newsletter is available from your Sonoma representative and at 
quality bookstores everywhere. 

Sincerely, 

Susan Skinner 
Sonoma Textbooks 



Printing En velopes, 
Labels, and Lists 

MailList comes with ready-made files for printing your mailing list on envelopes, labels, 
and Rolodex cards and for printing proof reports of your mailing list. These files are 
WordStar documents that contain the merge print commands to insert the data from 
your list. They are located in your MailList directory (usually \WS\OPTIONS). Just use 
the following procedures. 

Note: If you want to print envelopes, labels, or lists for only part of your mailing list, 
you can edit these files and insert the appropriate merge print commands. See the 
information on merge printing in the Reference manual. 

Printing Envelopes 
You can print standard 4'1s-by-g1/2-inch envelopes for a mailing list using the 
ENVELOPE.LST file. 

Note: Special files are provided for printing envelopes with Hewlett-Packard LaserJet 
printers. For the LaserJet or Laserjet Plus, use HP-ENVMM.LST. For the LaserJet 
series II, use HP2-ENVM.LST if you feed the envelopes manually, or HP2-ENVE.LST if 
you have an automatic envelope feeder. 



If your data file is not named WSLIST.DTA, before you print envelopes, you need to 
edit the envelope file and substitute your filename for WSLIST.DTA in the .df dot com- 
mand. If your data file i s  not in the current drive or directory, you need to edit the en- 
velope file and add the drive letter or directory path. 

1 Choose the Print command. 

2 For the name of the file, type envelope.lst, (hp-envmm.lst, hp2-envm.lst, or 
hp2-enve.lst). Include a drive letter or directory path if necessary. 

3 If you want to change any of the print options, do so. Don't start printing yet. 

4 Make sure your printer is  ready and the paper is removed. Then press F10 or "K. 

5 Choose the Print command to go to the Print screen. 

A message saying printing is paused appears on the screen. 

6 Insert an envelope in the printer, rolling the platen until the top of the envelope i s  
just visible. The top of the envelope should be at the same spot as the top of the 
page is when you align paper. (Don't align the envelope where you want printing 
to begin. It will advance the correct number of lines before printing.) 

7 Press C to print the first envelope. 

The name and address from the first record are printed on the envelope, and print- 
ing pauses. 

8 Repeat steps 6 and 7 until you have addressed envelopes for the entire list. 
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Sample printed envelopes are shown below. 

Albert G. Alvarez 
Wright School 
2330 Lark Ave. 
Buena Vista, CA 95912 

Mary E. Bowen 
Dogwood School 
1 Schoolhouse Rd. 
Lynville, OH 47308 

Lucy Harris 
Oakvale High School 
770 Burton St. 
Oakvale, KY 32701 

Printing Labels or Rolodex Cards 

You can print names and addresses from your mailing list on several different types of 
labels. The LABEL.LST file prints on 3'12-by-1 -inch, one-across labels. The 
LABELXL.LST file prints on 5-by-3-inch, one-across labels. The LABEL3.LST file prints 
on 3'12-by-1-inch, three-across labels on 11 -inch wide label stock. 

If you have a laser printer, MailList provides two special files to print labels: 

HP-LAB3.LST prints 27 three-across labels. Each sheet contains 33 labels; however, 
the file i s  set up to leave the top and bottom rows of labels blank because most 
laser printers can't print at the top and bottom of the page. 

LSRLABL3.LST prints 30 three-across labels. This file i s  designed for label stock that 
has half-high labels at the top and bottom of the page. 

You can also print names and addresses on 2'16-by-4-inch continuous strip Rolodex 
cards, using the ROLODEX.LST file. 



3 1/2"x1" one-wide labels 5"x3" one-wide labels 

0 0 

0 

0 

0 :El 0 0 

0 

0 :El 0 0 0 

LABEL3.LST 3 1/2"x11' three-wide labels 

If your data file i s  not named WSLIST.DTA, you need to edit the appropriate label or 
Rolodex file and substitute your filename for WSLIST.DTA in the .df dot command. 
The files to edit are SHOLABEL (for LABEL.LST), SHOLABLX (for LABELXL.LST), 
SHOLABL3 (for LABEL3.LST), and SHOROLDX (for ROLODEX.LST). If your data file i s  
not in the current drive or directory, add the disk drive or directory path. 

If you're printing labels, you must change to the MailList directory before you print. 

I Choose the Print command. 

2 For the name of the file, type label.lst for 3'h-by-I-inch one-across labels, 
labelxl.lst for 5-by-3-inch one-across labels, label3.lst for 3lh-by-I-inch three- 
across labels, hp-lab3.lst or Isrlabl3.lst for three-across labels on laser printers, or 
rolodex.lst for Rolodex cards. Include a drive letter or directory path if necessary. 

3 If you want to change any print options, do so. If you're printing labels with 
LABEL3.LST, LABEL.LST, LABELXL.LST, or ROLODEX.LST, type N next to Use form 
feeds. Make sure you select the Merge option. Don't start printing yet. 
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4 Remove the paper from your printer. Insert the labels (or cards), rolling the platen 
until the top of the label is just visible. The top of the label should be at the same 
spot as the top of the page when you align paper. (Don't align the label where you 
want printing to begin. It will advance the correct number of lines before printing.) 

5 When the printer is ready, press F10 or "K. WordStar prints a sample label (or row 
of labels) to help you align the labels correctly, then pauses printing. 

6 Choose the Print command. 

7 Check the sample label. If the text is not centered on the label, realign the labels. 
Press C to continue. 

Two more sample labels are printed, with pauses after each one. At each pause, 
make any necessary adjustments to the alignment, then press C to continue printing. 
After the third sample label, WordStar prints your labels, one for each record in 
your data file. 

When printing is complete, you are returned to the Opening screen. 

Sample printed labels are shown on the following page. 



. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

Label Alignment 3.5" x 1" * * * lo 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

0 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

0 

Albert G. Alvarez 
Wright School 

0 
2330 Lark Ave. 

0 

Mary E. Bowen 
Dogwood School 

0 
1 Schoolhouse Rd. 

0 

Lucy Harris 
Oakvale High School 

0 
770 Burton St. 

0 
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Printing Reports 
You can print two types of reports that list information from your mailing list. A proof 
report is a listing of all the information in the mailing list; a phone report is a list of 
names and phone numbers only. You can also print a proof report for your inventory 
list. 

If your data file is not named WSLIST.DTA, before you print reports, you need to edit 
the report file (PROOF.LST, PHONE.LST, or INVNTORY.LST) and substitute your 
filename for WSLIST.DTA in the .df dot command. If your data file is not in the current 
drive or directory, you need to edit the report file and add the drive letter or directory 
path. 

1 Choose the Print command. 

2. For the name of the file, type proof.lst (or invntory.lst for an inventory data file) for 
a proof report or phone.lst for a phone report. Include a drive letter or directory 
path if necessary. 

3 If you want to change any of the print options, do so. Make sure you select the 
Merge option. Then press F10 or "K to start printing. 

WordStar prints the report. 

A sample phone report and a sample proof report for a mailing list are shown below. 

PHONE DIRECTORY 
August 26, 1990 

Phone N u m b e ~  

00001 Alvarez, Albert 

00002 Bowen, Mary 

00003 Harris, Lucy 



MAILING LIST PROOF REPORT 
August 26, 1990 

00001 
Albert G. Alvarez 
Wright School 
2330 Lark Ave. 
Buena Vista CA 95912 

08/26/90 
Mr. 
101-555-7676 

English Teacher 

User Fields: 
1: 
2: 
3: 

00002 
Mary E. Bowen 
Dogwood School 
1 Schoolhouse Rd. 
Lynville OH 47308 

User Fields: 
1 : 
2 : 
3 : 

00003 
Lucy Harris 
Oakvale High School 
770 Burton St. 
Oakvale KY 32701 

User Fields: 
1 : 
2: 
3 : 

08/26/90 
Ms. 
101-555-7497 

Principal 

08/26/90 
Ms. 
513-555-0380 

English Teacher 
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A  sample proof report for an inventory list is shown below. 

Quantitv 
1050 
380 

If you want, you can change a proof report to put the information in another order 
or to exclude information you don't use. Copy PROOF.LST or INVNTORY.LST to a 
new file, then edit the file as you would a master document so that the variable in- 
formation you want is in the correct place. (Don't change the .rv commands; just 
change the placement of the variables enclosed in ampersands.) 

- 

INVENTORY PROOF REPORT 
August 26, 1990 

Reco- PeeeB Date: 08/26/90 
Item: File folders 1: 
Code: 01960 2: 
Status: N 3: 

Description: 

Account 
manila 
blue 

Remarks- 

Record; 90001 Date: 08/26/90 
Item: Copier paper 1: 
Code: 10843 2: 
Status: RS 3: 

Description: 

Account Duantitv Price 
8 1/2 x 11 7 boxes 
8 1/2 x 14 8 boxes 
11 x 17 2 boxes 

Remarks- 
Be sure to reorder legal size paper if less than two 
boxes. 

I 
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"A or "t, move to previous field, ML-8 
add names and addresses to data file, 

ML-6 to ML-8 
addresses, add to data file, ML-6 to ML-8 
alphabetize. See sort 
ampersand (&), and variable names, ML-18 
arrow keys, and cursor movement, ML-8 
ascending sort order, ML-12 to ML-13 
automatic envelope feeder (LaserJet), ML-23 

B 

backing up files, ML-15 

"C 
choose sort order, ML-12, ML-14 
copy information, ML-8 
create or change filter, ML-9 

change. See edit 
copy information ("C), ML-8 
create 

list, ML-5 to ML-8 
sort order, ML-11 to ML-13 

cursor movement, ML-8 

AD or "-+, move right one character, ML-8 
data entry form, ML-7 

inventory form, ML-15 to ML-16 
data files, ML-5 to ML-6 

add names and addresses to, ML-6 to 
ML-8 

backing up, ML-15 
change records, ML-8 to ML-10 
define for merge printing (.DF), ML-18 

data files (continued) 
defined, ML-6 
delete record ("E), ML-10 
filter records, ML-9 to ML-10 
find records, ML-10 
and index files, ML-14 to ML-15 
numbering of records in, ML-6 
save record ("W), ML-8 
sort records, ML-11 to ML-14 

date field 
sorting of, ML-13 
and the &ymd& variable, ML-19 

define file (.DF), for merge printing, ML-18 
delete 

record ("E), ML-10 
sort order ("El, ML-14 

descending sort order, ML-13 
.DF (define file), for merge printing, ML-18 
directories, run MailList from another 

directory, ML-6 
display 

next record ("N), ML-8 
previous record ("PI, ML-8 
specific part of mailing list, ML-9 to 

ML-10 
dot commands, for merge printing, ML-I 8 
.DTA files. See data files 

"E 
erase record, ML-10 
erase sort order, ML-14 

edit 
records, ML-8 to ML-10 
sort order, ML-14 

End key, move to last field, ML-8 
envelope feeder (LaserJet), ML-23 
ENVELOPE.LST, ML-23 
envelopes, printing, ML-23 to ML-25 
erase. See delete 
error messages, ML-6 
exit MailList, ML-14 
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F10 
reports, ML-29 
start printing envelopes, ML-24 
start printing form letters, ML-20 
start printing labels, ML-27 
start printing Rolodex cards, ML-27 

"F or "-+, move to next field, ML-8 
fields 

date field, ML-13, ML-19 
defined, ML-6 
See also data files 

files. See data files 
filter records, ML-9 to ML-10 
find records, ML-10 
form letters 

create master document, ML-17 to ML-18 
INVNTORY.DOT variables, ML-19 
MAILLIST.DOT variables, ML-19 
printing, ML-20 
sample master document, ML-20 
sample printed letters, ML-21 to ML-22 

Hewlett-Packard Laserlet printers, envelope 
printing, ML-23 

Home key, move to top (first) field, ML-8 
HP2-ENVE.LST, ML-23 
HP2-ENVM.LST, ML-23 
HP-ENVMM.LST, ML-23 
HP-LAB3.LST, ML-25 

index (.NDX) files, ML-14 to ML-15 
inventory form, ML-15 to ML-16 
inventory list, printing proof report for, 

ML-29, ML-31 
INVNTORY.DEF, ML-7, ML-15 

INVNTORY.DOT, ML-17 
variables listed, ML-19 

" K 
reports, ML-29 
select key field for sort, ML-12 to ML-13 
start printing envelopes, ML-24 
start printing form letters, ML-20 
start printing labels, ML-27 
start printing Rolodex cards, ML-27 

keys, for sort, ML-12 to ML-13 

"L, move to last field, ML-8 
LABEL.LST, ML-25, ML-26 
LABEL3.LST, ML-25, ML-26 
labels, printing, ML-25 to ML-28 
LABELXL.LST, ML-25, ML-26 
laser printers 

and label printing, ML-25 
See also Hewlett-Packard LaserJet printers 

Laserlet printers. See Hewlett-Packard 
LaserJet printers 

leading spaces and zeros, in sort, ML-11 
locate records, ML-10 
LSRLABL3.LST, ML-25 

mailing labels, printing, ML-25 to ML-28 
MailList, overview of, ML-3 to ML-4 
MAILLIST.DOT, ML-17 

variables listed, ML-19 
MAILSORT.OVR, ML-14 
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master document 
create for merge printing, ML-17 to 

ML-18 
sample of, ML-20 

merge printing 
dot commands for, ML-18 
form letters, ML-17 to ML-22 
mailing labels, ML-25 to ML-28 
master document creation for, ML-17 to 

ML-18 
master document for, ML-20 
reports, ML-29 to ML-3 1 
Rolodex cards, ML-25 to ML-28 

messages, ML-6 
movement (cursor), ML-8 

"N (display next record), ML-8 
names, add to data file, ML-6 to ML-8 
.NDX files, ML-14 to ML-15 
numbering 

of records, ML-6 
See also page numbering 

omit page numbering, for merge printing 
(.OP), ML-18 

.OP (omit page number), for merge printing, 
ML-18 

"P (display previous record), ML-8 
.PA (page advance), for merge printing, 

ML-18 

page advance (.PA), for merge printing, 
ML-18 

page numbering, omit for merge printing 
(.OP), ML-18 

PHONE.LST, ML-29 
phone reports, printing, ML-29 
printing 

envelopes, ML-23 to ML-25 
form letters, ML-20 
mailing labels, ML-25 to ML-28 
reports, ML-29 to ML-31 
Rolodex cards, ML-25 to ML-28 

PROOF.LST, ML-29 
proof reports, printing, ML-29, ML-30 to 

ML-31 

Q 
quit MailList, ML-14 

read variable (.RV), for merge printing, ML-18 
rebuild index files, ML-15 
Record Number field, ML-6 
records 

add to data file, ML-6 to ML-8 
change, ML-8 to ML-9 
defined, ML-6 
delete ("El, ML-10 
filter, ML-9 to ML-10 
find, ML-10 
numbering of, ML-6 
save ("W), ML-8 
sort, ML-11 to ML-14 

reports, printing, ML-29 to ML-31 
Rolodex cards, printing, ML-25 to ML-28 
ROLODEX.LST, ML-25, ML-26 
run MailList. See start MailList 
.RV (read variable), for merge printing, ML-18 
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move left one character, ML-8 
save sort order, ML-13 

save 
record ("W), ML-8 
sort order ("U or "S), ML-13 

show. See display 
sort 

date field, ML-13 
records, ML-10 to ML-14 

spaces, and sorting, ML-11 
start MailList, ML-5 to ML-6 

from another directory, ML-6 

AT (move to top field), ML-8 
three-across mailing labels, printing, 

ML-25 to ML-27 

" u 
save sort order and sort, records, ML-13 
sort records, ML-11 
use filter, ML-10 

variables 
ampersand and variable names, ML-18 
listing of, ML-19 
.RV command (read variables from data 

file), ML-18 

"W (save record), ML-8 
WLIST.DEF, ML-7, ML-15 
WLIST.DTA, ML-5 to ML-6 

zeros, and sorting, ML-11 
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Introduction 
ProFinder helps you keep your files and programs organized and accessible. ProFinder 
displays a file list similar to the one displayed with the DOS DIR command. Besides 
looking at the filenames, you can 

Scroll up and down through the list 

Assign a descriptive label to each file so you can identify its contents easily 

Sort the filenames so you can see the list, for example, in alphabetical order or by 
filename extension 

Locate all the files in a directory that contain certain words or phrases 

View individual files and search for text within a file 

Tag any number of files in the directory and perform operations such as deleting or 
copying quickly 

Create, rename, and delete directories 

Run a program by choosing either the program or one of its data files at the file l is t  

Change with one keystroke to a file list for another disk or directory 

Start Wordstar@ (or another program) from within ProFinder, then use a special "hot 
key" to flip between ProFinder and WordStar as often as you want while you're 
working 

Automate frequently performed activities by creating and using personal menus 



/nstalling Pro Finder 
If you didn't copy ProFinder when you installed Wordstar, do so now. See the Install- 
ing and Customizing booklet for information on adding a feature. 

I M P 0 R T A  N T You should put the directory containing ProFinder (usually 
\ WS\OPTIONS) on your DOS path so you can start ProFinder from any directory. 

After you've copied ProFinder you can run the ProFinder installation program, PFINST, 
which contains monitor and color settings and other program configuration settings. 
Most users don't need to run PFINST, but you may find it helpful. You must run the in- 
stallation program if: 

You have a gas plasma monitor or other monochrome monitor but have a color 
graphics board in your computer. 

You move your ProFinder files from one directory to another. (Otherwise, your 
configuration settings may not be saved and you may not be able to access help. 

m Your computer is not totally IBM compatible and when you run ProFinder, the sys- 
tem freezes or the screen doesn't look right. In this case, set Speed on the Video 
submenu to Slow. 

To run the installation program, type pfinst and press J. The program asks for the 
name of the directory that contains the ProFinder files. Press J to accept the displayed 
name (the current directory), or type the correct directory name and press J. 

The installation menu appears. To choose an option, move the highlighting to it and 
press 3, or just press the first letter of the option. Follow the onscreen instructions. 
You can press F1 for help with any option. 

Video allows you to change monitor and color settings. 

Sort, File, Locate, Options, and Configuration allow you to change the same settings 
you can change in the ProFinder menus with the same names. More information on 
these options is  given later in this section. Changing settings in PFINST is the same as 
changing the same settings in ProFinder and choosing Save all settings. The Options 
menu has one additional command, Insert, which allows you to set the typing mode to 
insert or overtype for typing information in ProFinderfs prompts. 

Restore changes settings for all options back to their original settings, whether you've 
changed them here or from inside ProFinder. 



Using Pro Finder 

Running Pro Finder 

To start ProFinder, type pf and press J. A list of the files in the current directory ap- 
pears on the screen. Each file's name, extension, size, date, and time are shown in the 
same way the DOS DIR command shows them. Disk space information is shown 
below the last file in the list. 

The ten main ProFinder commands are shown on function key tags on the bottom line 
of the file list screen. To use any of these commands, just press the corresponding 
function key or the corresponding number key at the top of your keyboard (use 0 for 
F10). You can also hold down the Alt key and press the first letter of the command (for 
example, Alt-H for Help). 

Some of the ProFinder commands display menus. To choose a command from a menu, 
either move the highlighting to the command and press J, or just press the first letter of 
the command. 

When you are using ProFinder, you can press. (period) to go back one step. For ex- 
ample, if you are displaying a submenu, pressing. causes ProFinder to go back to the 
previous menu. 

Press F1 (or 1 or Alt-H) whenever you need help for the command you're using. Press 
Esc after you finish reading the help screen to return to where you were. 



Working with the File List 
When you start ProFinder, the file list is displayed. You can scroll through the file list 
using the keys shown below. 

PRESS TO 

? or "E Scroll up one filename 

-1 or AX Scroll down one filename 

PgUp or AR Scroll up one screenful 

PgDn or "C Scroll down one screenful 

Home or "QE Move the highlighting to the top of the screen 

End or "QX Move the highlighting to the bottom of the screen 

"Home or AQR Move the highlighting to the top of the list 

"End or AQC Move the highlighting to the bottom of the list 

"Z Scroll the screen up one filename (highlighting doesn't move) 

"W Scroll the screen down one filename (highlighting doesn't move) 

You can also press the first letter of a filename to move the highlighting to the next 
filename that begins with that letter. Press the Shift key plus the first letter of a filename 
to move the highlighting to the previous filename that begins with that letter. 

Using File Titles 
On the right side of the file list screen is space for file titles. A file title is descriptive 
text that further identifies a file. You'll find file titles helpful if you have many files and 
sometimes can't remember the name of the file you're looking for. To add or edit a file 
title, move the highlighting to the filename and press + (or Tab or "D). Type the title. 
You can edit the file title with the WordStar editing commands. When the title is the 
way you want it, press J. 

You can move up in the titles column using ?, AE, PgUp, or "R; you can move down 
using J, "X, PgDn, or AC. 

ProFinder stores file titles in a file named TITLES.PF. Each directory that contains files 
with titles has its own TITLES.PF file. When you use ProFinder to copy, move, or delete 
files, ProFinder also copies, moves, or deletes their titles. 

You can remove the display of file titles from the file list. Press F6 (Options) and 
choose Titles. The default setting for this option is Yes (titles are displayed). Choosing 
the option changes it to No. You can change back to Yes by choosing this option 
again. To quit displaying file titles for longer than the current work session, use the 
Save all settings option (see "Setting the Configuration Options"). 
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Changing to Another Directory 
If you are in a subdirectory, the first line of the list says UPDlR in the file size column. 
This signifies the parent directory. If the directory has any subdirectories, the file size 
column for each of them says DIR. The table below shows how to change to a listing 
of another directory or disk. 

TO CHANCE TO DO THIS 

Another directory Press \ (backslash) and type the name of the directory 

Another disk drive Press : (colon) and type the drive letter, then either press J 
to accept the default directory path (\*.*) or type a new path 
and press J 

The parent directory Press. (period), or move the highlighting to the UPDlR line 
and press J, or press the Backspace key 

A subdirectory Move the highlighting to the DIR line and press J 

The root directory Press A\ (Ctrl-backslash) 

Displaying Selected Filenames 
To specify which filenames you want to display in the file list, press \, or press F6 
(Options) and choose Directory list. The default directory search path i s  all files (*.*I 
in the current directory. Edit the search path so that it is the one you want and press J. 
(You can use the WordStar editing commands.) As soon as you enter the new search 
path, the file list changes accordingly. Some sample search paths are shown below: 

C:\WS\*.DOC All files in the \WS directory with the .DOC extension 

C:\MEMO?.* All files in the root directory with filenames that consist of MEMO 
and one more character, with any extension 

A:LET.* All files named LET with any extension on the disk in drive A 

To display only program filenames (with the .EKE, .COM, and .BAT extensions), press 
F6 (Options) and choose Programs only. The default setting is No. Choosing the op- 
tion changes it to Yes. 

To display only the names of subdirectories of the current directory, press F6 (Options) 
and choose Subdirs only. The default setting for this option is  No. Choosing the op- 
tion changes it to Yes. 

After displaying selected filenames, you can return to the full file list quickly by press- 
ing * (asterisk), or you can press F4 or F6 and choose List all files. 
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Sorting a File List 
You can display your directory in several orders. 

To sort the current file list, press F7 (Sort), and choose the options you want from the 
submenu. The default sort order is by Extension, then Name. The options are 
described below. 

Begin sort sorts the file list in the order shown in the sort order box. 

Order of sort allows you to specify a new sort order. The displayed options, Name, Ex- 
tension, Datenime, and Size, are the orders you can use to sort. You can use any corn- 
bination of these options for sorting. For each option you choose, another prompt asks 
you for the sort direction; choose either the default, Ascending (regular alphabetical), or 
Descending (reverse alphabetical). Choose the options in the order you want them 
used. For example, if you want to sort first by filename, then by extension, choose 
Name first, then Extension. After you set the sort order, choose Resume or press Esc 
or. (period). When you set up a new sort order, it remains in effect until you change it 
again or exit ProFinder. If you want to keep the sort order longer than the current work 
session, use the Save all settings option (see "Setting the Configuration Options"). 

Auto-sort allows you to sort all directories automatically as soon as you change to 
them. The default is No; choosing this option changes it to Yes. When auto-sort i s  off, 
if you want to see sorted file lists, you need to sort each list as you display it. When 
you turn auto-sort on, i t is in effect until you change it or exit ProFinder. To keep 
auto-sort on for longer than the current work session, use the Save all settings option 
(see "Setting the Configuration Options"). 

Using the Hot Keys 
ProFinder recognizes two "hot keys." The flip hot key allows you to flip back and forth 
between WordStar and ProFinder. The copy hot key allows you to copy a block of text 
from a file you display with ProFinder into a WordStar file. 

The hot keys can be very handy. For example, if you're not sure of the name of the file 
you want to edit, you can use ProFinder to find the file you want, then automatically 
start WordStar and open the file. While you're editing, you can go back to ProFinder, 
look through several files to find text you want, and mark it as a block. You can then 
go back to WordStar and copy the marked block into your document with a single 
keystroke. 

Flip hot key This is the plus key on the numeric keypad. To use it, start at the 
ProFinder directory display. Move the highlighting to the name of a file you want to 
edit and press +. ProFinder starts WordStar and opens the file you selected. You can 
now edit the file and do any other WordStar operations (save the file, print, open a new 
file, and so on). 



U S I N G  P R O F I N D E R  

When you start WordStar using the + key, ProFinder remains in your computer's 
memory. You can access ProFinder from WordStar by pressing + again. You can flip 
back and forth between WordStar and ProFinder as often as you like. When you exit 
WordStar, you return to ProFinder. You can't exit ProFinder until you exit WordStar; if 
you try, ProFinder displays a message and returns you to WordStar. 

You can change the flip hot key from + to another key. You can also use the flip hot 
key to flip between ProFinder and another program instead of WordStar. For more in- 
formation, see "Setting the Configuration Options." 

Copy hot key This is the minus key on the numeric keypad. It works only when you 
have started WordStar from ProFinder (using the flip hot key). When you use ProFinder 
to view a file, you can mark a block in the file (see "Working with Blocks" in "Viewing 
Files"). After you flip back to WordStar, while you're editing a file, you can press the 
copy hot key anywhere in the file to copy the marked block. If you are not viewing a 
file with ProFinder, the copy hot key copies the highlighted filename into WordStar or, 
if you have tagged filenames, copies each tagged filename in turn. For example, if you 
want to read several files into a WordStar file, you can tag the filenames in ProFinder, 
then press AKR from WordStar, and press the copy hot key at the filename prompt. 
Repeat this procedure for each file to be read. Each time you press the copy hot key, 
the next tagged filename appears. 

You can change the copy hot key from the minus key (-) to another key. See "Setting 
the Configuration Options." 

working with Files 
When you're displaying a file list with ProFinder, you can do several operations on the 
files in the list. These operations are described in the following sections. 

You can select, or tag, any number of files for a file operation. Here's how tagging 
works: 

w To tag a file, move the highlighting to the filename and press F3 or "K. You can 
press F3 again to untag the highlighted file. 

w To tag a group of files, press F4 (Files), choose File tag by wild card, and type the 
filename, using the * and ? wild-card characters. For example, to tag all files with 
the .BAK extension, type *.bak. 

To see a file list of only the tagged files, press F4 (Files), then choose Select tagged 
files. To return to a full directory display, press * or press F4 or F6 and choose List 
all files. 

To remove the tags from all files that you have tagged, press F4 (Files), then choose 
Untag all. 
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w To retag files that you untagged or that ProFinder untagged after a file operation, 
press F4 (Files), then choose Retag. 

While a file operation such as copying or deleting is  in progress, you can press any key 
to interrupt the operation. A prompt asks whether you want to quit or continue. 

Copying, Moving, and Renaming Files 
To copy files to another directory, press F4 (Files), then choose Copy. To move files to 
another directory or to rename files, press F4 (Files), then choose Movelrename. 

If you have tagged any files, all tagged files will be copied or moved. If you have not 
tagged any files, type the name of the file(s) to copy or move at the prompt that ap- 
pears. Include the drive letter or directory path if necessary. You can use the DOS 
wild-card characters * and ? to name a group of files. For example, you could type 
\ws\*.doc to specify all the files in the \WS directory with the .DOC extension. 

At the Copy to or Move to prompt, type the directory you want the files copied or 
moved to. If you have not tagged files, you can include the filename if you want the 
copied or moved file to have a new name. You can use wild-card characters in the 
filename. 

After you enter the file information, you can start copying or moving, or you can set 
several options. Choose Begin to start. The other options have yes/no settings; you just 
need to choose the option to change the setting. These options are described below. 

Confirm overwrites This option determines whether ProFinder asks you if you want to 
overwrite an existing file (if you are about to overwrite it in a copy or move operation). 
The default is No. 

Transfer titles This option determines whether ProFinder file titles will be copied and 
moved with files. The default is Yes. 

Verify This option allows you to verify as you copy and move. It is the same as the 
DOS Verify Vv) option. The default is Yes. 

Skip same version If you set this option to Yes, ProFinder won't overwrite an existing 
file that has the same file size, time, and date as the file you are copying or moving. 
This can save time. For example, if you are backing up a directory of files to a floppy 
disk, ProFinder can copy only the files that have changed since you last backed up. The 
default is No. 

If you change any of these settings and want to keep your changes for longer than the 
current work session, use the Save all settings option (see "Setting the Configuration 
Options"). 



U S I N G  P R O F I N D E R  

Deleting Files 
To delete files, press F4 (Files), then choose Delete. 

If you have tagged any files, all tagged files will be deleted. If you have not tagged any 
files, type the name of the file(s) to delete. Include the drive letter or directory path if 
necessary. You can use the DOS wild-card characters * and ? t o  name a group of files. 
For example, you could type \ws\*.bak to delete all the files in the \WS directory with 
the .BAK extension. 

At the prompt, press J to begin. The files you tagged or named are deleted. 

Changing File Dates and Times 
To change the dates and times shown with filenames, press F4 (Files), then choose 
Timeldate stamp. 

If you have tagged any files, the date and time of all tagged files will be changed. If 
you have not tagged any files, type the name of the file to stamp. lnclude the drive let- 
ter or directory path if necessary. You can use the DOS wild-card characters * and ? to 
name a group of files. For example, you could type \ws\*.doc to change the date and 
time for all the files in the \WS directory with the .DOC extension. 

For the date, press J to accept the default, which is the current date, or type another 
date and press J. For the time, press J to accept the default, which is the current time, 
or type another time and press J. (You can type 0 (zero) to omit the time from the list.) 
At the prompt, press J to begin. ProFinder changes the dates and times. 

Printing the File List 
To print the file list, be sure your printer is ready. Press F4 (Files), then choose Print 
file list. ProFinder prints the current file list. If you have tagged any files, they are un- 
derlined in the printed list. 

Writing Filenames to a File 
You can create a file that contains the filenames in the current list. If you have tagged 
files, the file contains only the tagged filenames. Press F4 (Files), then choose Write 
filenames. Type the name of the file to write the filenames to and press J. If the 
filename you type is an existing file, a prompt appears. Press 0 to overwrite the file, A 
to append the new filenames to the end of the file, or Esc to exit. 

Next you can specify up to 20 characters that will appear before (prefix) or after (suffix) 
each filename in the new file. At each prompt, type the text you want and press J. If 
you don't want a prefix or suffix, just press J. As soon as you answer the last prompt, 
ProFinder writes the filenames to the file you specified. 



vie  wing Files 
You can use ProFinder to look at the contents of any file in the current file list, and you 
can do several operations with a file you're viewing. To view a file, move the high- 
lighting to the name of the file and press J. 

While you are viewing a file, you can use the cursor movement keys or the WordStar 
cursor movement commands to move the cursor around in the file. For a complete list 
of these commands, press F1 or AJ for help while you are viewing a file. You can also 
locate specific text, mark blocks, and use several other commands. The following sec- 
tions give complete instructions on how to work with a file you're viewing. 

File Format 
ProFinder normally assumes the file i s  in WordStar format. You can usually view ASCll 
files correctly in WordStar format. However, graphics characters from ASCll files are 
not displayed correctly, so you may sometimes need to switch from WordStar to ASCII 
format. You can also view WordStar 2000 files, which have a different format. To 
switch between formats while you are viewing a file, press "QC. 

You can change the default format; see "Setting the Configuration Options." 

ProFinder also automatically recognizes Lotus 1-2-3 files and displays them in the cor- 
rect format. When you view a Lotus 1-2-3 file, you can see only the top-left screenful 
of the file; you can move the cursor through the displayed portion of the file, but you 
can't scroll to other portions of it. 

Finding Text 
While you're viewing a file, you can easily find a specific word or phrase. Press F2 or 
AQF and choose Text to locate. ProFinder prompts you for the text to locate. Type up 
to 20 characters of text and press J. You can press J again at the Begin search prompt 
to begin the search, or you can first change any of the search options. To change a 
search option, choose the option you want to change. The options are described 
below. 

Whole words only specifies that the text to search for must be whole words. The 
default is No. Thus, if you search for the word "cat" with the No setting, ProFinder will 
locate "concatenation" or "catered." 

Case ignore tells ProFinder to find all instances of the text whether or not any char- 
acters are uppercase or lowercase. The default is Yes. 

Lightning synonyms is for Turbo Lightning users. It allows you to use a Turbo Lightning 
synonym file with your searches. The default i s  No. 

User synonyms lets you use a synonym file that you create yourself. For more infor- 
mation, see "Setting the Configuration Options." The default is No. 
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Direction lets you run a forward, backward, or global search. The default is global; 
pressing J toggles among the three choices. 

The settings for these options (except for Direction) apply to locating files as well as 
finding text within a file. If you want to keep your changes longer than the current 
work session, choose the Save all settings option (see "Setting the Configuration 
Options"). 

Once you've searched for specific text in a file, you can press F4 or "L to find the next 
instance of the current search text, and you can press F3 or "QV to find the previous 
instance. 

Working with Blocks 
While you're viewing a file, you can mark a block within the file. You can then write 
the block to another file or use the copy hot key to copy the block to a WordStar file (or 
to a file in whatever program you use with the flip hot key). See also "Using the Hot 
Keys.") 

PRESS TO 

F7 or "KB Mark the beginning of a block. 

F8 or AKK Mark the end of a block. 

F10 Automatically mark the line the cursor i s  on as a block (Auto-block). 
Press F10 again to add the next line to the block. Mark as many con- 
secutive lines as you want. If you mark a line that is not the next line 
below the current block, that line begins a new block. 

"KH Hide the display of the marked block. 

F5 or AKW Write the marked block to a new file. At the prompt, type the name 
of the file to write the block to and press J. If the filename is an ex- 
isting file, press 0 to overwrite the file, A to append the block to the 
end of the file, or Esc to exit. (The block is always written as it i s  
shown on the screen.) 

F6 or "KP Print the marked block. At the Left Margin prompt, type the number 
of columns you want the text offset from the left edge of the paper, or 
press J to accept the default, 0. 

Viewing Another File 
While you're viewing a file, you can press F9 or "OK to open another file. If the cursor 
is on a word that is the name of a file in the current directory, ProFinder opens that file. 
Otherwise, at the prompt, type the name of the file you want to open and press J. 

When you open more than one file each file appears in a separate "window" on the 
screen. You can view up to three files at a time. Press Esc or.  (period) to close the cur- 
rent window. 
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f ocating Files 
ProFinder can find all the files in the current list that contain certain text. For example, 
you can quickly find all your documents that mention the Houston contract or June 4, 
1988. You can also search file titles instead of the files themselves. This allows you, 
for example, to display a list of the files that have "report" or "Fjerstad" in their titles. 

Note: When you are searching through WordStar document files, the file format should 
be set to WordStar (the default) for best results. See "Setting the Configuration 
Options." 

To locate files, press F2 (Locate) at the file list. Then choose Search files by text to 
search for text in files, or choose Find files by title to search in file titles. You can now 
specify the text and set several options, as described below. 

Text to locate You can specify up to three text strings (words or phrases), each up to 
20 characters long. After you type each search string, press J, or press Esc when you're 
finished entering search strings. 

Begin search When you choose this option, ProFinder searches for all files (or titles) 
that contain any of the search strings you entered. The file list changes so that it dis- 
plays only the files that contain a search string. It also shows which search strings each 
file contains. When you view any of these files, each instance of a search string in the 
file i s  highlighted, and the cursor i s  on the first instance. 

T I  P If you have a lengthy search, you can continue to work while ProFinder searches. 
Just use any commands you want. The search will resume the next time you're at the 
file list and you stop using the keyboard for a few seconds. 

Whole words only tells ProFinder that the text to search for must be whole words. The 
default i s  No. Thus, for example, if you search for the word "cat," ProFinder will locate 
"concatenation" or "catered." 

Case ignore tells ProFinder to find all instances of the text whether or not any charac- 
ters are uppercase or lowercase. The default is Yes. 

Lightning synonyms is for Turbo Lightning users. It allows you to use a Turbo Lightning 
synonym file with your searches. The default i s  No. 

User synonyms allows you to use a synonym file that you create yourself. For more in- 
formation, see "Setting the Configuration Options." The default is No. 

The settings for these options apply to finding text in a file while viewing the file as 
well as to locating files. If you want to keep your changes for longer than the current 
work session, use the Save all settings option (see "Setting the Configuration Options"). 

After you finish examining the list of files you located, you can return to the full file list 
by pressing * (asterisk), or you can press F2 and choose List all files. 
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T I  p To avoid lengthy searches o f  files that you don't want to include in a search, you 
can specify up to 15 filename extensions to skip. Press FZ (Locate) and choose Exten- 
sions to skip. You see a preset list of  13 extensions: . EXE, .OBI, .COM, .LIB, .OVR, 
. BAK, .HLP, .MAP, .DTY, .$$$, .SYN, .DCT, and .ARC. To add or change an extension, 
move the highlighting to i t  and type the extension you want. The new extensions you 
choose are in effect until you exit ProFinder. To make your changes permanent, use 
the Save all settings option (see "Setting the Configuration Options1'). 

working with Directories 
You can use ProFinder to create, rename, and delete directories. 

Creating a Directory 
To create a directory, press F5 (Directories), and then choose Create. At the prompt, 
type the name of the directory to create. If the directory will not be a subdirectory of 
the current directory, be sure to include the complete path. When you press +I, 
ProFinder creates the directory. 

Renaming a Diredory 
To rename a directory, press F5 (Directories), and then choose Rename. At the prompt, 
type the name of the directory to rename and press J, or just press J to accept the 
displayed name. At the next prompt, type the new name you want to assign to the 
directory. The path to the directory must remain the same. When you press J, 
ProFinder renames the directory. 

Deleting a Directory 
To delete a directory, press F5 (Directories), and then choose Delete. At the prompt, 
type the name of the directory to delete and press J. Include the complete path if 
necessary. When you press J, ProFinder deletes the directory. 

Note: If the directory to delete contains any files or subdirectories, ProFinder will not 
delete it. You must delete all the files and subdirectories before deleting the directory. 

Exiting ProFinder 
Press F8 to exit ProFinder. When you use F8, if you've changed from one directory 
to another since starting ProFinder, you exit to the directory you've changed to. 
You can also exit by pressing Esc. When you press Esc, you exit to the directory 
you were in when you started ProFinder. 

If you are running WordStar (or another program) from ProFinder, you can't exit 
ProFinder until you exit WordStar (or the other program). If you try to exit, you'll 
find yourself back in WordStar. For more information, see "Using the Hot Keys." 



PROFIN 'DER 

You can also exit by choosing Quit from the menu displayed when you run the 
Menu command (F10). For more information about using this menu, see "Creating 
and Using Menus." 



More About 
Pro Finder 

This chapter gives information about more advanced ProFinder functions. You should 
be somewhat familiar with ProFinder before using these functions. 

setting the Configuration Options 

The Configuration submenu of the Options Menu contains several options that you can 
set. To set these options, press F6 (Options) at the file list, then choose Configure. 
When you change a setting, the new setting is used until you exit ProFinder. To make 
the setting permanent, choose the Save all settings option. The configuration options 
are described below. 

User synonym file This option allows you to give the name of the synonym file used 
when you use ProFinder to locate files (or file titles) that contain certain text. If your 
search string contains any word that i s  the first word in a line of the synonym file, 
ProFinder will search for all the other words in the line as well. 

The default synonym file is  USERSYN.PF. You can edit the USERSYN.PF file that comes 
with ProFinder, or you can create another file. To change to a different synonym file, 
choose this option and give the name of the synonym file. 

The synonym file i s  an ASCII file, which you can create and edit with WordStar in non- 
document mode. It consists of one line for each word for which you are naming 
synonyms. The line consists of the word followed by all its synonyms. All the words 
in the line are separated by commas. 



Hot key settings This option allows you to change the hot keys, the program started 
by the flip hot key, and the keyboard delay. The four choices are explained below. 

Program is the program that i s  started when you first press the flip hot key. Normally 
this is WordStar. You can change this if you want to run another program with the flip 
hot key. The default program command line i s  ws "f-e 10-0. The -f and 'e insefi the 
highlighted filename and extension into the command line. For more information on 
these and other options you can use, see the list in "Creating and Using Menus." If you 
enter a different program name, you must include the program file extension if it i s  not 
.EXE. 

Nip hot key and Copy hot key allow you to change the + and - hot keys to other keys. 
When you choose one of these options, press the hot key you want to use. You can 
use any function key or a combination of the Alt key and a letter, number (not those on 
the numeric keypad), hyphen, or equal sign. The new hot key is in effect as soon as 
you press it. Take care not to select a hot key that conflicts with a WordStar command 
or a hot key for a memory-resident program you use. 

T I  P You may want to change both hot keys so that they don't interfere with page 
preview. Otherwise, when you start WordStar using the ProFinder hot key, you won't 
be able to use the + and - keys for the zoom options in page preview. 

Keyboard delay allows you to set the speed at which your keyboard copies a block 
when you use the copy hot key. The default is 0, no delay. This works fine with 
WordStar. However, if you set up ProFinder so that the flip hot key starts a different 
program, and you notice that you lose characters when you use the copy hot key to 
copy a block, you may need to set a keyboard delay. Try increasing the delay to 1 or 2; 
no system should require a delay greater than 5 .  

Print margin This option sets the distance from the left edge of the paper where print- 
ing begins when you use ProFinder to print a file you're viewing. Enter the number of 
columns you want for the margin. 

File format This option sets the format that ProFinder uses when you view a file. The 
default i s  WordStar. You can choose WordStar, ASCII, or WordStar 2000 format. (This 
setting also changes when you use "QC to toggle file format when you're viewing a 
file.) ProFinder automatically recognizes Lotus 1-2-3 files regardless of which format i s  
chosen. 

Tab settings This option determines how document tabs are displayed when you view 
different types of files. You can have different tab sizes for all files with three specific 
filename extensions (which you can specify), and one tab size for all other files. The 
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defaults are 4 for files with the .C and .H extensions and 8 for all other files. To change 
any extension or tab size, move the cursor to the item you want to change and enter 
the new setting. 

About This option displays program information about ProFinder. 

Save all settings This option saves all the configuration settings and several other set- 
tings. Be sure to choose it if you want the new settings to be permanent. If you don't 
save your settings, the new settings remain in effect only until you exit ProFinder. 

Besides the configuration settings, this option saves the onloff options on the Options 
Menu, the sort order for sorting, automatic file list sorting, settings for four options for 
copying and moving files, settings for four options for locating files or text, and the list 
of extensions to skip while searching for files. If you have changed any of these set- 
tings, the new setting will now be the default until you change it again and save the 
setting. You can also change and save these options using the PFINST installation 
program. See "Installing ProFinder." 

Command Line Options 

When you type pf to start ProFinder, you can add other information to have ProFinder 
automatically do certain operations as it starts. The complete command line syntax is 

pf filespec search 7 search2 search3 /option 

filespec i s  the search path for the file list to display; for example, C:\MEMOS\*.MEM, 
or A:*.*. The default is  a file list of all files in the current directory; use a filespec if you 
want to display a different list. If you want the default directory list and you want to 
specify a search string or option, you can put a period (.) in the filespec position to 
indicate *.*. 

searchl, search2 and search3 are search strings. If you specify any search strings, 
ProFinder automatically runs its Locate function, and the file list that appears includes 
only the files that contain any of these strings. If a search string contains any spaces, 
enclose the string in quotation marks. For example, to search all files in the current 
directory for the words yacht and party, type pf . yacht party. To search all .DOC files 
for April 9, 1990, type pf *.doc "April 9,1990". 



/option is  either /k or /m. /m tells ProFinder to display the menu in the file named after 
the equal sign. /k tells ProFinder to run the commands signified by the keystrokes that 
follow the equal sign. All the keystrokes must be enclosed in quotation marks. For ex- 
ample, you can use the /k option to sort a file list; type pf /k="{F7}{enter]". {F7} 
chooses the Sort function, and {enter] accepts the default sort order. For more informa- 
tion about these options, see "Creating and Using Menus." 

Running Another Program or DOS Command 
You can run another program or command from ProFinder in several ways. One 
simple way is by using the flip hot key; this enables you to run ProFinder and another 
program (usually WordStar) at the same time. Other ways to run a program or com- 
mand are described below. 

The Go to DOS Command 
To go to DOS without exiting ProFinder, press F4 (Files), then choose Go to DOS, and 
use any DOS commands you want. When you are finished, type exit and press J to 
return to ProFinder. Don't use this command to load a memory-resident program; exit 
from ProFinder first. 

You can't use Go to DOS when you are flipping between ProFinder and WordStar. 
(You can use the WordStar command to run a DOS command.) 

The Run Command 
This command allows you to run a program from ProFinder in two ways. You can't use 
this command while you are flipping between ProFinder and WordStar. 

First, when you move the highlighting to a filename with the .EXE, .COM, or .BAT ex- 
tension and press F9, ProFinder exits to DOS and starts the program. 

Second, when you press F9 while highlighting files with certain filename extensions, 
ProFinder can start the program you use to edit these files. With many programs, it can 
automatically open the highlighted file. A file named EXTLIST.PF contains a list of ex- 
tensions and one or more commands to run for each extension. 

The EXTLIST.PF file supplied with ProFinder has two extensions. You can add, change, 
or delete items in this file by editing it in WordStar nondocument mode. Notice that 
you can give several commands to be run for an extension. Put each command on a 
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new line and indent each of these additional lines at least one column. Use a comma 
between the extension and the first command. This file is shown below: 

DOC,ws -d-p-f-e 
WKS,c: 

cd\lotus 
123 
pf -d-p 

The first line in the file tells ProFinder to start WordStar and open the highlighted file 
when the highlighted file has the .DOC extension and you press F9. It types ws 
followed by the current drive letter (Id), directory path (-PI, filename (-0, and exten- 
sion (-e). 

The rest of the file tells ProFinder to start Lotus 1-2-3 when the highlighted file has the 
.WKS extension and you press F9, and to restart ProFinder on the current drive ("d) and 
path (-p) after you finish using Lotus 1-2-3. 

The next section, "Creating and Using Menus," contains more information on the op- 
tions you can use in the EXTLIST.PF file. 

Creating and Using Menus 
You can set up a system of menus of things you can do from ProFinder. To display 
your main menu, you press F10 (Menu) at the file list. 

T I P You can have several menus to use in different directories if you want. When 
you choose F10, Profinder first looks in the current directory for a USERMENU.PF file. 
If it doesn't find one, it then looks in the directory where you installed Profinder. 

A sample menu has been set up for you. To choose any option on the menu, move the 
highlighting to the option and press J or just press the first letter of the option. You 
can use this menu as it is, or you can change it by adding, modifying, and deleting 
choices. The menu is  in a file named USERMENU.PF, which you can edit as a 
WordStar nondocument file. 
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The sample file is shown below. 

>Sample Menu 
Documents, /k=":c{enterl{F3)\doc(enter){F71~enter111 
<------Inset ------ 
Inset, c: 

cd\inset 
inset 
pf 'd-p 

Remove Inset, c: 
cd\inset 
ri 
pf "d-p 

<----PC-Outl ine--- 
Normal version, c: 

cd\pco 
pco /r 
pf -d-p 

Small version, c: 
cd\pco 
pco /r /m=20 
pf -d-p 

<------Other ------ 
Lotus, C : 

cd\lotus 
123 
pf "d-p 

Quit, /m=quitmenu.pf 

Here is the format for the menu file: 

w The menu title ("Sample Menu") begins with a right angle bracket (>). This tells 
ProFinder to center the title at the top of the menu. 

Each of the lines that i s  a heading on the onscreen menu begins with a left angle 
bracket (<). The bracket does not appear on the menu. (The left angle bracket 
can also be used to create an inactive menu item; the menu line appears dim 
and the highlighting skips over the line so that you can't choose it.) 

w Only the lines that are to appear on the onscreen menu start in the first column. 
The other lines must be indented at least one space. 

The lines that appear on the onscreen menu can be no longer than 30 charac- 
ters. Fewer characters are better; ProFinder automatically adapts the size of the 
menu window to the length of the longest menu line. 

a Each line that appears on the onscreen menu is separated from the other infor- 
mation in the file by a comma. 
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Each line that appears on the onscreen menu causes ProFinder to run all the 
commands following it in the file until the next menu (unindented) line. These 
commands can be any DOS commands. 

The commands in the menu file can include several ProFinder options, which are 
listed below. Each option begins with the - (tilde) character, which you'll find on 
the keyboard. 

-d This is replaced with the current drive letter and a colon (for example, C:). 
- 

p This is replaced with the current directory path (for example, \WS\DOC). 

1 This is replaced with the current filename. 

-e This i s  replaced with the current filename extension (including the dot). 
- 

o This is replaced with the offset (position in the file in decimal notation) of the 
first instance of the search text if you've used the Locate command. If you 
haven't used Locate and you've viewed the file since starting ProFinder, the off- 
set used is the most recent cursor location. You can use -0 with the WordStar 
/o command line option to start WordStar, open a file, and go to this location in 
the file. 

-m This is replaced with the file mask currently in use with ProFinder. For ex- 
ample, if the current file list shows C:\WS\*.DOC, and you use a menu com- 
mand that contains -m, ProFinder inserts C:\WS\*.DOC into the command 
line. 

Three special ProFinder commands enable you to use the menu for advanced ProFinder 
functions. They are described below. 

/k= tells ProFinder to close the menu and then do the ProFinder functions signified by 
the following keystrokes. All the keystrokes must be enclosed in quotation marks (" "1. 
For example, the command for the Documents menu line uses the /k command to 
switch to the \DOC directory and display a sorted file list as explained below. 

The : displays the disk drive prompt, and  enter] changes to drive C. At this point, the 
directory path prompt is on the screen. {F3) clears the displayed path and \doc{enterl 
changes the directory to \DOC. IF71 chooses the Sort function, and {enter) accepts the 
default sort order. 

Notice that the names of certain keys are enclosed in curly brackets ( ( ) ). The function 
keys are { F l  ] through {FIO], the J key is (enter], and Esc is (esc). (You can use either 
uppercase or lowercase letters.) 

/f= tells ProFinder to place the highlighting at the specified filename. For example, 
pf -d-p I f = - f  e would start ProFinder, change to the same directory, and highlight the 
same filename as when you chose the menu option. 



/m= tells ProFinder to close the menu and then display the menu in the file named after 
the equal sign. For example, the Quit line in the menu reads: 

This command displays the menu in the QUITMENU.PF file, which is shown below. It 
works just like USERMENU.PF. It i s  supplied with ProFinder as an example of a sub- 
menu you can construct. 

>Exit to: 
Current dire~tory,/k="{F8)~' 
Initial dire~tory,/k="{ESC}~~ 
Resume,/k="" 

The first menu line, Current directory, sends ProFinder the F8 command, and you exit 
to the directory of the current file list. The second line sends ProFinder the Esc 
keystroke, and you exit to the directory where you started ProFinder. The last menu 
line, Resume, sends ProFinder no keystrokes, and you return to the ProFinder file list. 

You can construct as many levels of submenus as you like, as long as the main menu is 
named USERMENU.PF. 

Tips for Advanced Users 
ProFinder is great for creating and working with a list of files. Here are a few tips you 
may find useful: 

Need to create a batch file to do something with several files? Tag the files, then 
choose F4 (Files) and choose Write filenames. Give the filename you want for your 
batch file and give a prefix or suffix (or both) to put commands or other information 
into your batch file. For example, to create a batch file to copy a group of files to a 
floppy disk, use the prefix copy and the suffix a:. The resulting batch file might 
look like this: 

copy file1 .ext a: 
copy file2.ext a: 
copy file3 .ext a: 

w Here's another way to mark a group of files. Place an identifying tag in the file title 
of each file; for example, make sure each file title contains the characters #I .  Then, 
whenever you want to do something with these files, press F2 (Locate) and choose 
Find files by title. Specify #I as the text to locate. The new file list will include 
only this group of files, and you can copy, move, or do another operation with 
them. 
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B It's easy to back up your files to floppy disks. First, tag all the files you want to 
back up. (Use F3 or File tag by wild card on the F4 Files Menu. Then press F4, 
choose Copy, and name your floppy disk drive. ProFinder copies the files. When 
the floppy disk i s  full, copying automatically pauses to let you insert another disk. 

The example below shows how a programmer can quickly locate and edit all the C 
source files that reference a certain procedure whose argument list has changed. 

1 To see a list of the source files, start ProFinder by typing pf *.? to display all the 
.C and .H files. 

2 To list only the source files that reference a specific procedure, press F2 (Locate) 
at the file list and choose Search files by text. Use the name of the procedure or 
other identifying text as the text to locate, and run the search. 

3 To note which of these files require changes, move the highlighting to each 
filename in turn and press J to view the file. When you view each file, the cur- 
sor i s  on the first instance of the search text. You can scroll through each file if 
necessary to find if you need to change it. If you need to change the file, when 
you return to the file list, press F3 to tag the filename. 

4 When you finish viewing and tagging files, move the highlighting to the first 
filename you tagged and press the flip hot key (the + key unless you've changed 
it). ProFinder starts WordStar and opens the highlighted file. (The default hot 
key program is WordStar; if you have changed it, you must change it back for 
this step to work.) Edit the file to make your changes, then save it. 

5 Choose the WordStar command to open a file. At the prompt for the file to edit, 
press the copy hot key (the - key unless you've changed it). ProFinder copies 
the next tagged filename from the file list. Edit the file, and repeat this proce- 
dure until you've edited all the tagged files. While you're editing files, you can 
use the flip hot key at any time to flip back to ProFinder to check something 
about your files, then flip back into WordStar right where you left off. 
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About option, PF-19 
alphabetize a file list, PF-8 
Alt-H (help), PF-5 
ascending sort order, for a file list, PF-8 
ASCll files 

choosing ASCll file format, PF-12, PF-18 
display, PF-12, PF-18 

asterisk (*), wild-card character, PF-7, PF-9, 
PF-11, PF-25 

backing up files, PF-25 
batch file, create, PF-24 
block operations, PF-13 

and copy hot key (-), PF-8 to PF-9, PF-13, 
PF-18 

case sensitivity, and search, PF-12, PF-14 
change 

date and time of files, PF-11 
directories, PF-7 

color monitors. See monitors 
command line options, PF-19 to PF-20 
configuration options 

setting, PF-17 to PF-19 
See also installing ProFinder 

COPY 
files, PF-10 
text, PF-9, PF-13 

copy hot key (-), PF-8 to PF-9, PF-13, PF-18 
change, PF-9, PF-18 

create 
batch file, PF-24 
directory, PF-15 

cursor movement, PF-6 

date, change for files, PF-11 
delete files, PF-11 
descending sort order, for a file list, PF-8 
directories 

change, PF-7 
create, PF-15 
delete, PF-15 
rename, PF-15 

display 
another file ("OK or F9), PF-13 
ASCll files, PF-12, PF-18 
a file, PF-12 to PF-13 
selected filenames, PF-7, PF-9 
set file format default, PF-18 

DOS, Go to D O S  command, PF-20 

erase files, PF-11 
exit ProFinder, PF-15 
EXTLIST.PF, PF-20 to PF-21 

F1 (help), PF-5 
F9 (view another file), PF-13 
file format, PF-12 

setting, PF-18 
file titles, PF-6 
filenames 

display selected, PF-7, PF-9 
write to a file, PF-11, PF-24 

finding files, PF-14 to PF-15, PF-24 
finding text (AQF), PF-12 to PF-13, PF-25 

case sensitivity and, PF-12, PF-14 
flip hot key (+), PF-8 to PF-9 

change, PF-9, PF-18 
program started by, PF-18 

format of files, setting, PF-18 
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gas plasma monitor, and installing ProFinder, 
PF-4 

Go to 
DOS, PF-20 
location in file, PF-23 

group tagluntag files, PF-9 to PF-10, PF-24 

help (F1 or Alt-H), PF-5 
hot keys 

change, PF-9, PF-18 
copy hot key, PF-8 to PF-9, PF-13, PF-18 
flip hot key, PF-8 to PF-9, PF-18 

installing ProFinder, PF-4 
See also configuration options 

J - 
jump to DOS, PF-20 

keyboard delay, PF-18 

"L, find next instance of search text, PF-13 
locate text. See finding text ("QF) 
location in file, go to, PF-23 
Lotus 1-2-3 

sample Run command, PF-20 to PF-21 
view files, PF-12, PF-18 

margins, print margin setting, PF-18 
mark a block, PF-13 
mass tagging. See group tagluntag files 
menus 

create, PF-21 to PF-23 
syntax for menu file commands, PF-23 to 

PF-24 
minus key (-). See copy hot key (-) 
monitors 

and installing ProFinder, PF-4 
move files, PF-10 
movement (cursor), PF-6 

"OK (view another file), PF-13 

PFINST, PF-4 
plus key (+I. See flip hot key (+) 
print margin, setting, PF-18 
printing 

file list, PF-11 
marked blocks, PF-13 

ProFinder, overview of, PF-3 
program 

run another, PF-20 to PF-21 
started by flip hot key, PF-18 

"QF (find text), PF-12 to PF-13 
"QG (WordStarIASCII toggle), PF-12, PF-18 
question mark (?), wild-card character, PF-7, 

PF-9, PF-11, PF-25 
quit ProFinder, PF-15 
QUITMENU.PF, PF-24 
"QV, find previous instance of search, PF-13 
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rename 
directory, PF-15 
files, PF-10 

run 
another program or DOS command, 

PF-20 to PF-21 
See also start 

save configuration settings, PF-19 
search for text. See finding text (AQF) 
select files. See tagluntag files 
show. See display 
sort a file list, PF-8 
start 

ProFinder, PF-5 
WordStar from ProFinder, PF-8 to PF-9, 

PF-18 
See also run 

synonyms, user synonym file, PF-12, PF-14, 
PF-17 

syntax, for menu file commands, PF-23 to 
PF-24 

tab settings, PF-18 to PF-19 
tagluntag files, PF-9 to PF-10, PF-24 

text, finding ("QF), PF-12 to PF-13, PF-25 
time, change for files, PF-11 
titles of files, PF-6 
TITLES.PF, PF-6 
Turbo Lightning, and synonym file, PF-12, 

PF-14 

untag files, PF-9 to PF-10, PF-24 
user synonym file, PF-12, PF-14, PF-17 
USERMENU.PF, PF-21 
USERSYN.PF, PF-17 

v 
view. See display 

wild-card characters, PF-7, PF-9, PF-11, 
PF-25 

WordStar 
choosing WordStar file format, PF-12, 

PF-18 
start from ProFinder, PF-8 to PF-9, PF-18 

WordStar 2000, choosing WordStar 2000 file 
format, PF-12, PF-18 

write filenames to a file, PF-11, PF-24 
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Introduction 
Star Exchange converts documents created with one application to be compatible with 
documents created with another application. For example, you can convert a docu- 
ment originally created with WordStar 2000 to the WordStar format, and then edit the 
file as you would any WordStar document. 

This documentation addresses conversions between WordStar and other applications. 
However, Star Exchange also converts between WordStar 2000 and other applications. 
Either WordStar or WordStar 2000 must be one of the applications in every Star 
Exchange conversion you do. For example, you can't use Star Exchange to convert 
between Microsoft Word and MultiMate. 

Conversion doesn't alter the original documents; it produces separate, converted docu- 
ments. After a document has been converted, it may need some editing to duplicate 
the exact appearance of the original. However, special codes, formatting, and word 
wrapping are retained during conversion, so the editing needed is minimal. 

The Star Exchange documentation includes 

w The "Introduction," which gives an overview of Star Exchange, lists the applications 
supported, and briefly describes the Automatic Translation feature. 

"Using Star Exchange," which tells you how to convert documents. This chapter 
also contains tips for editing converted documents and a list of features supported 
by Star Exchange. 

w "Error Messages," which lists the error messages you may see in Star Exchange, tells 
you what they mean, and indicates what to do next. 
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App/ications Supported by Star Exchange 

Star Exchange supports over 50 applications. You can convert files from your favorite 
word processor as well as spreadsheets and databases. For a complete list of the sup- 
ported applications, see "Supported Applications" in the Appendix. 

ASCll conversions are useful in preparing documents for electronic mail transfer or for 
sharing documents with applications not supported by Star Exchange. Converting a 
document to ASCII allows an unsupported application to import, view, and print the 
converted document. In general, WordStar accepts standard ASCll data files, and it's 
not necessary to convert them through Star Exchange. 

Automatic Translation 
When converting between applications, you normally tell Star Exchange what applica- 
tion the source document was created with. If you don't know what application was 
used, that is, if you don't identify it to Star Exchange, Star Exchange can still determine 
the file format with its Automatic Translation feature. For more information, see "Using 
Auto Translate" in the chapter "Using Star Exchange." 



Using 
Star Exchange 

You can install Star Exchange at the same time you install WordStar. You can also 
install Star Exchange by starting WINSTALL and using the Add or Remove a Feature 
option. For instructions on how to start WINSTALL, see the Installing and Customizing 
booklet. You can also use Add or Remove a Feature to add or delete any conversion 
applications. 

When Star Exchange is installed on your computer, you can convert documents to or 
from WordStar. The two procedures available for converting documents are described 

C 
below. Instructions for both procedures are in this chapter. 

m "Quick Steps for Converting Documents" takes you quickly through the basic steps 
for conversion. Once you're familiar with Star Exchange, this information may be 
all you need to convert your documents. 

m "Detailed Information on Converting  document^'^ provides complete details on all 
aspects of conversion, including screen examples and parameter information. This 
information supplements the "Quick Steps" procedure described above. 

The instructions in this chapter tell you to select WordStar as Conversion A and the 
other application as Conversion B. You should be aware that WordStar can be either 
Conversion A or Conversion B. You can convert in either direction, from Conversion A 
to Conversion B or from Conversion B to Conversion A. 

Note: Before you start a conversion, be sure to review the onscreen parameters for 
your application at least once. For more information, see "Setting Conversion 
Parameters" in this chapter. 
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Quick Steps for Converting Documents 

To convert documents, you can use either the quick steps below or the more detailed 
procedure that follows the quick steps (see "Detailed Information on Converting 
Documents"). 

1 Start the session from either WordStar or the system prompt. 

At the WordStar Opening Menu or screen, choose Star Exchange from the Addi- 
tional Menu. 

You can also start Star Exchange at the system prompt. Log on to the 
WS\CONVERT directory (or the directory containing your Star Exchange files). At 
the DOS prompt, type convert and press J. 

2 Select the applications: 

At the Main Menu, press 3 for System Setup. Be sure WordStar appears in the 
Conversion A box. Move the other application you'll use for the conversion into 
the Conversion B box. (Use the 1' , J , t, and + keys to select applications and 
move them into the conversion boxes.) 

3 Press Esc to return to the Main Menu. 

4 Select the direction of conversion: 

At the Main Menu, press 1 to translate from Conversion A (WordStar) to Conversion 
B, or press 2 to translate from Conversion B to Conversion A. 

Note: If you choose Auto Translate or a database or spreadsheet as one of your 
conversions, only one option appears on the Main Menu: for example, Translate 
from Auto Translate to WordStar. 

5 Queue documents for translation: 

Type the name of the source document, including the drive letter and directory 
path; for example, b:letter.doc. Press J. 

To queue documents from a directory: 

a. Press F2. 
b. Type the name of the drive or directory; for example, c:\wp\docs. Press J. 
c. Use the 1' and J keys to scroll through the directory list. 
d. Press J to enter a highlighted document into the queue. 
e. Press Esc to end directory assistance. 

6 Translate the queued documents: 

Press F10 to start conversion. 

7 End the session: 

When conversion is  complete, press any key to return to the Main Menu. At the 
Main Menu, press 4 to return to DOS. 

8 Edit the converted documents (see "Editing Converted Documents" in this chapter). 
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Detailed Information on Converting Documents - 

Starting the Session 
Start the session from either WordStar or the system prompt. 

At the WordStar Opening Menu or screen, choose Star Exchange from the Additional 
Menu. 

You can also start Star Exchange at the system prompt. Log on to the WSKONVERT 
directory (or the directory containing your Star Exchange files). At the DOS prompt, 
type convert and press J. 

The Star Exchange Main Menu appears. 

S t a r  E x c h a n g e  
UordStar 2000 / UordStar 5-7 

OPTIONS 

1 = Translate: From UordStar 2000 To UordStar 5-7 
2 = Translate: From UordStar 5-7 To UordStar 2000 
3 = Systen Setup <Select Conuersions) 
4 = End Session 

Enter Choice: 

The Main Menu options are described below. 

Options 1 and 2 display Input Queue screens where you list the documents you 
want to convert. 
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B Option 3 displays the Conversions Menu. You use this menu for selecting the 
applications you'll use for the conversion, setting parameters for naming and storing 
the translated documents, selecting the system work area where the documents are 
to be stored during conversion, and editing the character and typestyle filters. 

Option 4 returns you to DOS. 

T I  P Onscreen help is available from any Star Exchange screen where F1 = HELP is 
shown as an option. Press the F1 key for help; press Esc to leave the help screen. 

Selecting an Application 
1 At the Star Exchange Main Menu, press 3 for System Setup. The Conversions Menu 

appears. 

The Conversion boxes on the Conversions Menu show the applications and other 
file formats you can convert to or from with Star Exchange. To convert between 
WordStar and another application, WordStar should be in the Conversion A box 
and the other application in the Conversion B box. Once you set them up, the 
Conversion A and B boxes remain the same until you change them. 

- 

- 

Note: If Auto Translate i s  one of your conversions, you don't need to identify the 
source application during System Setup. For more information, see "Using Auto 
Translate" in this chapter. 

OPTIONS 
t . 4  = Scroll Highlight 
4- = Set Conuersion A 
-b = Set Conuersion B 
F1 = HELP 
FZ = System Parameters 
F3 = Conuersion A Parameters 
F4 = Conuersion B Parameters 
F5 = Edit Character Filter 
F6 = Edit Typestyle Filter 
Esc = End System Setup 

- 

CONUERSIONS 

UordStar 2000 
UordPerfect 
UordPerfect 5.0 
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2 Be sure WordStar is in the Conversion A box. Move the other application to be 
used in the conversion into the Conversion 6 box. 

(Use the T and keys to select an application; use the t or + key to move it 
into the Conversion B box.) 

Setting Parameters 
After selecting an application, you can select options from the Conversions Menu that 
allow you to set parameters for the conversion. Default parameters have already been 
set in Star Exchange. You can use those if you wish, or you can change them. For 
example, you might want to change the Output Directory parameter that specifies 
where to store your converted documents (the default is the current drive and 
directory). 

You should review the onscreen parameters for your application at least once before 
doing a conversion. Once you've set parameters for the conversion, you'll probably 
use the same ones for all conversions, unless you change computers or applications. 

You can select the parameters options shown below by using the F2, F3, F4, F5, and F6 
keys on the Conversions Menu. 

The System Parameters (F2) option is for setting parameters that affect the internal 
system work area, the keyboard type, the character filter file, and the spreadsheet 
delimiter and margins. 

The Conversion A Parameters (F3) option is for viewing or changing the parameters 
for the Conversion A application (WordStar). 

The Conversion B Parameters (F4) option is for viewing or changing parameters for 
the Conversion B application. 

The Edit Character Filter (F5) option creates a character filter file. It tailors the con- 
version by replacing a character found in the source document with a specific 
character in the converted document, based on the character filter file. This option 
is helpful when the destination application contains characters that are not sup- 
ported by the source application. 

The Edit Typestyle Filter (F6) option allows you to substitute any typestyle (font) in 
your source document with any supported typestyle in the converted document. 
This is helpful when the destination application supports fonts that aren't supported 
by the source application. 
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Setting System Parameters (F2) 
At the Conversions Menu, press the F2 key. The System Setup Menu is displayed. 

POROMETER LIST 

I = Next Parameter 2. Keyboard Type 
F1 = HELP 3. Character Filter File 
Esc = End Parameter Setup 4. Spreadsheet Deliniter 
Enter a neu ualue then press 4 5. Spreadsheet Top Margin 

Parameter: System Uork Qrea Directory 
Ualue: 

Use the "? and keys to highlight the parameter you want. The six parameters avail- 
able are described below. 

System Work Area Directory This parameter determines where the intermediate 
work files are to be stored during conversion. Although Star Exchange automati- 
cally erases these files after each conversion, they temporarily need about 1'12 times 
the size of the largest document being converted. 

To set this parameter, type a drive letter or the name of an existing drive and direc- 
tory, and press J. 

Keyboard Type This parameter i s  determined by the type of keyboard you 
have-disregard it unless you're using an alternative keyboard layout such as 
Norwegian, Danish, or Hebrew. 

Character Filter File This parameter specifies which existing character filter file to 
use for the current conversion. If you don't name an existing filter file in this 
parameter, none wil l  be used. For more information, see "Edit Character Filter (F5)" 
in this chapter. 
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Spreadsheet Delimiter This parameter specifies characters or keys that Star 
Exchange should insert between columns of converted spreadsheets or databases. 
You can select commas, tabs, or spaces. Tabs will help you align the columns once 
you edit the file in a word processor. 

Spreadsheet Top Margin This parameter determines the top margin of the con- 
verted spreadsheet when it is loaded into the word processor. Enter the value of the 
top margin and the unit of measure (cm, CM, in, IN, inch, or Inch). The default 
value is  1 inch. 

Spreadsheet Bottom Margin This parameter determines the bottom margin of the 
converted spreadsheet when it is loaded into the word processor. Enter the value of 
the Bottom Margin and the unit of measure (cm, CM, in, IN, inch, or Inch). The 
default value is 1 inch. 

Setting Conversion Parameters (F3 and F4) 
You can have some control over the codes and format information in a converted docu- 
ment by setting parameters during system setup. Star Exchange stores a separate set of 
parameters for each application it supports. Some parameters-primarily those that 
determine how converted files are named and stored-are standard for all supported 
applications. They are described on the following pages. Others, which you'll see on 
the onscreen parameter lists, apply to specific applications. These parameters are 
described on the help screens. To display help, press the F1 key. 

The first time you use Star Exchange, the parameters are set to the default values. After 
that, the parameters for Conversions A and B are set to the values that were used for the 
most recent conversion. 

To set conversion parameters, start at the Conversions Menu. Press F3 to set 
parameters for the Conversion A application (Wordstar), or press F4 to set parameters 
for the Conversion B application. When the System Setup Menu appears, use the t 
and d, keys to scroll through the parameter list. Each time you type a new value for a 
parameter, be sure to press J to save the value. 

The standard parameters shown below are available for most supported applications. 
Use the d, key at the parameter list to check for possible additional parameters. 

Note: There are no parameters available for spreadsheet or database files since you 
can't convert to those formats. 

Output Directory 

This parameter determines where the converted files are to be stored. If you don't 
specify this information, the documents are stored in the current drive and directory. 

To specify another directory, type the name of an existing directory and path, and 
press J. For example, type c:\document to have the converted documents stored in 
the DOCUMENT directory on drive C. 
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File Naming Method 

This parameter determines how converted files are named. Five ways for naming files 
are available, as shown below. 

w Original Filename with User Defined Extension If you select this method, the 
filename of the source document is  automatically assigned to the converted docu- 
ment in this form: 

[Output Directory][Original File Namel.[Output File Extension]. 

The Output Directory and Output File Extension parameters are also used to build 
the filename. 

E X A M P L E  

If a source document named LETTER.XYZ i s  converted to a different application, 
and the parameter values are 

Output Directory = C:\DOC 
Filenaming Method = Original Filename with User Defined Extension 
Output File Extension = .ABC 

then the converted file i s  named: C:\DOC\LETTER.ABC. 

Original Filename with Original Extension Choose this method if you want the 
converted document to be automatically assigned the same name as the source 
document. 

Note: If Star Exchange creates the converted document in the same directory as the 
source document, your source document wil l  be overwritten. 

w User Defined Filename with User Defined Extension The user assigns the filename 
and the extension. The Output Directory, User Defined Filename, and User 
Defined Extension parameters are used to build the filename. 

User Defined Filename with Original Extension The user assigns the filename and 
Star Exchange assigns the file extension, using the original extension from the 
source document. The Output Directory and User Defined Filename parameters are 
used to build the filename. 

Note: When a document of the same name already exists, Star Exchange prompts 
you for instructions. Then you can either type a new name and press J , or press 
Del to overwrite the existing document. 

w Prompt User for Filename This method allows the user to assign the filenames. 
When you select this parameter, Star Exchange prompts you for a name as each 
document is  converted. You must also include the drive letter or directory name, as 
necessary, and any mandatory file extension; for example, .DOC for documents that 
are converted to MultiMate. 

User Defined Filename 

If you selected a filenaming method where the user assigns the filename, use this 
parameter for the filename. 
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You may include a plus sign (+) as the last character in the filename if you want to 
increment the filenames automatically with numbers, starting with 001. (DOS allows 
only eight characters for a filename, so limit your filename to five characters when you 
use the plus sign.) 

E X A M P L E  

USER DEFINED FILENAMES OF 
FILENAME CONVERTED DOCUMENTS 

ABC+ ABC001, ABC002, ABC003, etc. 
ABC+X ABCOOl X, ABCOO2X, ABC003X, etc. 
+ 001, 002, 003, etc. 

User Defined Extension 

If you selected a filenaming method where the user assigns the file extension, use this 
parameter for the extension. 

You may include a plus sign (+) in the extension if you want to automatically increment 
the extensions with numbers starting at 01. (DOS allows only three characters for a file 
extension, so limit your extension to one character when you use the plus sign.) 

E X A M P L E  

USER DEFINED EXTENSIONS OF 
EXTENSION CONVERTED DOCUMENTS 

A+ .A01, .A02, .A03, etc. 
+ ,001, ,002, ,003, etc. 

Note: Special extensions are required by MultiMate 3.6, Advantage II and Wang PC 
(.DOC) and MultiMate 4.0 (.DOX). You cannot alter the extension for these word 
processors. For other applications, use any valid DOS extension. (See also the default 
extensions on the help screen for this parameter.) 

Replacement Character 

This parameter defines a special character to be inserted in the translated document to 
mark the location of any nontranslatable character found in the source document. 
Replacement characters are represented by Hex-ASCII codes; for example, Hex 40 i s  
represented on the screen by an @. (Hex-ASCII codes are listed in the "ASCII Character 
Charts" in the Reference manual.) 

Sometimes a source document contains a character that cannot be translated. The 
character you specify in this parameter wil l  be inserted in the translated document 
when a nontranslatable character is found. In the converted document, this "marker" 
indicates a character that needs correcting. 
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Input File Type 

This parameter is useful if you have a database file that you want to use with Wordstar. 
When you choose Data File as your Input File Type, Star Exchange converts your data 
file to an ASCII comma delimited file. (When you convert a data file, Star Exchange 
changes the Spreadsheet Delimiter from tabs or spaces to commas.) You can use the 
converted file as a data file for merge printing. 

Edit Character Filter (F5) 
This option allows you to tailor a conversion by creating a file that replaces a specific 
character (or characters) found in the source document with any character in the con- 
verted document. This option is helpful when your destination application does not 
contain characters that are supported by your source application. 

T I P If you want a filter file to be used during conversion, you must specify the drive, 
filename, and the extension of that file in the Character Filter File parameter (see 
I'Setting System Parameters (F2)" in this chapter). 

To create a filter file: 

1 At the Conversions Menu, press F5. 

The Filter Table is displayed. 

FILTER EDITOR OPTIONS 

Enter a neu ualue then press 4 
To scroll use: 

t ,  4 ,  Hone, End, PgUp, PgDn 
Use -+ or 4- to change entry node 
F1 = HELP 
FZ = Read in a filter file 
F3 = Saue to a filter file 
Esc = Exit Filter Editor 

Input Code F Conuerts To =I 
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In the Filter Table, the values in the Input Code column, which represent characters 
in the source document, cannot be changed. The values in the Converts To column 
are the actual replacement characters. These values can be changed. 

2 In the Converts To column, use the -+ , t , 1' , and 4 keys to move the cursor to 
the character you're replacing. 

3 To change a character, type either a new character (the replacement character) or 
the Hex-ASCII representation for that character (see the "ASCII Character Charts" in 
the Reference manual). 

4 When the filter file is  complete, press F3 to save it. 

5 At the Save File: prompt, type a filename and press J. 

The filename can be any name and extension you choose, and can include a drive 
name and directory. If you don't include a drive and directory, the default i s  the 
current directory. 

6 Press Esc twice to return to the Main Menu. 

To edit an existing filter file: 

1 At the Filter Table, press F2. 

2 At the Read File: prompt, type the name of the filter file you want to edit. 

3 Make changes and save them as in "To create a filter file" above. 

4 Press Esc twice to return to the Main Menu. 

Edit Typestyle Filter (F6) 
This option allows you to select the typestyle, or font, that you want used in a con- 
verted document when that font isn't supported by the source application. The font 
you choose must be supported by the destination application. 

The typestyle you choose for your translated document must have the same pitch as the 
typestyle in the source document. For example, if the source document uses 10 pitch, 
you can't select a typestyle that i s  12 pitch for the translated document. If you do, Star 
Exchange ignores your selection. 

If your conversion includes WordStar 2000 or WordPerfect, be sure to specify the 
WordStar 2000 PDF file or the WordPerfect PRS file in the appropriate Conversion A or 
Conversion B Printer Description File parameter during system setup. Specify the drive 
letter or directory path, if necessary. Otherwise, Star Exchange won't be able to find 
the correct typestyles. 

To edit the typestyle filter: 

I At the Conversions Menu, press F6. 

2 At the Choose a Direction to Edit screen, press 1 or 2 to select the direction of your 
conversion. 
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The Typestyle Filter Menu is displayed. 

On this screen, the top window lists the options available; the middle window lists 
the typestyles supported by both the source and the destination applications; the 
bottom window lists the available typestyles for the destination application (you 
select a typestyle from this list). 

- 

- 

3 Select options as needed: 

TYPESTYLE FILTER OPTIONS 
F1 = Help 
FZ = Moue cursor betueen display uindous 
F3 = Select highlighted typestyle 
F4 = Restore default filter 
F5 = Restore preuiously saued filter 

Use t, +, t, L to Moue cursor 
ESC = Exit and use filter 

UordStar Typestyles UordStar 2000 Typestyles 

Best Fit 
Best Fit 

AUAILABLE TYPESTYLES 
I '  I N O N  PS it NON PS 17 

NON PS 20 NON PS 5 NON PS 6 
PROPORTIONAL PROP EXPANDED 

F1 displays Help, which includes complete instructions for editing the Typestyle 
Filter. 

F2 moves the cursor between the Options window and the Available Typestyles 
window. 

F3 selects the typestyle highlighted in the Available Typestyles window. 

F4 restores the original Star Exchange default filter for use in subsequent conver- 
sions. 

F5 displays the previously saved filter changes and allows you to make further 
changes. 

F10 saves your changes. 
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Queuing Documents for Translation 
When the parameters are set as you want them, press Esc twice to return to the Main 
Menu. (You'll see a message on the screen telling you the parameter settings are being 
saved.) At the Main Menu, press 1 or 2 to choose the direction of conversion, either 
from A to B or from B to A. 

The lnput Queue appears. On this screen, you specify the documents to be converted 
by manually typing each document name or by selecting each document (or an entire 
directory) from an onscreen directory display. 

The lnput Queue, shown below, has room for 100 document names. The application 
named on the screen is the source application, the one you're converting from. 

source application 

OPTIONS 

Type Document Names folloued by 4 I Fl = HELP 1 
FZ = Automatic Directory Assistance 
Esc = End Document Queueing 

Number of Entries: 0 

Current Path: C:\US\CONUERT 

Note: When you use the Auto Translate option, the lnput Queue screen is divided into 
two sections-one for the document names and one for the names of the source 
applications, as determined by Star Exchange. For more information, see "Using Auto 
Translate" in this chapter. 
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After you enter the first document name into a queue, the OPTIONS list changes to 
include two more options, as shown below. 

C: \US\LIST. DOC 

Current Path: C: \US - 

additional options 

To type individual document names in the queue, see "Manual Entries" below. 

- 

H To select documents from a directory display, see "Automatic Directory Assistance," 
which follows "Manual Entries." 

OPTIONS 

Type Docunent Nanes folloued by 4 
F1 = HELP 
FZ = Butonatic Directory Assistance 

Manual Entries 

In the lnput Queue screen, type the first document name (using either upper- or lower- 
case letters), and press J. Continue typing document names, pressing J after each 
one, until you've entered all the documents that belong in the queue. 

- 

H To queue individual documents, type the drive letter or directory path; for example, 
b:letter.doc or c:\ws\convert\letter.doc. 

FIB = Translate the Queued Docunents 
Del = Delete Docunent Nanes fron the Queue 
ESC = End Docunent Queueing 

- -  - - 

Note: If the drive letter or directory path that appears at the bottom of the lnput 
Queue is  where your source documents are located, type only the document names 
in the queue. When you press J, Star Exchange adds the path information. 
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m To queue all documents on a disk or in a directory, type the drive letter or path, and 
use the DOS wild-card character *. 
To queue documents with related filenames, use the DOS wild-card characters * 
and ?, and include any identifying drive letter or directory. 

E X A M P L E S  

TYPE THIS 

a:*.* 

c:\ws\convert\*.* 

TO QUEUE THESE DOCUMENTS 

All documents on the disk in drive A. 

All documents in the WS\CONVERT directory on 
drive C. 

All documents with a .TXT file extension on drive A. 

All documents with the filename FEB??89 (where ?? i s  
any date) in the WS\CONVERT directory on drive C. 

C A  U T I  0 N All documents in a queue must.have been created with the application 
you chose for the conversion (the source application). Don't mix documents from dif- 
ferent applications in the same queue, unless you're using Auto Translate. 

Automatic Directory Assistance 

Using Automatic Directory Assistance is  the fastest way to queue documents that are in 
the same directory. To add files to the Input Queue using the Directory Assistance 
screen, follow the quick steps below. For more detailed information about the Direc- 
tory Assistance screen, see "Using the Directory Assistance Screen" in this chapter. 
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1 At the Input Queue screen, press the F2 key. The Directory Assistance screen 
appears. 

[ FAX1 
C INSET1 
COPTIONSI 
CCONUERTI 
TABLESZ. OUR 
UINSTALL. EXE 
$INDEX. OUR 
$TOC. OUR 
384K. PAT Directory 

ASCI I. PDF 
BOX 
CHANGE. OUR 
CLIENT. DTA 
COPYUS. EXE 
DISPFONT. CON 

I Subdirectoru Listina LI-CI- 

2 Press Esc to move to the window on the left side of the screen, which lists the 
names of all the documents and subdirectories in the current directory. The names 
in brackets are subdirectories. When a filename is highlighted, the contents of that 
file appear in the window on the right side of the screen. 

3 Use the cursor keys to scroll through the document names. When the document 
you want to convert is highlighted, press F10 to add it to the queue. 

4 When you finish adding documents to the queue, press F8 to display the Directory 
window and specify a different drive and/or directory, or press Esc to end Automatic 
Directory Assistance. 

Deleting Documents from the Queue 
Incorrectly typed entries or other improper entries should be deleted from the queue 
before conversion. Star Exchange doesn't verify that an entry exists until it tries to 
translate it. Any document that is incorrectly named cannot be translated. 

8 A queue is not erased automatically after conversion. 

All queues are erased when the session is ended or when you select a different 
direction of conversion on the Main Menu. 
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You can delete individual document names or you can delete an entire queue by fol- 
lowing these steps: 

1 At the lnput Queue, press the Del key. 

This OPTIONS window appears. 

UordStar 5-7 Input Queue Nunber of Entries: 10 

C: \US\HAILING. DOC 
C: \US\PLAYS. DOC 
C: \US\SHAKE. DOC 
C: \US\SPELL. DOC 

Current Path: C: \US\CONUERT 

- 

- 

2 Using the T and keys, highlight the document you want to delete. (To delete the 
entire queue, skip this step and go to step 3.) 

3 Press Del to delete the highlighted document. Or press and hold the Alt key while 
you press D to delete the entire queue. 

Fi = HELP 
Del = Delete Highlighted Nane fron the Queue 
Alt-D = Enpty the Queue of all docunent nanes 
t = Scroll Highlight Up 
1 = Scroll Highlight Doun 

4 When you finish deleting files, press Esc. 

Using Auto Translate 
The Auto Translate option on the Conversions Menu lets you convert documents for 
which the source applications, or file formats, have not been identified to Star 
Exchange. You simply enter the unidentified files into the lnput Queue, and Star 
Exchange identifies their formats. 
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To use Auto Translate, choose Auto Translate and WordStar from the Conversions 
Menu during system setup. Then choose Translate: From Auto Translate to WordStar 
from the Main Menu. (When Auto Translate is one of the two conversions selected, 
only one conversion direction is  available-from Auto Translate to WordStar.) At the 
lnput Queue, enter the document names as usual, either manually or using Automatic 
Directory Assistance. As you enter the document names, Star Exchange identifies them 
and displays their file formats onscreen. 

When you use Auto Translate, the lnput Queue is divided into two parts. The docu- 
ment names appear on the left side of the screen; the file formats appear on the right. 

If you enter an unidentified document into the queue, and the document was created 
by ah application that is  not supported by Star Exchange, the word UNKNOWN 
appears on the right side of the queue opposite the document name. During conver- 
sion, Star Exchange bypasses that document and goes on to the next document it 
recognizes. 

Some short Wordperfect 4.2 documents and some ASCII and WordStar 3 . 3 ~  files may 
not be recognized by Auto Translate. These documents contain limited or no format- 
ting codes that can be used to determine the origin of the document. Star Exchange 
treats these documents like any other unidentified document-it displays UNKNOWN 
next to the document name in the queue. The only way to translate such documents i s  
to manually select the conversion as Conversion A or Conversion B. 

Translating Queued Documents 
When the queue is  ready, press F10 to start the conversion. 

C A U T I  0 N Be sure you have enough room on your output disk for the converted 
files--about 111.2 times the size o f  the combined input files. 

Two windows appear on the screen. One shows the lnput Queue (the document being 
converted is highlighted); the other displays the name of each converted document as it 
is  completed. If you're using Auto Translate, the name of the source application for the 
document appears while the document is being translated. 

After conversion begins: 

To interrupt a session, press Esc and follow the onscreen instructions. 

If you selected Prompt User for File Name as your File Naming Method, Star 
Exchange prompts you for filenames. Be sure to preface each name with the drive 
letter and directory name, if necessary. 

m If you choose a filename that already exists, the program prompts you to either 
rename the translated document or overwrite the existing document. 

If conversion fails, an error message is displayed. Then you can either press Esc to 
end the session, or press J to translate the next document in the queue. 
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After a conversion error occurs, files with the extension .INT may be left on the 
disk. These files take up disk space unnecessarily and should be deleted. 

When conversion is  complete, you can either delete the queue and build another 
one, or you can press Esc to return to the Main Menu. 

Using the Directory Assistance Screen 

The Directory Assistance screen consists of several parts, as shown below. 

document viewing window 
file list window directory information line 

[ . . I  
[FAXI 
C INSET1 
[OPTIONS] 
LCONUERTI 
T R  

diredorv edit window 

- -  -- A $INDEX. OUR I t 
Directory 

11 ASCI I. PDF 1' 11 

BOX 1 1 11 CHRNGE.OUR I 
I I  I1 CLIENT. DTA 

COPYUS. EXE 
DISPFONT. CO11 I file information line 

5 

function key template message line I 
The Directory Information Line displays the path Star Exchange is using. The path 
consists of the drive, directory(ies), and filename. 

rn The Directory Edit Window lets you specify the directory and filename for the 
document you want to view and/or convert. 

The File List Window lists the files in the current directory and its subdirectories, if 
any. 

The Document Viewing Window displays the contents of the file that i s  highlighted 
in the File List Window. 
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1 The File Information Line displays the file format and cursor position for the file dis- 
played in the Document Viewing Window. 

The Message Line displays status information or instructions for completing a task. 

The Function Key Template displays the function keys available on the current 
screen and what they do. For some functions, you use the Ctrl key along with the 
function key. For a complete list of the function keys available at the Directory 
Assistance screen, see "Directory Assistance Keys" in this section. 

Using the Directory Edit Window 
You can use the Directory Edit Window to specify the drive, directory, and filenames 
you want. To display the Directory Edit Window from the lnput Queue screen, press 
F2. To display it from the Directory Assistance Screen, press F8. 

To change the directory in the Directory Edit Window, press the Backspace key or press 
"Backspace to delete the current directory. Then type the new directory name and the 
filename. To specify filenames in this window, you can use DOS wild-card characters. 

Using the File List Window 
The File List Window appears on the left side of the Directory Assistance screen. It 
displays the parent directory and its subdirectories, and all the filenames in those 
directories. 

You can move the highlighting through the subdirectories and files to find the ones you 
want. To add a highlighted file to the lnput Queue, press the F10 key. 

About the File List Entries 

When the Directory Assistance screen appears, the cursor is located in the Directory 
Edit Window. You can press Esc to close that window. Then the cursor moves to the 
first line of the File List Window. If the current directory is a subdirectory, the first 
entry in the file list looks like this: I. .I. This symbol represents the parent directory of 
the subdirectory you're in. For example, if you are in the DOCS subdirectory of the WS 
directory (C:\WS\DOCS), the I. .I symbol represents the WS, or parent, directory. If 
you highlight the I. .I symbol and press J, Star Exchange changes to the WS (parent) 
directory. 

If the current directory is the root directory, the first entry in the File List Window is 
either a subdirectory or a file, depending on which was created first. Subdirectories are 
enclosed in brackets, for example, IWSI. Files appear as regular text, for example, 
SHAKE.DOC. 
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Finding Subdirectories and Files 

The File List Window lets you move easily through the directories on your disk to find 
the files you want. For example, if you're in the root directory and you want to view 
C:\WS\DOCS\SHAKE.DOC, you would first highlight the [WS] subdirectory entry and 
press J. Then you would highlight the [DOCS] subdirectory entry and press J. Finally, 
you would highlight the SHAKE.DOC filename. When SHAKE.DOC is highlighted, the 
contents of that file appear in the Document Viewing Window. 

As you move the highlighting through the list of files in the File List Window, the File 
Information Line changes to reflect the various file formats. This line identifies the file 
format and the cursor position in the file. If a document contains no formatting codes 
or codes that Star Exchange cannot recognize, the File Information Line displays ASCII 
or Other. 

Using the Document Viewing Window 
The Document Viewing Window displays the contents of the file or subdirectory that is 
highlighted in the File List Window. After highlighting an entry in the File List 
Window, press the Tab key to move into the Document Viewing Window. Then use 
the cursor keys to scroll down through the file. 

Note: You can view but not edit text and data in the Document Viewing Window. 

If the highlighted file in the File List Window is  a subdirectory name, a message in 
the Document Viewing Window tells you the name of the subdirectory and how 
many files are in it. You can scroll down the screen (press the PgDn key once or 
twice) to view a list of the files in that subdirectory. The list includes the same 
information you would see after entering a DIR command in DOS. 

a If the highlighted file in the File List Window is a filename, the contents of that file 
are displayed in the Document Viewing Window. How the file appears onscreen 
depends on the format and type of file. For example, word processor files appear in 
their original format. 

When you highlight an .EXE or .COM file, the Document Viewing Window displays the 
message: This File is an Executable (. EXE) File. It is not viewable. 
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Zooming in on Files 

To magnify the Document Viewing Window so that it fills the entire screen, press the 
F2 key. Then the Document Viewing Window blocks out the File List Window and 
looks like this: 

To toggle out of Zoom mode and redisplay the File List Window, press the Tab key or 
the F2 key. To view a different file while in Zoom mode, press the plus (+) or minus (-) 
key on the numeric keypad. The + key highlights the next file in the File List Window; 
the - key highlights the previous file. 

- 

- 

S t a r  E x c h a n g e  
HEM0 
To: t Charles 
From: t Deborah 
Re: t Props 

Rehearsals for Act I of "The Herry Uiues of Uindsor" are 
scheduled to begin on Monday. During the first ueek, uhile 
ue're blocking the action, I'd like to haue a snall table and 
three chairs on stage. Ue're performing this play in settings 
and costumes fron the 1928s. For the perfornances, you'll need 
to prepare props that are appropriate for that period. I'n 
giving you advance notice because some of the props could be 
difficult to find or construct. 

Please prepare the props listed belou for "Herry Uiues." 

-=UordStar 7 LIST. DOC Ll-C1=- 

Help Zoom 
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Searching for Text 

You can find specific text in a file by using the Search function. In the Document 
Viewing Window, press F9. The Search window appears: 

S t a r  E x c h a n g e  
nEn0 
To: t Charles 
From: t Deborah 
Re: t R o p s  

Rehearsals for Pct I of "The Merry Uiues of Uindsor" are 
scheduled to begin on Monday. During the first ueek, uhile 
ue're blocking the action, I'd like to have a small table and 
three chairs on stage. Ue're performing this play in settings 
and costum 

Case: Off 

Please prepare the props listed belou for "Merry Ulues." 

I I Lu,,m+., 7 I I ~ T  nnc L I C I ~  I 

Change Search hdd to I I I H e l p l z O O m l  1 I I 1 I D i r - 1  (Queue1 I 

Notice the two prompts in the middle of the window: 

w The Search prompt (the arrow) shows which direction the search will take. Press ? 
to search upward through the file or to search downward. 

The Case prompt shows whether case sensitivity is on or off. When Case is on, Star 
Exchange searches for a string with the same capitalization as the search string. 
When case sensitivity is off, Star Exchange ignores capitalization. Press PgUp to 
turn case sensitivity on or PgDn to turn it off. 

You can enter up to 40 characters in the Search window. If you are searching for a key 
word, you can enter all or part of the word. When you enter part of a word, Star 
Exchange displays the first match it finds. For example, if you enter Fin, Star Exchange 
might find the words "Final," "Finish," or "Finland." 

To search for a text string, type the text in the Search window and press J. When Star 
Exchange finds the text, it places the cursor at the first character in the text and displays 
Search Completed in the Message Line. To find the next occurrence of the text string, 
move the cursor past the found text and press "F9. 
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Note: Star Exchange may'not find text strings that are separated by word wrap or a line 
break. 

Converting Spreadsheet and Database Files 
Star Exchange can convert complete data files or just specified parts of spreadsheets 
and databases. When you highlight a spreadsheet or database in the File List Window, 
and press Tab, the Function Key Template at the bottom of the screen looks like this: 

-Gs 1-2-3 Release 2 ~l-tl===J 

Help Zoon Select Select 
Line Block Queue 

Fl FZ F3 F4 

I 
function key template 

To select just part of a spreadsheet or database file, you define the selected section to 
Star Exchange in one of the following ways: 

By selecting individual rows or records 

By selecting a block of data 

m By selecting a noncontiguous range of rows and columns 

Selecting Individual Rows or Records 

Use the F3 key to select one row (in a spreadsheet) or record (in a database) at a time. 
First, press F3 to define the beginning of the selected area. Then press the I' and keys 
to extend the area. As you move the cursor up or down, entire lines or records are 
added to the selected area. 
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Selecting a Block of Data 

Use the F4 key to select a block (rectangular area) of data. When you press F4, the cur- 
rent cursor position becomes one corner of the rectangle. Then use the arrow keys to 
move the cursor to define the opposite corner of the rectangle. This selection method 
is handy for converting columns or tables. 

Selecting Noncontiguous Rows and Columns 

In spreadsheet and database files, you may want to select only certain rows and 
columns rather than an entire block of data. You can do so by using the "F3 and "F4 
commands to select horizontal and vertical ranges. "F3 selects the Horizontal Range 
function and "F4 selects the Vertical Range function. These two functions work 
together. You define the ranges; the selected area i s  defined by the intersection of 
those two ranges. 

Instructions for defining the ranges shown in the following examples appear on page 
31. 

E X A M P L E S  

Suppose you want to convert the Salaries and Purchases rows in the example below. 
The rows are noncontiguous, that is, they are not side by side. Each row i s  a Horizon- 
tal Range. When these ranges are selected, the spreadsheet looks like this: 

------------ ------------ ------------ ------------ ------------ ------ ------------ ------------ ------------ ------------ ------ 

$600.00 $600. 00 $see. a0 $600. e0 $2,4 
Aduer. $900.00 $2.000.00 $1.700.00 $4.000.00 $8,6 
, ,.,,..,,,. & ,  ......... . &... ..... ,.~,..u..,., . .  ...s,. , $ - , : '  .,$s;@eri;.qc;: . $$7,7 

II ------------ ------------ ------------ ------------ ------------ ------ 
a Total: $a, m a .  ee $10. zae. ee $10, m e .  ee $13, zee. ee $4z,4 11 ------------ ------------ ------------ ------------ ------------ ------ ------------ ------------ ------------ ------------ ------------ ------ 

Incone: 
Quarterly $5,300.08 $4,808.80 $5,700.00 $18,800.00 

Lotus 1-2-3 Release 2 INCOflE4. UK1 L1-C1 
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The Jan-Mar and Jul-Sep columns in the example are also noncontiguous. Each column 
is  a Vertical Range. When these ranges are selected, the spreadsheet looks like this: 

Help Zoom Select Select 
Line Block Select Dir 

F1 FZ F3 F4 F5 FC 
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The selected area is defined by the intersecting areas of the Horizontal Range and the 
Vertical Range. The following example shows the two ranges and how they intersect to 
define the selected area: 

------------ ------------ ------------ ------------ ------------ ------ ------------ ------------ ------------ ------------ ------------ ------ 
$14,000.00 $15,000.00 $16,000.00 $24.000.00 $69.0 ------------ ------------ ------------ ------------ ------------ ------ 

::;:::::: $2.000.00 $8,0 
1,200.00 1 500 00 $1,600.00 $5,7 
$600.00 $600.00 $600.00 $600.00 $2,4 
$300.00 $2,000.00 $1.700.00 $4,000.00 $8.6 

------------ ------------ ------------ ------------ ------------ ------ 
$8,700.00 $10,200.00 $10,300.00 $13.200.00 $42.4 ------------ ------------ ------------ ------------ ------------ ------ 

Quarterly $5,300.00 $4,800.00 $5.700.00 $10.800.00 $26.6 

Defining the Ranges 

To define a horizontal range: 

Move the cursor to the first row in the range and press AF3 .  If the range includes 
more than one row, move the cursor up or down to define all the rows you want to 
include. To define the end of the range, press the Spacebar. The Spacebar anchors 
the range so you can move the cursor again without extending the range. Repeat 
these steps until you have defined all the horizontal ranges. 

To define a vertical range: 

Move the cursor to the first column in the range and press "F4. If the range 
includes more than one column, move the cursor left or right to define all the 
columns you want to include. To define the end of the range, press the Spacebar. 
Repeat these steps until you have defined all the vertical ranges. 

After you have defined both ranges, the intersecting areas (the selection area) appear in 
reverse video. If you find that the selected area includes any rows or columns that you 
don't want, you can deselect them the same way you selected them. 
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Directory Assistance Keys 
You can use the keys listed below in the Directory Edit Window, the File List Window, 
and the Document Viewing Window. 

PRESS THlS KEY TO D O  THlS 

Move the cursor in the File List Window to the next entry 
that begins with the same letter. 

- (minus) or + (plus) key Display the previous (-) or next (+) file in the list. 

Change the current directory to the directory highlighted in 
the File List Window. 

Display a help screen. 

Toggle the Document Viewing Window in and out of Zoom 
mode. 

Select a row or record in a spreadsheet or database. 

Select a Horizontal Range of rows or records in a spread- 
sheet or database. 

Select a block (rectangular area) of data in a spreadsheet or 
database. 

Select a Vertical Range of columns or records in a spread- 
sheet or database. 

Cancel all selections in a file. 

Display the Directory Edit Window. 

Search through a file for a keyword or text string. 

Find the next occurrence of the search text. 

Add the highlighted document to the Input Queue. 

Editing Converted Documents 
When conversion is complete, you should review the translated documents. Changes 
may be necessary to duplicate the appearance of the original document. 

Here are some tips for editing your documents: 

Scan the document for replacement characters. These are the "markers" that Star 
Exchange inserted for any nontranslatable characters it found in the source docu- 
ment. For more information, see "Replacement Character" in this chapter. 

Check the appearance of any columns in the document. If the line length used for 
word wrapping varies widely between the two applications in the conversion, you 
may need to adjust column indentations. 
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When you first edit documents that have been converted to DisplayWrite or 
MultiMate, refer to the instructions below. 

DisplayWrite If the translated documents are stored in Revisable For Text (RFT), 
use the DisplayWrite utility "Convert Documents" to convert the documents into 
text files before you edit them. 

MultiMate Large documents translated into MultiMate can exceed the maximum 
number of format lines, number of pages, and so on, that are allowed. These docu- 
ments are split into separate documents during conversion. You may wish to do 
some minor editing to establish breaks between these documents. 

Features Supported by Star Exchange 

The word processing features supported by Star Exchange are listed below. 

Soft carriage returns 
Regular tabs 
Bold 
Titles 
Hard hyphens 
Right and left margins 
Headers and footers 
Pitchifont 
Top and bottom margins 

Hard carriage returns 
Decimal tabs 
Superscriptlsubscript 
Overstrike 
Soft hyphens 
Line spacing 
Forced page breaks 
Footnotes 
Offsets and gutters 

Centering 
Underlining 
Columns 
Stop codes 
Indenting 
Automatic page breaks 
Italic 
Nonprinting comments 

Transferring Converted Files to the Macintosh 

When converting a document file to a Macintosh word processor format, you need to 
consider the type of file (MacBinary or Standard) that you want the conversion to 
produce. If you plan to convert to Standard format, you'll need to use the Macintosh 
Tagger program to tag the files. If you plan to convert to MacBinary format, you don't 
need to tag the files. For more information on file types and the Tagger program, see 
"Macintosh File Types" and "Using the Macintosh Tagger" in this section. 

Note: The terms tag and tagging used in this section are Star Exchange terms, not 
Macintosh terms. They are used to describe a process that, in Macintosh terms, i s  
similar to changing the creatorltype for a file. 

The three basic methods for moving a file between the PC and the Macintosh are Apple 
File Exchange, Superdrive, and direct transfers. 
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Apple File Exchange and Superdrive 
The Apple Superdrive is a standard part of most Macintosh systems. This drive lets the 
user read DOS formatted disks and can be used to transfer DOS files to a Macintosh 
disk. This procedure is accomplished using an application called Apple File Exchange 
(AFE), which is a standard part of Macintosh System 6.0 and later. (For more informa- 
tion, see the "Macintosh Utilities User's Guide.") 

If you plan to use AFE to transfer your converted file to the Macintosh, be sure (in 
System Setup) to select Standard as the file type in the Output File Type parameter for 
the Macintosh format. 

When using AFE to move a converted document to the Macintosh, make sure no spe- 
cial translation has been done to the file. This means that special translators (such as 
Text Translation) should not have check marks next to them in the MS-DOS to 
Macintosh menu. (This menu does not appear until a DOS disk is inserted into the 
system.) 

A product called DOS Mounter by Dyna Communications allows a DOS disk in a 
Superdrive to look just like a Macintosh disk to the Finder. In this case, the converted 
file should be dragged to a real Macintosh disk and then tagged, as explained in "Using 
the Macintosh Tagger" in this section. 

Direct Transfers 
Many combinations of hardware and software allow the transfer of files between a PC 
and a Macintosh. Some of them are as follows: 

Direct serial or parallel connections using standard communications software such 
as ProComm, Smartcorn, or Crosstalk on the PC and MacTerminal, and Microphone 
or Red Ryder on the Macintosh. 

Modem or network connections using standard communications software. 

Connections using dedicated file transfer software/hardware combinations such as 
LapLink Macintosh, MacLink Plus PC, or pcAnywhere. 

Any other connections that allow file transfer. 

When using one of the above connections to transfer files, first determine whether or 
not your Macintosh software will allow the Macintosh to receive files in MacBinary for- 
mat. Most current Macintosh communications software permits the use of the 
MacBinary file. Most PC communications software can send the MacBinary file using 
XMODEM protocol. And virtually all specialized software and hardware can receive 
and send MacBinary files. 

If the transfer software you're using allows MacBinary file transfers, select MacBinary 
(in System Setup) as the Output File Type parameter for the Macintosh format. Once a 
file has been transferred to the Macintosh as a MacBinary file, it is ready to be used 
with the word processor for which it was created. No tagging should be necessary. 
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If your software does not support MacBinary files, select Standard as the Output File 
Type parameter for the Macintosh word processor. When the file has been transferred 
to the Macintosh, you will need to tag it for the word processor you will be using. 

Macintosh File Types 
As noted above, Macintosh conversions in Star Exchange can produce a Macintosh 
document in two formats, MacBinary and Standard. (The Standard format is often 
called the Data Fork.) 

PC files are created using a single stream of bytes and some fairly unimportant informa- 
tion like the creation time and date. PC-based applications can open almost any file, 
regardless of its name or other information maintained by the operating system. 

Macintosh files are created using two streams of data called the Data Fork and the 
Resource Fork. These two forks include information maintained by the Macintosh 
operating system that associates a creator and type with the file. The Macintosh uses 
this information to display special icons on files and to allow the user to start an 
application by double-clicking on a document. If a Macintosh document does not 
have the correct creator or type, it cannot be opened, not even by the application that 
created it. 

The MacBinary and Standard formats are described below. 

w MacBinary When a Macintosh file resides on a non-Macintosh system, you can 
use the MacBinary format to preserve the information, as well as the separate Data 
Fork and Resource Fork. This format groups the file's name, creator and type infor- 
mation, and Data Fork/Resource Fork into a single stream of bytes. Most com- 
munications programs on the Macintosh can send and receive Macintosh files in 
this format, allowing the transfer of Macintosh files to and from a non-Macintosh 
system with no loss of information. 

w Standard In certain network situations or when the transfer method does not sup- 
port MacBinary, the conversion can produce only the Data Fork of the Macintosh 
file. This format is called Standard. A file produced with the Standard Option and 
transferred to the Macintosh is not accessible to the word processor for which it was 
created. This inaccessibility is caused by incorrect or missing creator and type 
information. To give this type of transferred document the correct creator and type 
information, you need to use the Macintosh Tagger program available from 
Wordstar. 

Using the Macintosh Tagger 

The Macintosh Tagger sets the creator and type information for a file or a group of files 
on the Macintosh. You can run the Tagger program from the master distribution disk or 
you can copy Tagger to your Macintosh hard disk and run it from there. 
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Note: If you're converting files from a PC-based format to the Macintosh Standard for- 
mat, you'll need to use the Tagger program. This program is not included with the Star 
Exchange disks. To order your free copy of the Tagger program, call WordStar 
Customer Support. 

The example below shows the various parts of the Tagger. 

directories document type 
I I 

Tagger = 

0 Contracts + 
piizKT-1 

I I O Proposals 

ta&ed files 

The left side of the Tagger looks very much like the standard Open File dialog box used 
in almost every Macintosh application. The difference between the Tagger and other 
Macintosh software is  that the folders and files in the Tagger are listed separately. 

The right side of the Tagger has a pop-up menu for selecting the creator/type that will 
be attached to the selected files and a Tag button that attaches those files to the 
selected creatorltype. 

To use the Tagger, follow the steps below. 

C A U T I 0 N Be sure you select only the documents you have converted with Star 
Exchange and transferred to your Macintosh. Tagging files produced in other applica- 
tions will not be recognized by their original application. The best way to guarantee 
that no other files are tagged is to transfer all new files to an empty folder. 
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To tag files: 

1 Select the disk and folder where your converted document(s) i s  located. 

2 Select the word processor format the document(s) was converted to. 

3 Select the document from the list of filenames. (To select more than one document 
at a time, hold down the Shift key while you click the filenames.) 

4 Choose the Tag button. 

5 Exit the Tagger. 

The documents you tagged have the correct icon and are ready to use with the 
Macintosh word processor. 

Remember--use the Tagger only for files that were converted to Standard format. Files 
converted to MacBinary format, and transferred to the Macintosh using a MacBinary 
transfer, have already been tagged. 

If a conversion produces a MacBinary document, and the document is transferred to the 
Macintosh without using a MacBinary transfer, the document will not be recognized by 
the Macintosh word processor for which it was created. 

Only the receiving Macintosh needs to understand MacBinary. MacBinary i s  imple- 
mented on top of other transfer protocols such as XMODEM, and the PC communica- 
tions software does not have to understand anything about MacBinary. 

C A U T I 0 N The current version of the Tagger does not allow you to undo mistakes. 

Transferring Macintosh Files to the PC for Conversion 
Macintosh conversions can identify and convert files that are in MacBinary format or 
that are binary images of the Macintosh file's Data Fork. This process is not noticeable 
to the user and does not depend on the Output File Type parameter setting. Almost all 
transfers from a Macintosh to a PC will result in one of these two formats (MacBinary or 
Standard). 



Error Messages 
This chapter lists error messages that may appear on your screen in Star Exchange. 

Access Denied: This file cannot be opened for viewing 
You have tried to view a file that is locked by another application. This could be 
the file loaded in another program, or a file that is locked out on a network. You 
would see this message if another network user has loaded the file you want to 
view. 

Application load failure-EXE corrupted 
One or more of the program files required by Star Exchange has been damaged or 
did not copy correctly during installation. Start WINSTALL and choose Add or 
Remove a Feature. Reinstall the conversion format with the damaged file. 

Application load failure-EXE not found 
A Star Exchange conversion file is missing. Start WINSTALL and choose Add or 
Remove a Feature. Add the conversion format that you want. 

Application load failure-Insufficient memory 
You may not have enough memory (a minimum of 384K RAM is  required). If 
you're using another memory-resident program such as SideKick or Inseta, remove 
it from memory and try the conversion again. 

Command file processing error 
Star Exchange cannot use the work area. In the System Parameters option, check to 
see if the drive letter (including the colon) and the directory are correct. Be sure the 
disk has enough room (about 11/2 times the size of the largest document) for the 
work area. 
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Disk read error 
Star Exchange cannot read the source document. There may be an error on the disk 
containing the document. Move the file to another part of the disk. 

Disk write error 
Star Exchange cannot complete the conversion and write an output file because 
there is not enough room on the disk to write the file. Delete any files you don't 
need, and repeat the conversion. 

lnput file open failure 
Star Exchange can't find the document listed in the lnput Queue. Be sure the 
document name in the queue is correct. Delete the name from the queue, and 
use the Automatic Directory Assistance document queuing method to resubmit 
it for conversion. 

The path information may not be correct-check to see if it is. 

Too many files may be open. Be sure the FILES=30 statement is in your 
CONFIG.SYS file. 

Insufficient memory for conversion 
Your system does not have enough memory to execute the conversion (a minimum 
of 384K RAM is required). To correct the problem, add more memory to your 
system. 

Invalid input file 
Star Exchange can't translate a document because it wasn't created on the 
source application for the lnput Queue being converted. Convert the failed 
document in another session, using the correct source application. 

The document you're trying to convert has a format that is not supported by Star 
Exchange. 

Star Exchange can't read the source document. Using the source application, 
edit the source document for discrepancies; for example, maybe the document 
wasn't saved correctly. 

RTLlNK failure-RTLINKST.COM not found 
The RTLINKST.COM file is damaged or missing. Use COPYWS to copy the file 
from the original compressed disk to the WS\CONVERT directory. Then rerun Star 
Exchange. For instructions on how to use COPYWS, see the Installing and 
Customizing booklet. 
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RTLINK failure-General RTLINK failure 
One or more of the RTLINK files has been damaged or deleted. Use COPYWS to 
copy the RTLINKST.COM file and the S C C ? ? . R T L  file from the original com- 
pressed disk to the WSKONVERT directory. Then rerun Star Exchange. For 
instructions on how to use COPYWS, see the lnstalling and Customizing booklet. 

RTLINK failure-SCC- ??. RTL not found 
The SCC-??.RTL file cannot be found. Use COPYWS to copy the file from the 
original compressed disk to the WS\CONVERT directory. Then rerun Star 
Exchange. For instructions on how to use COPYWS, see the Installing and 
Customizing booklet. 

Run-Time Error R6001, Null Pointer Assignment 
You may have selected the wrong conversion format for the document you're trying 
to convert. For example, if you select WordPerfect 5.0 from the Conversions Menu 
and then try to convert a WordPerfect 4.2 document, you may get this error mes- 
sage. If you do, make sure you selected the correct format for the document you're 
trying to convert. If the format i s  correct, go back to your source application and 
edit the source document-scroll to the end of the document and then save it. 
Then try using Star Exchange again to convert the document. 

Unable to create output file 
Star Exchange can't create a file for a converted document or for a work area 

Be sure the disk has enough room (about 1 1 / 2  times the size of the largest docu- 
ment) for the work area. 

Be sure the FILES=30 statement is in your CONFIG.SYS file. 

Be sure you provided a valid DOS filename for the translated document, includ- 
ing the correct drive letter, a colon, and (if needed) a directory path. 

m If you're using the Prompt User for Filename method for naming files, be sure to 
include any required drive letter and directory path. If you want documents 
named automatically, use the System Parameters option to change the filenam- 
ing method to Default Title. 

Using the System Parameters option, check to see if the drive letter (including 
the colon) and the directory or RAM disk are correct. 

Unable to load application definition files 
One or more of the definition (.DEF) files has been deleted from the WS\CONVERT 
directory. Use COPYWS to copy the .DEF files you need from the original com- 
pressed disk to the WS\CONVERT directory. Then rerun Star Exchange. For 
instructions on how to use COPYWS, see the Installing and Customizing booklet. 
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Unable to read source document 
Press Esc to abort the conversion. Return to DOS. Type type file.log on the 
command line and press J. The FILE.LOG file is displayed; it contains a mes- 
sage giving you the probable cause of the error. 

Star Exchange can't read the source document. Using the source application, 
edit the source document for discrepancies; possibly the document wasn't saved 
correctly. 
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Supported 
Applications 

The applications listed below are supported by Star Exchange. 

WORD PROCESSORS 

PC-Based Format 

DEC WPS PLUS (DX) 
Displaywrite 2, 3, 4, 5 
First Choice 
IBM Writing Assistant 
MASS-1 1 
Microsoft Word 
MultiMate 
MultiMate Advantage 
MultiMate Advantage 2 
Nota Bene 
PFS:Write 
Professional Write 
Samna Word 
Smartware I1 
Volkswriter 3, 4 
Wang PC (IWP) 
WordMARC Composer 
Wordperfect 
WordStar 
WordStar 2000 
XyWrite 

Version/Release 

3.0 and earlier 
All 
3.0 and earlier 
1.01 
8.0 and earlier 
4.0 through 5.5 
3.6 and 4.0 
All 
All 
3.0 
A, 6, and C 
2.2 and earlier 
IV Plus and earlier 
1.5 and earlier 
All 
2.6 and earlier 
Plus and earlier 
5.1 and earlier 
7.0 and earlier 
3.5 and earlier 
Ill+ and earlier 
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Macintosh-Based Format Version/Release 

Microsoft Word 
Word Perfect 
MacWrite II 

Other Formats 

ASCll 
Intelligent ASCll 
DCNFFT 
DCNRFT 
Navy DIF 
Microsoft RTF 

SPREADSHEETS 
Application 

Enable 
First Choice 
Framework 
Lotus 1-2-3 
Lotus Symphony 
Microsoft Excel 
Microsoft Works 
Mosaic Twin 
PFS: Professional Plan 
Quattro 
SuperCalc 5 
SmartWare II 
VP Planner 3D 

D A  TA BASES 
Application 

dBASE 
Data Ease 
dBXL 
Enable 
First Choice 
FoxBase 
Framework 
Microsoft Works 
Paradox 
Q & A  
R:Base 
Reflex 
SmartWare II 

4.0 
2.0 and earlier 
1 .I 

Version/Release 

N/A 
N/A 
A1 1 
All 
All 
1.0 and earlier 

3.0 
3.0 and earlier 
Ill and earlier 
3.0 and earlier 
2.0 and earlier 
2.0 through 3.0 
2.0 
2.5 
1 .o 
PRO and earlier 
A1 1 
1.5 
1 .o 

IV and earlier 
4.0 
1.3 
3.0 
3.0 and earlier 
2.1 
I l l  
2 .o 
2.0 through 3.5 
3.0 
3.1 and earlier, System V, Personal 
2.0 and earlier 
1.02 through 1.5 

Note: If you want to convert dBXL or FoxBase files, select dBASE as the conversion 
application to represent these files. 
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Apple File Exchange (AFE), SE-34 
Apple Superdrive, SE-34 
applications supported, SE-4, SE-43 to SE-44 

word processing features, SE-33 
arrow key 

as Search prompt, SE-27 
for selecting row, record, or data block, 

SE-28 to SE-29 
ASCII codes, for replacement characters, SE-13 
ASCII files, SE-4 

Auto Translate and, SE-22 
automatic translation feature, SE-4 
Auto Translate option (Conversions Menu), SE-6, 

SE-21 to SE-22 

bottom margin, for spreadsheet, SE-11 
brackets, directory shown in, SE-24 

case sensitivity, in searches, SE-27 
character filter file, SE-9 

creating or editing, SE-14 to SE-15 
specifying, SE-10 

choosing an application, SE-8 to SE-9 
columns (spreadsheet) 

checking appearance of, SE-32 
noncontiguous, SE-29 to SE-31 
selecting for conversion, SE-28 to SE-31 

.COM files, Document Viewing Window and, 
SE-25 

Conversion AKonversion B parameters, SE-5, 
SE-8 to SE-9 

File Naming Method, SE-12 
Input File Type, SE-14 
Output Directory, SE-11 
Replacement Character, SE-13 
setting from Conversions Menu (F3/F4), 

SE-9, SE-11 to SE-14 
setting from Main Menu, SE-6 
User Defined Extension, SE-13 
User Defined Filename, SE-12 to SE-13 

Conversions Menu 
Auto Translate option, SE-21 to SE-22 
Conversion A/Conversion B Parameters 

(F3/F4), SE-9, SE-11 to SE-14 
Edit Character Filter (F5), SE-9, SE-14 to 

SE-15 
Edit Typestyle Filter (F6), SE-9, SE-15 to 

SE-16 
System Parameters (F2), SE-9, SE-10 to 

SE-11 
converting documents 

editing after, SE-32 to SE-33 
to Macintosh format, SE-33 to SE-37 
preparing for, SE-7 to SE-22 
quick steps for, SE-6 
starting process, SE-6, SE-22 to SE-23 

database applications supported, SE-44 
database file 

conversion parameters for, SE-14 
conversion process for, SE-28 to SE-31 
converting, SE-14 
system parameters for, SE-11 



Data Fork, SE-35 
default parameters, changing, SE-9 to SE-16 
deleting documents from queue, SE-20 to SE-21 
deleting queue, SE-20 to SE-21 
directory 

changing, SE-24 
output, SE-11 
queuing documents from. See lnput Queue 
specifying, SE-24 
system work area, SE-10 

Directory Assistance keys, SE-32 
Directory Assistance screen, SE-19 to SE-20 

parts of, SE-23 to SE-24. See also specific 
parts by name 

with spreadsheet, SE-28 
using, SE-23 to SE-28 

Directory Edit Window, SE-23 
Directory Assistance keys for, SE-32 
using, SE-24 

Directory Information Line, SE-23 
Displaywrite, editing documents from, SE-33 
Document Viewing Window, SE-23 

Directory Assistance keys for, SE-32 
enlarging, SE-26 
searching for text in, SE-27 to SE-28 
using, SE-25 to SE-28 

DOS, returning to, SE-8 
DOS Mounter, SE-34 
DOS wild-card characters 

in Directory Edit window, SE-24 
in lnput Queue, SE-19 

drive, specifying, SE-24 

Edit Character Filter (Conversions Menu F5), 
SE-9, SE-14 to SE-15 

Edit Typestyle Filter (Conversions Menu F6), 
SE-9, SE-15 to SE-16 

end a session, SE-7, SE-22. See also exit 
Enter key (change directory), in File List 

Window, SE-32 
erasing documents or queue, SE-20 to SE-21 
error messages, SE-39 to SE-42 
.EXE files, Document Viewing Window and. 

SE-25 
exit 

help screen, SE-8 
Star Exchange, SE-8 
See also end a session 

F1 (display help screen), SE-8, SE-32 
F2 (from Conversions Menu), for setting system 

parameters, SE-9, SE-10 to SE-11 
F2 (from lnput Queue screens), for choosing 

document from directory, SE-6 
F2 (from Zoom mode), for File List Window 

SE-26, SE-32 
F3 (select row or record), SE-28, SE-32 
"F3 (select Horizontal Range), SE-31, SE-32 
F3/F4 (from Conversions Menu), for conversion 

parameters, SE-9, SE-11 to SE-14 



F4 (select block of data), SE-29, SE-32 
"F4 (select Vertical Range), SE-31, SE-32 
F5 (from Conversions Menu), for editing 

character filter, SE-9, SE-14 to SE-15 
F6 (from Conversions Menu), for editing 

typestyle filter, SE-9, SE-15 to SE-16 
F7 (cancel file selections), SE-32 
F8 (Directory Edit Window), SE-32 
F9 (find keyword or text string), SE-32 
"F9 (find next search string), SE-27, SE-32 
F10 (add document to lnput Queue), SE-32 
F10 (start conversion), SE-6, SE-22 to SE-23 
File lnformation Line, SE-23, SE-25 
File List Window, SE-23 

Directory Assistance keys for, SE-32 
displaying file contents from, SE-25 to SE-28 
using, 24 to SE-25 

filename extensions 
specifying, SE-12 
user-defined, SE-13 

filenames 
list of, SE-24 
numbers in, SE-13 
specifying, SE-24 
specifying method for, SE-12 
user-defined, SE-12 to SE-13 

files 
converting, SE-6, SE-22 to SE-23 
converting to Macintosh format, SE-33 to 

SE-37 
editing after conversion, SE-32 to SE-33 
format identification for, SE-25 
viewing contents of, SE-25 to SE-28 
zooming in on, SE-26 

Filter Table, SE-14 
finding text in file, SE-27 to SE-28 

font filter. See typestyle filter 
formats 

on File lnformation Line, SE-25 
supported applications, SE-4, SE-43 to SE-44 
supported features, SE-33 

H 

help, onscreen (F1 ), SE-8, SE-32 
Hex-ASCII codes, for replacement characters, 

SE-13 
horizontal range, selecting, SE-29, SE-31 

-- 

Input Queue, SE-6, SE-7, SE-17 to SE-20 
Automatic Directory Assistance for, SE-19 

to SE-20 
Auto Translate option and, SE-17, SE-22 
deleting, SE-20 to SE-21 
deleting documents from, SE-20 to SE-21 
specifying files for, SE-6, SE-24 to SE-25 
typing manual entries in, SE-18 to SE-19 

lnput Queue screen, SE-17 
installing Star Exchange, SE-5 
interrupting conversion, SE-22 

Keyboard Type (System Setup Menu), SE-10 
key word, searching for, SE-27 



INDEX 

MacBinary format, SE-34, SE-35, SE-37 
tagging and, SE-37 

Macintosh computers 
converting from format for, SE-37 
converting to format for, SE-33 to SE-37 
direct transfers with, SE-34 to SE-35 
file types for, SE-34, SE-35 

Macintosh Tagger 
obtaining, SE-36 
role of, SE-33, SE-35 to SE-36 
using, SE-36 to SE-37 

Main Menu, SE-7 to SE-8 
quick conversion using, SE-6 

margins, spreadsheet, SE-11 
Message Line, SE-23 
minus (-) key (view previous file in list), SE-26, 

SE-32 
MultiMate 

editing documents from, SE-33 
filename extensions for, SE-13 

naming converted files, SE-12 to SE-13 

0 

onscreen help (FI), SE-8, SE-32 
Options window (Input Queue), SE-21 
output directory, specifying, SE-11 
Output File Type, for Macintosh format, SE-34 

PgUpIPgDn keys (in Search window), case 
sensitivity and, SE-27 

plus (+) key (view next file in list), SE-26, SE-32 

Q 
queuing documents for translation, SE-6, SE-17 

to SE-20 
quick conversion method, SE-6 
quitting Star Exchange, SE-8 
quit. See exit 

ranges, selecting, SE-29 to SE-31 
records, selecting, SE-28 to SE-31 
replacement characters 

creating or editing file of, SE-14 to SE-15 
for nontranslatable characters, specifying, 

SE-13 
scanning document for, SE-32 

Resource Fork, SE-35 
rows (spreadsheet), selecting for conversion, 

SE-28 to SE-31 
in blocks, SE-29 
noncontiguous, SE-29 to SE-31 

searching through files, SE-27 to SE-28 
Search window, SE-27 
selecting an application, SE-8 to SE-9 



INDEX 

selecting files for conversion, SE-6, SE-24 to 
SE-25 

spreadsheet 
applications supported, SE-44 
conversion process for, SE-28 to SE-31 
system parameters for, SE-11 

Spreadsheet Bottom Margin (System Setup 
Menu), SE-11 

Spreadsheet Delimiter (System Setup Menu), 
SE-11 

Spreadsheet Top Margin (System Setup Menu), 
SE-11 

Standard format, for Macintosh, SE-34, SE-35 
starting conversion process, SE-22 to SE-23 
starting Star Exchange, SE-6, SE-7 
subdirectories 

displaying information for, SE-25 
list of, in the File List Window, SE-24 
selecting files from, SE-25 

supported applications, SE-4, SE-43 to SE-44 
System Parameters (Conversions Menu F2), SE-9 

setting, SE-10 to SE-1 1 
setting for Macintosh, SE-34 to SE-35 

system prompt, starting Star Exchange from, 
SE-6, SE-7 

System Setup (Main Menu option), SE-6, SE-8 to 
SE-9 

for Macintosh format, SE-34 to SE-35 
System Setup Menu, SE-10 
System Work Area Directory, SE-10 

Tab key 
for Document Viewing Window, SE-25 
for File List Window, SE-26, SE-28 

tagging Macintosh files, SE-33, SE-34, SE-35 to 
SE-37 

text string, searching for, SE-27 to SE-28 
top margin, for spreadsheet, SE-11 
translated documents, editing, SE-32 to SE-33 
typestyle filter, SE-9 

creating or editing, SE-15 to SE-16 
Typestyle Filter Menu, SE-16 

unknown documents in Auto Translate, SE-22 
user-defined extensions, SE-13 
user-defined filenames, SE-12 to SE-13 

v 
vertical range, selecting, SE-30, SE-31 
viewing file contents, SE-25 to SE-28 

Wang PC, filename extensions for, SE-13 
wild-card characters 

in Directory Edit window, SE-24 
in Input Queue, SE-19 

WINSTALL, installing Star Exchange with, SE-5 
Word Perfect 

Auto Translate and, SE-22 
typestyle filter and, SE-15 

word processing features, SE-33 
word processor support, SE-43 to SE-44 
WordStar, starting Star Exchange from, SE-6, SE-7 
WordStar 3 . 3 ~  files, Auto Translate and, SE-22 



WordStar 2000, typestyle filter and, SE-15 
word wrap 

column indentations and, SE-32 
searching and, SE-28 

work area, setting directory for, SE-10 

Zoom mode, SE-26 
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Introduction 
TelMerge makes electronic communications easy by enabling your computer to com- 
municate with computers all around the world. You can use TelMerge to 

Send and receive electronic mail ("Email") 

Check the progress of stocks and bonds with online communications services like 
the MCI Dow Jones service 

m Set up a data collection terminal for salespeople in the field 

m Do computer work at home using dial-up lines to a mainframe 

m Exchange messages and files with other personal computer users 

The TelMerge documentation is  organized as follows: 

"Getting Ready to Use TelMerge" explains how to prepare your equipment for 
TelMerge. 

"Calling a Service with TelMerge" and "Sending and Receiving Electronic Mail" illustrate 
the most common data communications tasks with basic exercises. 

"Talking to Other Computers" shows how to transfer data files in different ways. 

"Shortcuts with TelMergel' contains tips to speed up and customize the program. 

There are also sections listing the TelMerge keywords (special commands), 
preprogrammed communications services, and function key assignments. If you have a 
problem using TelMerge, see the "Troubleshooting" chapter. 



Getting Ready to 
Use TelMerge 
What You Need 

To run TelMerge, you must have the following: 

An IBM PC or an IBM-compatible system with at least 128K of internal memory and 
90K of available disk space 

A private telephone line with a plug-in connector (RJI 1 C jack) 

An asynchronous communications card (if you don't have an internal modem) 

A Hayes-compatible modem 

TelMerge may not work if you have any of the following: 

A multiline or "hold button" phone system 

A printer and modem on the same port 

m A "call waiting" feature on your phone 

RAM-resident programs running concurrently with TelMerge 

Note: In some areas you can turn call waiting off for the duration of a phone call. Call 
the local business office of your telephone company for details. 



/nstalling TelMerge . 
If you didn't copy TelMerge when you installed Wordstarm, do that now. See the 
Installing and Customizing booklet for information on adding a feature. 

Setting Up Your Modem 
TelMerge is  set up to work with the default switch settings on a Hayes modem. (These 
are the switch settings set by the factory.) Unless your modem has different factory 
defaults, you don't need to change any switches. 

Hayes 300 and 7200 
Hayes 300 and 1200 modems are freestanding and require a serial port and a serial 
cable from your computer. To use these modems without a serial port, you must buy 
an asynchronous communications adapter card (an "async card"). Follow the directions 
in the Hayes manual to connect the modem. 

Hayes 300 and 1200 Switch Settings 
The Hayes 300 and 1200 modems have a row of switches, found behind the front 
panel, that have the following settings: 

SWITCH 
NUMBER SElTlNG SWITCH FUNCTION 

Down 
UP 

Down 
UP 
Down 
Down 
u P 
Down 

TelMerge ignores the Data Terminal Ready (DTR) signal 
Puts result codes (CONNECT, RING, etc.) into English 
words. . . 
. . . and sends them to your computer 
Shows modem commands onscreen while dialing 
Modem doesn't answer incoming calls automatically 
TelMerge ignores the carrier 
Sets modem for single-line phone 
Enables modem command recognition 
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Hayes 12009 Switch Settings 

The Hayes 12008 i s  an internal modem that plugs into one of your computer's short 
slots. The 1200B has a row of switches near the top of the card that are set as follows: 

SWITCH SWITCH 
NUMBER SETTING FUNCTION 

1 O n  Selects the communications port [ON = port COM1, 
OFF = port COM21 

2 Off Sets modem for single-line phone 
3 Off TelMerge ignores the carrier 

If You Have a Phone System with Built-in Modems 
Many offices install phones that contain modems so you can use the same telephone 
line for both voice and data. If you have such a system-and it has a Hayes- 
compatible mode-you can use TelMerge with it, but it may require special initializa- 
tion (see PREMODEM in the "Keywords" chapter for more information). 



Calling a Service 
with TelMerge 
Registering with a Communications Service 

You get information for TelMerge from services and networks. The leading services and 
their phone numbers are listed in the "Communications Services" chapter. To register 
with a service, call the one you want directly, or ask your local computer store. Either 
way, when you register with a service, you receive a subscriber package with informa- 
tion for TelMerge. 

H o w  to Use TelMerge 

There are two ways to call a service with TelMerge: 

You can create individual service files that each contain the information necessary 
to call one service. If you subscribe to only one or two services, this is the easiest 
way to use TelMerge. 

You can set up the TELMERGE.SYS control file with the information for several ser- 
vices. Then, when you run TelMerge, you can call any service by choosing it from 
the TelMerge Communications Menu. If you subscribe to a number of services, this 
method is  more efficient in the long run. 

Both methods are described on the pages that follow. Be sure to have your subscriber 
packages handy. 
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Creating Individual Service Files 
You can create a file for each communications service you want to call. 

I Start TelMerge. Either pull down the Additional Menu at the Opening screen and 
choose TelMerge, or, if you're using classic menus, press A at the Opening Menu, 
then press T for TelMerge. 

Note: If you want to run TelMerge as a stand-alone program, log on to the directory 
containing the TelMerge files, type telmerge, and press J. 

You see the TelMerge Communications Menu. 

2 Press F5 (Other) at the TelMerge Communications Menu. Any files in the current 
directory with the extension .TEL are displayed. You can choose an existing .TEL 
file or create a new one. 

3 To create a new one, press J. TelMerge asks you for the name of the service to 
call, your user ID and password, and the service's phone number. This information 
is contained in your subscriber package. 

4 TelMerge also asks for information about your system, like your baud rate, and so 
on. In most cases, you can use the default settings, which are: 

Modem HAYES specifies that you are connected to a modem. If you are cabled 
directly to another computer, replace HAYES with the appropriate description. See 
MODEM in the "Keywords" chapter. 

Port C O M l  means that TelMerge expects to find a modem connected to the C O M l  
port on your computer. If you are using a different serial port for your modem, type 
the correct port number here. 

Baud 2400 means that you wil l  be transmitting and receiving at 2400 bits per 
second-about 2400 words per minute. You can change to any baud rate that your 
modem allows. The correct setting for this keyword may vary for different services. 
Some telexes, for instance, use baud 300. 

Duplex Full means that the remote computer wil l  "echo" your typing back to you. 
That way, you can be sure it received what you sent. Some services require half 
duplex-check your subscriber package. 

Press J to accept the default answer for the current question and go to the next 
one. If you press Esc after giving the phone number, default answers are used for 
all the remaining questions. 

5 Your answers to these prompts are stored in a new file (in the current directory) 
with the extension .TEL. You can use it again by pressing F5 (Other) at the 
TelMerge Communications Menu and then choosing it. 

If you need to change a .TEL file later, edit it as you would any nondocument file. You 
can add any additional keyword commands you like. See the "Keywords" chapter for 
more information. 
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Using the TELMERGE.SYS Control File 
If you subscribe to a number of services, you can store the information for every service 
in one file, which is called a control file. This file (TELMERGESYS) is already provided 
for you. All you need to do is fill in the necessary information. TELMERGESYS is 
usually stored in the WS directory. 

The TELMERGESYS file contains the TelMerge menu. Below the menu is  a series of 
"scripts" containing information for each service. If you are calling a service that i s  
preprogrammed into TELMERGE.SYS, all you add are the phone number of the service, 
your user ID, and your password. 

Once you add the necessary information to the control file, connecting to a service is  
simple. You start TelMerge and type the name of the service you want to call when 
TelMerge asks for it. TelMerge consults the script for that service for the information it 
needs to make the connection and to log you on. 

Note: If you're running TelMerge as a stand-alone program, the TELMERGE.SYS file 
must be in the current directory or in a directory on your DOS path. To specify a .SYS 
file to use, other than TELMERGE.SYS, type telrnerge fi1enarne.s~~ at the command line. 

Adding information to TELM ERGE.SYS 
1 Start Wordstar and edit the TELMERGESYS file in nondocument mode. 

2 Press the PgDn key until you see the "System Section." 

; System Section 
- * * * * * * * * * * * * * * * * *  

;The following keywords set the basic defaults for your system. 
;The current settings work for most systems. If the setting for 
;any keyword here doesn't match your system's requirements, replace 
;it with one of the other choices listed for that keyword. 

;Specify the settings that you will use most of the time. If a 
;particular service requires different settings, specify them 
;in that service's script. Settings in a script override settings 
;in the System Section. 

Each entry listed in this part of the file is a keyword that tells TelMerge how to work 
with your system. The default values for these keywords work in most cases. 
However, check the MODEM, PORT, and BAUD keywords now to make sure they are 
set up correctly for your system. See the "Keywords" chapter for a full description of 
these keywords. 
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Adding Information about a Service 
Once you receive your subscriber package from a service (CompuServe is used in the 
example below), you enter information into TELMERGE.SYS. 

1 Each preprogrammed service has its own script with the information TelMerge 
needs to place a call. Press the PgDn key a few times until you see the 
CompuServe script, which starts with LABEL CIS. LABEL CIS tells TelMerge to use 
this script when you specify CIS as the name of the service to call. 

The SERVICE CIS tag tells TelMerge what technical information to send to the ser- 
vice. This information is already programmed into TelMerge. 

Fill in the next three lines using the information you received from the communica- 
tions service. 

2 Put the cursor after the word NUMBER, press the Tab key twice, and type the 
telephone number of the service. Type 9 or 1 before the number if your telephone 
system requires it. You can also include the code to turn call waiting off if you 
need to. 

Note: When you use 9 to get an outside line, type one or two commas after it. 
Each comma makes the modem wait about two seconds so the second dial tone has 
time to sound before the modem dials the rest of the phone number. 

3 Put the cursor after the keyword USERID, press the Tab key twice, and type your 
user ID. 

4 Put the cursor after the keyword PASSWORD, press the Tab key twice, and type 
your personal password. The rest of the CompuServe script i s  already filled in for 
you. 

LOGFILE CIS.LOG means that if LOGGING is ON, the record of your CompuServe 
session is saved to a file called CIS.LOG. See "Logfiles" in "Sending and Receiving 
Electronic Mail." 

END tells TelMerge that it has come to the end of the script for CompuServe. Once 
you finish a CompuServe session, TelMerge returns you to the TelMerge Communi- 
cations Menu. 

Note: Printing is  off when you start to use CompuServe even if you changed PRINT 
to YES. You must press F8 to turn printing on. 

5 Save the file. 
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Calling a Service through a Network 

Many people use commercial data networks to contact databases and services. To call 
a service through a commercial data network, add the name of the network, change the 
phone number in the service script, and add the HOSTID code provided by the net- 
work. This example shows the proper entries. 

Labe l  MC I 
S e r v i c e  MC I 
Network Tymnet 
H o s t i d  MCIMAIL 
Number 9,453-5420 
U s e r i d  
Password 
Logf i l e  MCI .LOG 
End 

Adding a New Service to TELMERGE.SYS 
The procedure for adding a new service (one that isn't preprogrammed) to TelMerge is 
the same as the one discussed in the previous section, with two exceptions: 

You add the service name to the TelMerge Communications Menu. 

You create a new script in TELMERGE.SYS for the new service. 

To add a new service to TELMERGE.SYS, follow these instructions: 

1 Use WordStar to edit the TELMERGE.SYS file in nondocument mode. 

2 Move the cursor to the Menu section in the file, which contains a series of SAY 
statements. Mark the line containing NEW as a block. Press J to create a blank 
line and copy the block. 

3 Replace NEW with the name of your service, and delete the semicolon from the 
beginning of the line. 

4 Move down to the Service section and mark the text from LABEL NEW through the 
next END statement as a block. Move the cursor down one line and copy the 
block. 

Now customize the information in the copied section for your new service: 

1 Replace NEW with the name of the new service. This name must match the name 
you typed on the Menu. 

2 Add the phone number, your user ID, and your password. 

3 Change any other data that you want to modify. 

4 Quit and save the file. 
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Note: If you want the menu entries you add to be highlighted when you run TelMerge, 
type a vertical bar (I) before and after the service label. 

Adding a Telex Service 
You can add any telex service the same way you add other new services, but with these 
additions: 

1 On the line above the phone number, type INTERACTIVE, press the Tab key twice, 
and type the phone number of the interactive (real-time) telex service. The service 
supplies you with this number. 

2 O n  the line below the interactive number, type ANSWERBACK, press the Tab key 
twice, and type the answerback name for that service. The service gives you this 
name when you sign up. 

Add the INTERACTIVE and ANSWERBACK responses only if your service provides telex 
communications. See INTERACTIVE and ANSWERBACK in the "Keywords" chapter. 



Sending and Receiving 
Electronic Mail 
Preparing Messages for Electronic Mail 

Most communications services allow you to compose messages online, but you are 
charged for the time you are connected to the service. It is less expensive to type your 
messages first, using Wordstar. Then, when the service prompts you for your message, 
press the SEND function key and specify the file containing your message. Your mes- 
sage is sent to the service. 

A document file won't always print properly when it's received by the service. For this 
reason, TelMerge strips most of the print control commands from a file before transmit- 
ting it. Tabs, indents, margins, and centering are maintained, though spacing may 
change slightly. Boldfacing, underlining, and other print features are removed. You 
can control a file more closely by printing it to disk and then sending the disk file. To 
send a document that contains footnotes, endnotes, line numbers, or paragraph num- 
bers, print the document to disk in ASCII format and then send the ASCII file. 

sending Electronic Mail 
There are several ways to send electronic mail: 

You can send an electronic letter to someone if you both have an account with the 
same service. You deposit the letter in your correspondent's electronic mailbox. 

w You can send a paper letter. In this case, you still send the letter electronically, but 
the service prints and delivers it. This may cost more than regular mail, but i t  can 
be much faster. 
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If your correspondent has a telex machine, you can direct the letter to the telex net- 
work. In this case, your mail is printed on your correspondent's telex machine. 

Examples of each of these methods follow. Each example shows the use of a particular 
c~mmunications service. Many services offer all of the methods and not just the 
method shown in the example. 

Sending an Electronic Letter 
E X A M P L E  

To send an electronic letter using CompuServe, follow these steps: 

1 Write the letter with WordStar and save the file. 

2 Start TelMerge. 

3 Type CIS (for CompuServe) and press J. TelMerge dials CompuServe. 

As TelMerge dials, it counts the seconds it takes to reach that service. At 45 
seconds, TelMerge redials the number. After dialing twice, TelMerge gives up. You 
can change the number of times TelMerge dials with the TRY keyword. See the 
"Keywords" chapter. 

Note: If TelMerge does not find a phone number for a service you specify, it 
prompts you for that information. At each prompt, type the required information 
and press J. TelMerge saves the information in a file that you name and calls the 
service. TelMerge gives the file a .TEL extension and stores it in the \WS directory. 
If you call that service again, press F5 at the TelMerge Communications Menu and 
type the .TEL filename. TelMerge calls the service for you. 

4 When CompuServe answers, TelMerge automatically issues your password and 
identification number and logs you on. You are now at the CompuServe Main 
Menu. 

From the CompuServe Main Menu, go to the Email Menu (see your CompuServe 
manual). From the Email Menu, enter the CompuServe editing workplace. 

5 When you are online in TelMerge, you have two sets of function keys to use. The 
"TelMerge Function Keys" chapter explains each one and how they are used. 

Press the F2 function key to see function key set 2 (if it i s  not already displayed). 
Then press F4 to send a file. When prompted, type the full pathname of the file that 
contains your letter and press J. TelMerge transmits your file to CompuServe. 

6 Follow the CompuServe instructions to close and send the letter. 

7 Exit the Email Menu, then exit CompuServe. 

8 Press F10 to hang up. Press F10 again to exit TelMerge and return to WordStar. 
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Sending an Electronic Paper Letter 
E X A M P L E  

To send an electronic paper letter using MCI Mail, follow these steps: 

1 Write the letter with WordStar and save the file. 

2 Start TelMerge. 

3 Type MCI and press J. TelMerge dials the number of MCI Mail and logs you on. 
You are now at the MCI Mail Main Menu. 

See your MCI Mail manual (or follow onscreen instructions) to reach the MCI Mail 
editing workplace. Type the name and address of your correspondent. MCI Mail 
prompts you for the letter. 

4 Press F4 of function key set 2 to send a file. Type the full pathname of the file con- 
taining your letter and press J. TelMerge sends your file. 

5 When you are prompted for the end-of-text marker, type a forward slash (n and 
press J. 

6 Select the menu choice that sends your letter. MCI acknowledges receipt of your 
letter. The letter will be laser-printed and delivered to your correspondent. 

7 At the MCI Mail prompt, type exit to disconnect from MCI. 

8 Press F10 to hang up. Press F10 again to exit TelMerge and return to WordStar. 

Sending a Telex 
E X A M P L E  

Following is  a sample telex document. This format is prescribed by ITT. For variations 
of this telex format, see instructions from your service. 

TO: 
Barbara Jones  
FROM : 
Andy Smith 
DT: 
11/21/88 

G r e e t i n g s  from t h e  F a l l  Cookware Show! We have j u s t  u n v e i l e d  
o u r  new food p r o c e s s o r .  Along wi th  i t s  many powerful  f e a t u r e s ,  
t h i s  machine kneads dough, g r i n d s  meat, and p u r e e s  v e g e t a b l e s .  
To s e e  a l l  o f  t h e  new f e a t u r e s  o f  t h i s  s t a t e - o f - t h e - a r t  
p roduc t ,  you must t r y  it f o r  y o u r s e l f .  

NNNN 
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In telex messages you put the addressee's number in the top left corner of the docu- 
ment. End-of-document and disconnect signals come at the end. You then use 
TelMerge to send the document to the telex service. 

There are two ways to send a telex document: store-and-forward mode and interactive 
mode. 

When you use store-and-forward mode, you communicate with an intermediate com- 
puter system. Your letter is stored temporarily and transmitted later to its destination. 

When you communicate in interactive mode, you are connected to your 
correspondent's individual telex machine, which prints each character as you send it. 
There is no intermediate computer system. 

Using Store-and-Forward Mode 

E X A M P L E  

To send a telex using ITT TIMETRAN, follow these steps: 

1 Write the letter with WordStar and save the file. 

2 Start TelMerge. 

3 Type ITT and press J. You see the prompt What file do you want to send? 

4 Type the full pathname of the file that contains your letter and press J. 

5 If there is  an INTERACTIVE number in your control file script, you see the prompt 
Want to access interactive mode? Y/N. Type N for no. 

ITT displays your account number, password, and destination account number, 
then transmits the file. You receive verification-"CALL ACCEPTED." If you have 
messages in your mailbox, ITT says "MESSAGES WAITING." 

6 Press the SEND function key (F4 of function key set 2) to see your messages. ITT 
displays all of your messages. When it has finished, it displays "END OF 
TRANSMISSION." 

7 Press F10 to hang up. Press F10 again to exit TelMerge and return to WordStar. 

Using Interactive Mode 

E X A M P L E  

To send a telex using ITT telex, follow these steps: 

7 Write the letter with WordStar and save the file. 

2 Start TelMerge. 

3 Type l l ' l  and press J. 

4 If there is an INTERACTIVE number in your control file script, you see the prompt 
Want to access interactive mode? Y/N. Type Y for yes. 
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5 After the service answers and TelMerge logs you on, type the telex number of your 
correspondent followed by a + (plus sign). The systems exchange answerback 
codes. 

6 At this point, if your correspondent is there, you could communicate back and forth 
in real time. Instead, you'll send a prepared document. Press the SEND key (F4 of 
function key set 2), type the filename, and press J. TelMerge sends your file. 

7 Press the WHO ARE YOU key (F7 of function key set 1 ). TelMerge verifies that you 
were connected during the entire session. 

8 Press F10 to hang up. Press F10 again to exit TelMerge and return to WordStar. 

Note: If you have a problem using interactive mode with a particular service, use that 
service's store-and-forward mode instead. 

Receiving Electronic Mail 

The way you receive mail varies with different services. With store-and-forward telex 
services like ITT and RCA, you give a command after you log on to the service. The 
service then tells you if you have mail waiting. 

With menu-driven communications services like CompuServe and MCI Mail, you are 
told if mail is waiting as soon as you log on to the service. 

If you have mail, make sure the TelMerge logging feature is on and then ask the service 
to send your mail. When logging is on, all mail i s  saved in a file on the disk. You turn 
logging on and off by pressing F7. With telex services, however, logging is always on. 
Check the status line to see if logging is  on. 

C A U T I  0 N Make sure you have enough room on your disk for your logfile before 
you turn logging on. If you run out of disk space during a session, TelMerge discon- 
nects from the service immediately to avoid loss of information. If this happens, make 
room on your disk and log on to the service again. Your mail is probably not lost; in 
most cases, the service still has it. 

When you turn LOGGING ON, information is  saved in a logfile in the current directory 
(unless you change the pathname for it in your service script). Unless you specify 
otherwise, the filename is TELMERGE.LOG. (Logfiles for preprogrammed services have 
been named individually in the TELMERGE.SYS file. For instance, TELMERGE.SYS 
names a CompuServe session logfile CIS.LOG.) Each session is saved in its own file. 
Files received by TelMerge can be edited with WordStar in nondocument mode. 

When you start a new session, TelMerge saves your previous session by automatically 
renaming the old .LOG file as .SAV. The new session is  then saved in the .LOG file. 
The contents of the earlier .SAV file are discarded. If you want to save the logfiles of 
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previous sessions, rename the .LOG file at the end of each session. Choose a filename 
that reflects the date of your session and the service that you used, for example, 
JUNO6.ITT. 

You can use the APPEND keyword to have information from each online session added 
to the existing logfile without creating a new file each time. See APPEND in the 
"Keywords" chapter for more information. 

You can also create prompts that ask you for a logfile name each time you call a ser- 
vice. To do this, type a ? after the keyword LOGFILE in that service's script. Insert a 
blank line just before the LOGFILE statement and type say Name for logfile? See 
"Shortcuts with TelMerge" for more information. 

Printing 
If you have a "PRINT YES" statement in a control file script, you can print your session 
while you're online. Use the F8 (PRINT) function key to turn printing on or off. To 
check the current setting, look at the status line. If you have no printer, you can direct 
the printed output to a disk file. See PRINT in the "Keywords" chapter for more infor- 
mation. 



Talking to 
Other Computers 
Methods of Data Transfer 

If you use TelMerge exclusively for sending Email through an Email service, you don't 
need to read this chapter. You can always use the F4 (SEND) function key to transfer 
data. However, if you intend to call a mainframe or send program files, read on. 

There are two general methods of transferring data between computers: 

ASCII transfer allows you to send and receive standard text files. This transfer 
method will not work for files that contain print controls or for binary and program 
files. All communications programs and commercial communications services sup- 
port ASCII transfers. . Protocol transfer allows you to send a file with print controls in place. You can 
also use this method to send and receive program files. 

A protocol is a set of conventions for exchanging data between two computers and 
checking for errors that may occur during transmission. TelMerge uses the XMODEM 
checksum and XMODEM CRC protocols. Both the sending and receiving computers 
must be running the same protocol for a protocol transfer to work. 

The protocol TelMerge uses to send the file depends on the function key you send it 
with and the service specified in the script. 

If you specify SERVICE TelMerge and press the F4 (SEND) function key, TelMerge 
uses the CompuServe A protocol. 
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If you specify any other service and press F4, TelMerge performs an ASCll file 
transfer. 

If you press the F6 (XM SND) function key, TelMerge uses the XMODEM protocol. 

Talking to Mainframes 

Mainframes expect to be talking to terminals, not to your personal computer. If you are 
simply using Email or doing ASCll file transfers; this should not be a problem. However, 
the mainframe may require that your personal computer emulate (behave as) one of the 
more common terminals. TelMerge can be set up to emulate two terminals: 

VTlOO The DEC VT100 is  a popular ASCll terminal. This is the default emulation. 
You don't need to add it to your script. 

VIDTEX The VIDTEX (or VT52) is another ASCII terminal. If a mainframe requires 
this emulation, you can put the command EMULATE VIDTEX in your control file 
script. 

See EMULATE in the "Keywords" chapter for more information. 

If you have log-on problems in half-duplex mode, add these keywords to your service 
script: DUPLEX HALF and ADDLF NO. The ADDLF NO statement prevents TelMerge 
from sending a line feed after each carriage return sent from the keyboard. 

Note: TelMerge may not support certain communication controls required by 
mainframes. 

Online Databases 
Online services, such as CompuServe, are large mainframe computers with local nodes 
distributed throughout the country. 

When you send Email and simple text files to an online database, use the F4 (SEND) 
function key to send in ASCll mode (without any print controls). When you do a 
protocol transfer, the service usually asks you which protocol you are using. If you 
have problems with transmissions (losing characters, etc.) see B A U D  and LINEDELAY 
in the "Keywords" chapter. 

Talking to Another Personal Computer 

With TelMerge, you can communicate with personal computers and computer 
"bulletin boards" that use any asynchronous communications software. You add 
these services to TelMerge just as you would any other new service. If the other 
computer is also using TelMerge, see "Talking to Another TelMerge User" later in 
this chapter. 
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Use the SEND function key to send ASCll files. For other files, use a protocol trans- 
fer (XMODEM CRC or checksum). Modify your TELMERGE.SYS file as follows. 
First add the new service name (either "ORIGINATE" or "RECEIVE" in our example) 
to your TELMERGE.SYS menu, then add these scripts: 

ORIGINATING RECEIVING 
COMPUTER COMPUTER 

Label ORIGINATE Label RECEIVE 
Say Originating Computer Say Receiving Computer 
Number (number of other computer) Modem ANSWER 
End End 

1 If you are the receiving computer, set the modem switch setting for auto-answer 
to ON, restart your modem (to reinitialize it), start TelMerge, and type receive 
(or whatever name you chose). Then wait for the originating computer to call 
and establish communication. The modem is placed in answer mode. 

If you are the originating computer, wait until the receiving computer is set up. 
Then start TelMerge and type originate (or whatever name you chose). Tel- 
Merge dials the number. The receiving computer answers the call and the two 
computers connect. 

2 To talk with the other computer, type your message. Messages are transmitted. 

To send an ASCll file, press the F4 (SEND) function key, type the name of a file 
to send, and press A. 

For protocol transfers, tell the remote system that you are about to send a file. 
When the system indicates that it is ready, press the XM SND function key (F6 
of function key set 2 )  and type the filename (when prompted). 

The default protocol i s  XMODEM checksum. To use XMODEM CRC protocol, 
put PROTOCOL XMCRC in the control file script. See PROTOCOL in the 
"Keywords" chapter for more information. 

When the transfer is complete, TelMerge indicates that it was successful. 

3 Receiving an ASCll file is automatic. To receive a file via protocol transfer, tell 
the remote system to initiate a file transfer. When the system indicates that it is 
ready, press the XM REC function key (F5 of function key set 2) and type the 
filename (when prompted). 

4 The originator or receiver presses F10 twice to disconnect. 

With an ASCll file transfer, you can see the text on your screen as it comes from the 
modem; if you have LOGGING ON, the file i s  stored to disk. With a protocol 
transfer, incoming data i s  captured in a buffer and written to disk without being dis- 
played onscreen. Instead, the status line displays, for example, RECORD #4. 
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Using Your Personal Computer for Data Collection - 
With the TelMerge auto-answer ability, you can set up your personal computer to 
receive data automatically. For example, sales staff can call in reports and data. 

ASCII File Transfers 
To use your personal computer for data collection, add a control file script with this 
information: 

Label COLLECT (or whatever) 
Say Now ready for data collection 
Service TELMERGE 
Logfile COLLECT.LOG 
Modem ANSWER 
Duplex HALF 
End 

With your modem in answer mode, TelMerge treats all incoming calls as one session, 
adding each call to the same logfile. If your correspondents are using TelMerge and 
add the following script to their control files, each file they send you creates a new file 
on your disk. If this i s  the case, run TelMerge from a directory that has no files in it that 
you want to save, since files sent to you will overwrite files with the same name on 
your disk. 

Label CALLHOME (or whatever) 
Say Now calling home office for file transfer 
Service TELMERGE 
Duplex HALF 
Number (your phone number) 
End 

Protocol Transfers 
In protocol transfers, if a caller tries to send you a filename that already exists on your 
disk, the file on your disk i s  overwritten. 

C A U T I 0 N If you expect a lot of incoming calls through TelMerge, be sure your 
disk has plenty of space to accommodate incoming files. If your disk fills up, the caller 
is disconnected and all subsequent connections fail. 

Talking to Another TelMerge User 
If you are communicating with another computer that is running TelMerge, set up your 
script as follows. 

Label TMERGEZ 
Say Now connected to another TelMerge user 
Service TELMERGE 
Duplex HALF 
End 
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Protocol transfers between two computers running TelMerge use the CompuServe A 
protocol. 

If you are sending files to the other computer, type the name to give to the file when it 
reaches the remote computer. You can use the wild-card character * to send multiple 
files with the same extension (*.DOC) or all the files in a directory (C:\DOCS\*.*). 
During a personal-computer-to-personal-computer transfer, the user who presses the 
SEND function key provides the filename for the other user. 

You can use TelMerge to transfer files directly between computers (without modems) if 
the serial ports of the computers are connected by a special serial cable adapter. Both 
computers must have TelMerge. Set up the control file scripts as follows. 

Label DIRECT 

Say Now set up for direct connection 
Service TELMERGE 
Modem DIRECT 
Duplex HALF 
End 

The direct transfer procedure is the same as for a transfer over the telephone. See 
"Talking to Another Personal Computer" earlier in this chapter for more information. 

A Summary of Techniques to Send and Receive Files - 
Send (F4) Sends ASCll files. (When contacting another TelMerge user, F4 uses the 
CompuServe A protocol.) 

XmSnd (F6) Uses the current protocol (the one set in the service script) to send a file 
to a service or to a personal computer that is not using TelMerge. 

XmRec (F5) Uses the current protocol (the one set in the service script) to receive a 
file from a service or from a personal computer that i s  not using TelMerge. 

No action is required to receive an ASCll file. When you contact another TelMerge 
user, no action is ever required to receive a file. 



Shortcuts with 

This section contains some suggestions for customizing TelMerge for your personal 
needs. The shortcuts are most useful if you are using the TELMERGE.SYS file to call 
your services. The shortcuts in this section include 

programming function keys 

reprogramming TELMERGE.SYS: 
prompting for a password 
prompting for a logfile name 
prompting for printer or disk output 

automating an online session 

exiting while online 

using Snap Shot and ShoFil 

Programming Function Keys 
You can customize F7 and F8 of the online function key set 2 for each service you use. 
In this example, the F7 function key (FK1) i s  programmed to check mail on the 
CompuServe EasyPlex service. 

1 Use WordStar to edit the TELMERGE.SYS file. 

2 Page down until you come to the section that begins Label CIS. 

3 At any point after the Say statement, press J to insert a blank line. 

4 On the blank line, type fkl r,email go-mail. 

5 Save the file. 
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What does fil r,email go-mail mean? 

FK1 stands for the F7 function key. The R sends a carriage return at the end of the 
command. 

When you are online with CompuServe, Email is the new label for the F7 function 
key (at the bottom of your screen). 

Go-mail (followed by J ) is  the command issued when you press F7 while logged 
on to the CompuServe EasyPlex electronic mail service. 

You can program F7 and F8 to send commands, passwords, or other information while 
online. They can have different functions for each service. 

TelMerge has a built-in scripting language with conditional commands like IF and ELSE. 
The following examples demonstrate the use of this scripting language. 

E X A M P L E  

Here is an example of reprogramming TelMerge to prompt you for a password. 

Say Password? 
Hold ? 
If =Mypassword 
Goto GoodPassword 
Else 
Say Sorry. Incorrect password. 
Exit 
End1 f 

Label GoodPassword 
Password ! 

E X A M P L E  

Here is  an example of reprogramming TelMerge to prompt you for a logfile name. 
Insert the following lines into the appropriate section of your control file just after the 
Label line that gives the service name. 

Logfile MYFILE.LOG 
Say What would you like to call this session's logfile? 
Say 
Say Type a filename and press Enter, 
Say or press Enter to use the filename "MYFILE.LOG." 
Say 
Hold ? 

Logfile ! 
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E X A M P L E  

Here is  an example of reprogramming TelMerge to prompt you for printer or disk out- 
put. 

P r i n t  MYFILE.PRN 
S a y  Type  t h e  name t o  u s e  
S a y  f o r  t h e  d i s k f i l e  
S a y  (Type  P t o  u s e  t h e  p r i n t e r )  
H o l d  ? 
If =P 
P r i n t  YES 
E l s e  
P r i n t  ! 
E n d i f  

Automating an online Session 
You can use the TelMerge keywords to issue commands automatically, so you have a 
minimal amount of typing to do. Here are some examples. 

Changing the Log-on Script 
TelMerge issues the commands in its control file in a particular order (see the 
"Keywords" chapter for a full listing). If you have a service that needs information in a 
different order--or one that calls for input that TelMerge doesn't understand-use the 
LOGON keyword to customize your log-on sequence. 

Suppose that you subscribe to a service that requires you to log on by giving (in order) 
the network identification number, your first name, your last name, and your password. 
The LOGON keyword i s  designed to handle this. You would type the following line 
into your control file: 

LOGON networkidl firstnamel lastnamel password 

Each vertical bar ( I  ) in the LOGON command tells TelMerge to issue a carriage return 
and wait for a prompt from the service before continuing. 

Since LOGON is  one of the last keywords that TelMerge checks, remove the lines con- 
taining the network identification and your password from the control file script before 
using this new version. 

Automating an Entire Session 
TelMerge can automatically call a service and request the information you need. You 
can even make several automated calls in sequence without pressing any keys in 
between. The following keywords work together to create an automated session. 
(They are described in more detail in the "Keywords" chapter.) 
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KEYWORD 

CALL 
WAIT word 

SEND word 
PAUSE secs 

QUIET secs 

FILESEND filename 
LOGGING O N  or OFF 
PRINT O N  or OFF 
HANGUP 

DESCRIPTION 

Dials the service now 
Waits for this word from the remote service (after log- 
ging on) 
Sends this word (or words) to the service 
Waits this number of seconds for the service to start 
sending 
Waits until the serial line is quiet for this number of 
seconds 
Sends the specified file 
Turns logging on or off at this point in the session 
Begins or ends printing at this point in the session 
Hangs up the phone 

In an automated session, when TelMerge finds a CALL keyword, it dials the service 
using the preceding information. Then the script keywords are executed. When it 
reaches HANGUP, it looks at the next script to see if it contains a CALL keyword. If 
it does, TelMerge calls that service. Otherwise, it exits the service and goes to the 
TelMerge Communications Menu. 

If you press any key but F10 during an automated session, TelMerge terminates the 
call and switches to normal interactive mode. If you press F10 during an automated 
call, the current script (including any other calls that follow in the script) is can- 
celed, and the phone is hung up. You can automate part of a session and then con- 
tinue it in interactive mode by leaving out the HANGUP keyword after the last 
CALL keyword. 

E X A M P L E  

Here is an example of an automated session. 

S e r v i c e  m c i  
P r i n t  y e s  
Number ( 8 0 0 )  1 2 3 - 4 5 6 7  
B a u d  2 4 0 0  
U s e r i d  k p u t m a n  

L o g g i n g  o n  
C a l l  
W a i t  command:  
S e n d  d o w j  
W a i t  q u e r y  
S e n d  / / d j n e w s  
W a i t  h e l p  
S e n d  .I/EDP 01 
P a u s e  2 
Q u i e t  1 
S e n d  "M 
P a u s e  2 
Q u i e t  1 
S e n d  / / c q e  
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Wait que ry  
Send w s t a r  
Wait r e t u r n .  
Send f 
Pause  2 
Q u i e t  1 
Send d i s c  
Wait command: 
Send e x i t  
Hangup 

Exiting While online 
While you're online, you may want to check a file before sending it. With TelMerge, 
you can exit a service while online without logging off. To do this, press the F9 (Edit) 
function key, while you're online. You return to the WordStar Opening screen. When 
you are ready to reconnect, restart TelMerge and press the F8 (Go Online) function key. 
Select the service from the menu. You can skip the automatic log-on process (by press- 
ing any key after you reconnect), since the remote computer thinks you have been 
logged on all the time. 

To go to DOS while you're online, press the F3 (DOS) function key of set 2. You can 
use any DOS command or run another program. When you're finished, press Esc to 
return directly to your online session. 

Using Snap Shot and ShoFil 
Use the F5 (SnapSh) key to save the current screen in your logfile or in memory. You 
can save up to five screens in memory, but they are saved for the current session only. 
Use the ShoFil function key to look at any file while you're online. 

You can use Snap Shot during ShoFil. For example, if a service displays a list of files 
available for downloading, turn logging on, and ask the service to display the list. 
Logging saves the display on disk. Then press the F8 (ShoFil) function key and J to 
view the logfile. Take snap shots of the parts of the list that interest you. Then use the 
Recall function to display them. Find the file you want to download. 

You can use the ShoFil function to create a customized help screen. Edit the previous 
log file in WordStar to display the information you want to see while you're online. For 
example, you can consolidate all the commands for a given service onto one screen. 
Copy that screenful of information to a file with a descriptive name, like CISHELP.DOC. 
Then, when you're online with that service, use ShoFil to view the screen whenever 
you want. 

You can also use ShoFil to review the logfile of the current session. To do this, press F8 
(ShoFil) and then press J. 



Keywords 
Keywords determine the actions that TelMerge takes. All the TelMerge keywords 
are listed in this section, with explanations and examples of their use. See "Calling 
a Service with TelMergeU for more information on using each keyword. Press F1 to 
display the current settings for keywords while you're using TelMerge. 

How Keywords Are Sent 

This list shows the order of keywords sent in a call. The NUMBER keyword is  re- 
quired; all others are optional. See individual entries for default values for the op- 
tional keywords (except USERID, HOSTID, FILESEND, and PASSWORD). 

KEYWORD DESCRIPTION 

PREMODEM 
IN IT 
INIT2 
PREFIX 
NUMBER 
SUFFIX 
ATTENTION 
ATDELAY 
ATTENTION 
TERMINAL 
HOSTID 
USERID 
PASSWORD 
LOGON 

Modem initialization 
Additional modem initialization 
Dial--default ATDT 
Or INTERACTIVE if interactive telex 
Wait for carrier reply from modem 

Wait this many tenths of a second 
If more than one in control file 
If network 
If network 
Or ANSWERBACK for Telex 
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KEYWORD 

FILESEND 

DESCRIPTION 

In a normal session, TelMerge enters interactive online mode. 
In an automated session, CALL, WAIT, SEND, PAUSE, QUIET, 
FILESEND, and HANGUP take effect. Press F10 to hang up 
the phone, unless there is a HANGUP keyword after the CALL 
keyword. 

HANGCOM Modem hangs up 
POSTMODEM 

Special Characters 
The following special characters can be used with TelMerge keywords. 

CHARACTER FUNCTION 

Subsequent characters on the line are ignored. Use this symbol 
to add comments to the control file. 

Waits for your response from the keyboard. If followed by a 
number, your response is  limited to that number of characters. 
When used with HOLD, puts the characterb) you type into a 
memory buffer. You can use a ! to assign these characters later 
as an entry for a keyword. (See the HOLD keyword.) 

Assigns the contents of the buffer to the preceding keyword. 

Entries for the modem keywords (INIT, INIT2, PREMODEM, POSTMODEM, HANGUP) 
and log-on keywords (TERMINAL, HOSTID, USERID, PASSWORD, LOGON) can in- 
clude the following special characters. 

CHARACTER FUNCTION 

Causes a delay of one second. 

Sends the next character as a control character. "E sends a 
Ctrl-E. 

Sends a caret (") to the remote service. When the caret is the 
last character of a string, no carriage return i s  sent after that 
string. For instance, SEND Y A  sends the letter Y without a car- 
riage return. 

Ctrl-M and a carriage return are interchangeable. To send one carriage return, type 
AM". Without the last A, a carriage return is added after the string AM, resulting in two 
carriage returns. 
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ADDLF Tells TelMerge whether to send a line feed following a carriage return 
entered from the keyboard. 

Usage: ADDLF YES 
ADDLF NO 

Use for logging on to some half-duplex services such as the legal service LEXIS. 
Without ADDLF NO, a service may not respond when you press J or it may hang up. 

ANSWERBACK Issues your personal ID code at a Who are you request (used by 
telex systems only). 

Usage: ANSWERBACK string 

Example: ANSWERBACK Charlie 

Telex-based services request your user identification to verify that you dialed correctly. 
The code you type for the answerback string (up to 30 characters) is provided by the 
service when you register. 

APPEND Adds information from new sessions to the named logfile, without start- 
ing a new one. 

Usage: APPEND YES 
APPEND NO (default) 

Use APPEND in automated sessions when you make several calls, or to avoid renaming 
.LOG files to save them. 

ATDELAY Pauses before sending first character to a service. 

Usage: ATDELAY tenths of seconds 

Default: ATDELAY 5 

Some networks require a delay before the first character (usually the ATTENTION 
character-see ATTENTION) can be received. If the service doesn't respond when you 
first call, increase the setting to ATDELAY 20 or ATDELAY 30. 
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ATTENTION Issues any special characters required by a service at the beginning 
of transmission. 

Usage: ATTENTION character 

Example: ATTENTION "C 
(sends Ctrl-C) 

ATTENTION "M 
(sends Ctrl-M or carriage return) 

To specify more than one ATTENTION character, put each one on a separate line fol- 
lowing the keyword. You can specify a maximum of six. Supplied automatically for 
preprogrammed services and if NETWORK keyword is used. 

AUTOLOG Turns automatic log-on on and off. 

Usage: AUTOLOG YES (default) 
AUTOLOG NO 

If you are testing a new control file script, you may want to disable the automatic log- 
on process by specifying AUTOLOG NO. 

BAUD Sets the rate at which information is transmitted between two devices. 

Usage: BAUD 110 
BAUD 300 
BAUD 1200 
BAUD 2400 (default) 
BAUD 4800 
BAUD 9600 

TelMerge can use six different baud rates. The lower the baud rate, the slower the rate 
of transmission. When an information service supports various baud rates, there may 
be different phone numbers and charges for each setting. 

BITS Sets the number of bits sent for each character. 

Usage: BITS 7 
BlTS 8 (default) 

Already set internally for preprogrammed services. Change as needed when you add a 
new service. 



K E Y W O R D S  

CALL Used instead of END in automated sessions to call the service. 

Usage: CALL 

All information for contacting a service should be above the CALL keyword in the 
script. When CALL i s  encountered, TelMerge calls, attempts to log on, and then 
executes any subsequent keywords in that script. (See END.) 

CLS (Clear Screen) Clears the display. 

Usage: CLS 

Returns the cursor to the upper-left corner of the screen. 

DUPLEX Determines which computer controls the onscreen display of characters 
you type. 

Usage: DUPLEX FULL (default) 
DUPLEX HALF 

Characters you type can be displayed onscreen by your computer or by the host com- 
puter. FULL DUPLEX means the host computer "echoes" your characters to the screen 
as you send them. HALF DUPLEX means your computer echoes the characters. 
Preprogrammed services already have the proper DUPLEX setting. 

ELSE See IF. 

EMULATE Enables monitors to behave like different terminals. 

Usage: EMULATE VT100 (default) 
EMULATE VIDTEX 
EMULATE NONE 

Use this keyword to emulate a mainframe terminal. VT100 (ANSI standard) i s  a widely 
used terminal. See also FULLSCREEN. 

VT100 emulation accepts and displays ANSI standard sequences for cursor movement, 
colors, and special attributes. These sequences include foreground color, background 
color, high intensity, foreground/background reverse, and underlining. Some electronic 
bulletin boards use these sequences to display color screens with highlighted text. 

VIDTEX (VT 52) emulation accepts and displays sequences for cursor movement and 
printer enabling and disabling. 
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END Ignores subsequent commands in a control file script and runs it. 

Usage: END 

TelMerge starts at the service label, reads in the keyword commands up to the END 
command, and calls the service. END is  similar to the CALL keyword. CALL is  used 
for automated sessions, and END is used for interactive sessions. 

ENDIF See IF. 

EXIT Stops and returns to WordStar 

Usage: EXIT 

Use with IF/ELSE to end a session if certain conditions are not met. See IF. 

FILESEND Sends an ASCII or WordStar file that you specify. 

Usage: FILESEND filename 

Example: FILESEND \MEMO.WS 

In interactive sessions (no CALL keyword included), the file is sent after you are logged 
on to the service. In automated sessions, the file is sent when TelMerge encounters the 
FILESEND command. 

FIRST Waits for a particular character from the remote service before displaying 
characters onscreen. 

Usage: Fl RST character 

Example: FIRST p 

Some services send a series of characters before the prompt you need to read. Use 
FIRST to specify the first character you want to display. In the example, the first text 
displayed is Please log in, because "pH was specified as the first character to display. 

FK Programs a Function Key (F7 or F8 of function key set 2) to issue a specified com- 
mand. 

Usage: FK1 ,label space string 
FK2, label space string 
FK1 R,label space string 
FK2R,label space string 

Example: FK1 R,Email GO-Mail 



K E Y W O R D S  

In the example, Email defines the screen label for function key F7. R sends a carriage 
return at the end of the command. Go-Mail i s  the command-go to the electronic mail 
menu. FK1 represents F7 and FK2 represents F8. Commands can be up to 60 charac- 
ters long. You can program these keys differently for each service. 

FULLSCREEN Works with EMULATE to allow better VT100 or VIDTEX screen 
emulation. 

Usage: FULLSCREEN YES 
FULLSCREEN NO (default) 

Removes the status line at the top of the screen to display 24 lines. When you toggle 
logging (F7) or printing (F8) on or off while in FULLSCREEN mode, the status line is 
temporarily displayed to show this change. Then the status line is overwritten or scrolls 
off the screen. 

GOTO Goes to a LABEL in the control file. 

Usage: GOT0 label name 

Example: GOT0 Menu 

GOTO and LABEL are always used together. 

GRAPHIC Uses the extended character set for graphic display. 

Usage: GRAPHIC YES 
GRAPHIC NO (default) 

The extended character set is used by some electronic mail services and bulletin boards 
to enhance screen displays. 

HANGCOM Gives hangup instructions to the modem. 

Usage: HANGCOM string 

Default: HANGCOM ATH 

The command ATH tells your modem to hang up. If your modem uses a different 
hangup command, use HANGCOM to specify it in your control file. (See USEDTR for 
more information.) 
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HANGUP Used in an automated session to hang up the phone. 

Usage: HANGUP 

To add another call to the automated session, use the NUMBER keyword after 
HANGUP. Specify any keywords that differ from those in the last call. Then type the 
CALL keyword. (See CALL for more information.) 

HARDCOPY See PRINT. 

HOLD Waits for user input from the keyboard, and stores the response in a buffer. 

Usage: HOLD ? 

A buffer stores information temporarily. Test the buffer contents with the IF and IFNOT 
keywords. You can use the information in the buffer as the response to another 
keyword by typing ! after the keyword. Stores up to 80 characters. 

HOSTID Issues the host ID code. 

Usage: HOST1 D string 

Default: No HOSTID is sent 

Example: HOSTID XYZZY 

HOSTID (up to 30 characters) is  the network's internal "phone number" for the service 
you are calling. Include it if you use NETWORK in the script. 

IF, IFNOT, ELSE, ENDIF Tests for a specific condition and proceeds accord- 
ingly. 

Usage: IF string 
IFNOT string 
ELSE 
ENDlF 

Example: See "Reprogramming TELMERGE.SYSI1 in the "Shortcuts with TelMergetl 
chapter 

Use together to create program logic for TelMerge. 

IFNOT See I F .  
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INCLUDE Interrupts the current script and runs the script in the included file. 

Usage: INCLUDE filename 

Example: INCLUDE SCRIPT.SYS 

Use INCLUDE to pass control between several files. When the included script is com- 
pleted, TelMerge returns to the original script at the line following the INCLUDE 
keyword. Use as many INCLUDE statements as you want and nest up to four files. 

INIT Initializes the modem before a call is made. 

Usage: INlT string 

Default: INIT ATE1 

Specify the initialization string for your modem if it differs from the default. In the 
default, AT prepares the modem for a command; E l  echoes input to the screen. A car- 
riage return follows the string. A \d with INIT adds a delay of one second. (See 
"Special Characters" at the beginning of this section.) 

INIT2 Adds other initialization information. 

Usage: INIT2 string 

Example: INIT2 ATS 7=20 

The string sent by INIT2 follows the INIT string. The example sets the number of 
seconds TelMerge will wait for a carrier signal after dialing. (The Hayes default is 20 
seconds.) 

INTERACTIVE Specifies the phone number of a telex real-time (interactive) 
service. 

Usage: INTERACTIVE phone number 
INTERACTIVE P phone number 

Example: INTERACTIVE 9 (800) 555-1 21 2 

Numbers specified can be up to 30 characters long. Include any dialing prefix required 
by your PBX system and the area code. 

The default dialing mode i s  tone dialing. The "P" preceding the number in the second 
usage form indicates pulse dialing to the Hayes Smartmodem. 

See your modem manual for information about special punctuation marks. For the 
Hayes Smartmodem, a comma creates a two-second delay. This is useful for dialing 
out of a local PBX, which requires a second dial tone. 
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LABEL Marks a position in the control file as a destination for a GOT0 keyword. 

Usage: LABEL label name 

Example: GOT0 MCI 

LABEL MCI 

Each GOT0 statement must have a corresponding LABEL. Labels can be up to 80 
characters long. 

LINEDELAY Pauses after each line sent with the F4 (SEND) function key. 

Usage: Ll N EDELAY tenths of a second 

Example: LINEDELAY 3 

Use LINEDELAY if the receiving computer cannot keep up with your SEND speed. In 
the example, TelMerge waits three tenths of a second after each carriage return before 
sending the next line. 

LOGFILE Names the file that records an online session. 

Usage: LOGFILE filename 

Default: LOGFILE telmerge.log 

Example: LOGFILE MCI.LOG 

With logging on, the online session is  recorded in the current directory (unless you 
specify a pathname for it). The name of the logfile defaults to the service name and a 
.LOG extension. The previous logfile is saved to a .SAV file. The .SAV file from the 
session before that i s  overwritten. 

LOGGING sets the initial status of the logging function. 

Usage: LOGGING ON (default) 
LOGGING OFF 

When logging is  on, a logfile i s  opened and incoming information from an online ses- 
sion is recorded. You can turn logging on or off during any online session with the 
LOG function key (F7 of function key set 2).  

LOGON Automates the log-on process and much of an online session. 

Usage: LOGON string1 string1 string 

Example: LOGON JoelSmithlpasswordl~MAI~M~lf 
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LOGON replaces the USERID, PASSWORD, TERMINAL, and HOSTID keywords. It 
automates the session up to the point of logging. You can automate the rest of the ses- 
sion with CALL, WAIT, and SEND. LOGON can have up to 80 characters. 

In the example, LOGON logs Joe Smith on to a bulletin board service that prompts with 
First Name?, Last Name?, Password?, Want to see bulletins? (carriage return for no), 
Want messages?, and, finally, a menu in which " f " goes to the file section. The verti- 
cal bar character (I) after each item in the string sends a carriage return and waits for 
the next prompt. (See the PROMPT keyword.) 

MODEM Defines the type of modem you are using. 

Usage: MODEM AUTOMATIC (default) 
MODEM ACOUSTIC 
MODEM DIRECT 
MODEM ANSWER 
MODEM HAYES 
MODEM HAYES 2400 

The default is a Hayes Smartmodem that automatically dials and answers. Use 
MODEM HAYES 2400 if you are using the Hayes Smartmodem 2400. 

For an acoustic modem, change the response to ACOUSTIC and dial the service 
manually. TelMerge resumes operation after the connection is made. Note: If the set- 
ting is MODEM ACOUSTIC, AUTOLOG is set to N O  for that service, even if you 
specify AUTOLOG YES in that script. Once the telephone connection is made, you 
must complete the log-on procedure yourself. 

For a direct-cabled connection (without modems), change the response to DIRECT. 

For a personal-computer-to-personal-computer transfer, change the response to 
AUTOMATIC or ANSWER. See "Talking to Another Personal Computer." 

NETWORK Specifies a network to use to contact a particular service. 

Usage: NETWORK TYMNET 
NETWORK TELENET 
NETWORK UNINET 

A network allows you to reach a service with a local phone call rather than with a long 
distance one. If you use the NETWORK keyword, you must use HOSTID as well, but 
you don't need the ATTENTION and TERMINAL keywords. 
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NUMBER Specifies the telephone number for a service. 

Usage: NUMBER phone number 
NUMBER P phone number 

Example: NUMBER 9,,(201)555-1212 
NUMBER P9,,(201)555-1212 

NUMBER can be up to 38 characters long. Include any dialing prefix required by your 
PBX system and the area code. The commas shown in the examples create two-second 
delays for a PBX that requires a second dial tone. See your modem manual for more 
information about special punctuation marks. 

If you have call waiting and your local telephone company provides a way to disable it, 
you can add the call waiting cancel code to the NUMBER string. Put it before the area 
code of the service number. Call waiting is reinstated as soon as the HANGUP signal 
is issued. 

The default dialing mode is tone dialing. If you have a Hayes Smartmodem, which re- 
quires pulse dialing, type a P after the NUMBER keyword. 

PARITY Specifies an error-checking procedure. 

Usage: PARITY NONE (default) 
PARITY ODD 
PARITY EVEN 
PARITY ZERO 
PARITY ONE 

This keyword is  already set internally for preprogrammed services. For new services, 
change the response to the setting required by that service. 

PASSWORD issues your password to a service automatically. 

Usage: PASSWORD string 

Example: PASSWORD BLUEFOX 

Passwords can be up to 30 characters long. If you don't want to include passwords in 
your control file scripts, type the following lines to have TelMerge prompt you for your 
password just before logging on to the service. 

SAY What is your password 
PASSWORD ? 
CLS 
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PAUSE Pauses for the number of seconds you specify to allow the remote service to 
begin sending. 

Usage: PAUSE number of seconds 

Example: PAUSE 3 

Use PAUSE in an automated session when you don't know how the service will 
respond. Use PAUSE in conjunction with QUIET to insure that the service is finished 
sending characters. In this example, TelMerge waits three seconds before proceeding 
to the next instruction in your script. 

PORT Specifies the port on your computer that TelMerge will use to communicate. 

Usage: PORT COM1 (default) 
PORT COM2 

If you use the COMl port for your printer, connect TelMerge to the COM2 port and 
change the entry for PORT to COM2. 

P O S T M O D E M  Sends a string of characters to an electronic switch after a call is 
made. 

Usage: POSTMODEM string 

Example: POSTMODEM ATE1 V1 AM 

Use POSTMODEM to initialize the modem for the next user. If a PREMODEM com- 
mand tells switching equipment to use modem 3, POSTMODEM can unhook modem 3 
to make it available. 

In the example, "ATE1 " leaves the modem in echo mode. "V1" uses long responses 
(words) instead of single characters. The "AM" is needed because neither PREMODEM 
nor POSTMODEM automatically sends a carriage return. 

PREFIX Specifies a condition for dialing a phone number. 

Usage: PREFIX string 

Default: PREFIX ATDT 

Example: PREFIX ATMODT 

The Hayes Smartmodem dials the "Dial String," which consists of the prefix, the num- 
ber, and the suffix. 
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Entries for the PREFIX keyword can be up to 30 characters long. Begin each one with 
AT and end with a dial command (DT for tone dialing or DP for pulse dialing). In the 
example, MO (zero) silences the modem's speaker during dialing. Check your modem 
manual for more information about dialing prefixes. 

PREMODEM Sends a string of characters to the communications port before the 
modem initialization string is sent. 

Usage: PREMODEM string 

Example: PREMODEM AZ\d\d\d 

A premodern command (up to 32 characters) can be sent to an electronic switch con- 
necting several modems, a corporate phone system with built-in modems, or a modem 
that requires a special command before normal Hayes-type initialization. 

Use A to specify control characters and \d to specify a one-second delay. (See "Special 
Characters" at the beginning of this chapter.) 

In the example, a Ctrl-Z (required by some phones with built-in modems) is sent, fol- 
lowed by a three-second pause (one second for each \d). 

PRINT Records an online session on your printer or in a disk file. 

Usage: PRINT YES 
PRINT filename 
PRlNT port 
PRlNT NO (default) 

Example: PRINT LPT2 

PRlNT YES sends a record of your session to your default printer. PRlNT port sends the 
information to a printer connected to a different port. PRlNT filename sends the infor- 
mation to a disk file with that name. 

If PRINT is  set to YES, turn printing on and off with the F8 (PRINT) function key. Before 
you begin printing, be sure that your printer is ready and has enough paper. 

Printing is  initially ON for preprogrammed telex services. Printing begins as soon as 
you connect with the service. You can turn it off and on again with F8. 
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PROMPT Adds new characters to the prompts TelMerge recognizes. 

Usage: PROMPT character 

Example: PROMPT J 

A prompt is used by the remote service to tell you that it's waiting for your response. 
For example, in the phrase "Command :" the colon (:) is a prompt, since it is the 
service's signal that it is ready for you to respond. 

These prompt characters are recognized by TelMerge: Q, :, =, !, ?, >, A, and Q. Use 
PROMPT to add up to nine new prompts. Prompts can be up to 14 characters long. 

PROTOCOL Changes the file transfer protocol. 

Usage: PROTOCOL XMCRC 
PROTOCOL XMCHK (default) 

F5 of function key set 2 (XM REC) defaults to XMODEM checksum protocol. To use the 
CRC protocol, add PROTOCOL XMCRC to the service script. 

QUIET waits until no character has been received from the remote service for a 
specified number of seconds before sending new information. 

Usage: QUIET number of seconds 

Example: QUIET 3 

Use in conjunction with PAUSE in automated sessions. In this example, TelMerge 
waits until no characters have been received for three seconds before following the 
next instruction in your script. 

SAY Displays the subsequent text on that line when you run TelMerge. 

Usage: SAY string 

Example: SAY Check the printer 
SAY 
SAY and press J 
SAY to continue 
HOLD ? 

Each SAY command can be up to 80 characters long. Create blank lines by using SAY 
alone with no text. 
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SEND Sends a string of characters and a carriage return to the service. 

Usage: SEND string 

Example: SEND //NEWS 

In the example, the word NEWS is sent to the remote service, followed by a carriage 
return. (The slashes are part of an MCI command.) Use SEND in automated sessions. 

SERVICE ~ o g s  on to a particular service automatically. 

Usage: SERVICE CIS 
SERVICE ESL 
SERVICE ITT 
SERVICE MCI 
SERVICE OAG 
SERVICE ONT 
SERVICE RCA 
SERVICE Telmerge 

CompuServe 
EasyLink 
ITT TeleflIMETRAN 
MCI Mail 
Official Airline Guides 
ONTYME Messaging Service 
RCA TeleflELEXTRA 
Another TelMerge user 

SERVICE is a description of your communications service (up to 32 characters long). It 
appears in the status line when you are connected to that service. Any service not 
listed here can be added with the SERVICE keyword. (See "Adding a New Service to 
TELMERGE.SYS.") 

If you add a new service without specifying a service name, TelMerge displays Remote 
System when you connect with that service. 

STOPS Sets the number of stop bits. 

Usage : STOPS 1 (default) 
STOPS 2 

This keyword is already internally set for preprogrammed services. Check the service 
requirements for this setting when adding a new service. The default setting works for 
most services. 
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SUFFIX Issues a post-dial command to the modem. 

Usage: SUFFIX string 

Default: A carriage return is sent 

Example: SUFFIX M I  

SUFFIX (up to 30 characters) follows NUMBER. In the example, " M I "  turns on the 
modem speaker after the number is dialed. This i s  useful if you use PREFIX to tell the 
modem to be silent during dialing, but you want to hear busy or no-answer signals 
when dialing is completed. 

The Hayes Smartmodem dials the "Dial String," which consists of the PREFIX, NUM- 
BER, and SUFFIX keywords. See your modem manual for more information. 

TERMINAL Specifies your terminal type. 

Usage: TERMINAL string 

Example: TERMINAL A 

During an automatic log-on to a network, TERMINAL (up to 6 characters) specifies the 
equipment you are using. Do not use TERMINAL with a preprogrammed NETWORK 
keyword, since these terminal settings are already internally programmed into 
TelMerge. 

TRY Specifies how many times to redial a busy number before giving up and return- 
ing to Wordstar. 

Usage: TRY number from 1 to 99 

Default: TRY 2 

Example: TRY 9 

When a number i s  busy, TelMerge does not redial immediately. It waits until the dial- 
ing clock registers about 45 seconds. 

USEDTR Controls how TelMerge hangs up the modem. 

Usage: USEDTR YES 
USEDTR N O  (default) 

You can use this keyword with modems that have a switch that uses the DTR serial port 
signal to hang up. The Hayes 2400 modem can use the DTR switch, but it requires 
special initialization. For this modem, use the INIT2 keyword ("INIT2 AT&D3"). If the 
phone doesn't hang up when it should, add USEDTR YES to your control file script and 
set the modem switch to use DTR. (See also HANGCOM.) 
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USERID Issues your identifying name when you log on to a communications 
service. 

Usage: USERID string 

Example: USERID 1456 

When you subscribe to a communications service, you receive a user ID code (up to 30 
characters long) that you must send each time you call the service. 

WAIT Waits for a particular string from the remote service before continuing with 
the next instruction. 

Usage: WAIT string 

Example: WAlT Command: 

In this example, "WAIT Command:" tells TelMerge to wait until the word "Command:" 
is received from the remote service before proceeding. Use WAlT for automated ses- 
sions. 



Troubleshooting 
This section lists some commonly reported TelMerge problems and their solutions. 

C A U T I  0 N Some problems have been reported in running TelMerge with 
RAM-resident programs. If you have problems using TelMerge, disable any RAM- 
resident programs you have. To do this, you may need to remove the commands in 
your AUTOEXEC.BAT file that start these programs. Then reboot your computer 
and run TelMerge. 

Connection Problems 
The modem dials the phone, but there is no answer. 

The telephone number in the script for this service is probably incorrect. Be 
sure to include the appropriate prefix ("9" for a PBX or "1" for long distance) and 
the area code. 

The modem dials and connects, but TelMerge doesn't log on to the service. 

There may be something wrong with the script for that service. You may have 
typed the wrong user ID or password, or specified the wrong baud rate setting 
for your modem. See the "Communications Services" chapter and edit the con- 
trol file. You can also try increasing the character delay. Set the ATDELAY, 
keyword to 20 or 30. (See ATDELAY in the "Keywords" chapter.) 

Transmission is erratic, or is cut off when sending a document to a service. 

The end-of-document marker for that particular service may have been inadver- 
tently included somewhere in the text of the message. For instance, MCI uses a 
slash ( 1)  to indicate the end of a letter. Edit the document and remove the of- 
fending character(s). See the information packet from your service for more in- 
formation. 
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Also, check the LINEDELAY keyword in your control file script. Try increasing 
the LINEDELAY setting to 10. (See LINEDELAY in the "Keywords" chapter.) 

When connecting to a service, everything freezes. 

Perhaps the keyword in that script is set for PRINT YES, but when you connect 
to the service, your printer is turned off. Turn on your printer and try again. 
This can also happen if you run TelMerge while using a RAM-resident program. 
Disable any ,RAM-resident programs, reboot your computer, and run TelMerge 
again. 

Screen Display Problems 
During a session, none of the characters typed appears on the screen. 

The service you are using requires half duplex. Edit the control file and add the 
line DUPLEX HALF to the service's script. 

During a session, each character typed appears twice on the screen. 

The service you are using requires full duplex. Edit the control file and replace 
DUPLEX HALF with DUPLEX FULL for that service's script. 

The screen fills with random characters when connected to a service. 

The baud rate of the service and the baud rate of your computer don't match. 
The baud rate information for the service is in the packet that the service sent 
you. Edit the service's script in the control file and specify the proper baud rate. 

During a telex service session, lines in the text wrap before the end of the line. 

Telex services allow fewer than 80 characters across the page. Use a right mar- 
gin of 65 in document files to be safe. 

File Problems 
The logfile is erased each time a new session is initiated. 

TelMerge renames the previous logfile 1ogfile.SAV at the beginning of each new 
session. The same logfile name is used for every session and is specified in the 
script for that service after the keyword LOGFILE. If you want to keep old log- 
files, rename the file after each session or add APPEND to the scripts whose log- 
files you want to save. (See APPEND in the "Keywords" chapter for more 
information.) 

Printing Problems 
Documents do not retain print commands like bold, underline, and overstrike 
when sent. 

Because of compatibility constraints, TelMerge strips all print commands from 
WordStar document files, unless you use a protocol transfer. The balance of the 
document is transmitted faithfully. 
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C A U T i  0 N If you are sending files that you created with another word 
processor, and these files contain print enhancements, you must use a protocol 
transfer. Otherwise, serious problems could occur. 

During a telex service session, certain punctuation marks don't appear in the 
document received. 

The character set for telex is a subset of the typewriter character set. Generally, 
lowercase characters are converted to uppercase. Certain punctuation marks 
are discarded during the transmission, and others are converted. The com- 
munications service representative can supply more specific information. 



TelMerge 
Function Keys 
T e l ~ e r ~ e  Communications Menu 
Function Key Assignments 

FUNCTION 
KEY LABEL PURPOSE 

Help 

Other 

Displays TelMerge function keys and current settings 

Creates a new service file or allows you to specify an ex- 
isting one 

Go Online Returns to a service after you go offline temporarily 

Exit Exits the service 

Online Function Key Assignmen ts-Set 1 
FUNCTION 
KEY LABEL 

Help 

PURPOSE 

Explains each function key 

Set2 Switches between function key sets 1 and 2 

UserlD/Hereis Sends the user identification code you typed in this 
service's script to the service 

PassWd/Mail Sends the password you typed in this service's script to 
the service. (For telex services, gets messages) 
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FUNC~ION 
KEY LABEL 

SnapSh 

Recall 

LoglWRU 

Print 

Edit 

Hangup 

PURPOSE 

Saves current screen in logfile or in memory. Saves up 
to 5 screens 

Displays screens saved with F5 

Turns logging on and off. (For telex services, issues a 
WHO ARE YOU command) 

Turns printing on and off 

Exits to WordStar while online. Use F 8  (Go Online) to 
return to the service 

Hangs up the phone. Be sure to log off from your ser- 
vice first if required 

Online Function Key Assignments-Set 2 
FUNCTION 
KEY 

F1 

LABEL 

ShoFil 

Set1 

DOS 

Send 

XM Rec 

XM Snd 

User1 

Break 

Hang up 

PURPOSE 

Displays any file, including the current logfile 

Switches between function key sets 1 and 2 

Goes to operating system without disconnecting from 
service (type exit to go back online) 

Sends a WordStar or ASCII file 

Receives a file using the XMODEM protocol 

Sends a file using the XMODEM protocol 

Can be programmed for your own commands. (See the 
F K  keyword) 

Can be programmed for your own commands. (See the 
F K  keyword) 

Issues an RS-232C break signal (not normally used) 

Hangs up the phone. Be sure to log off from your ser- 
vice first, if required. 



Communications 

This chapter provides information about TelMerge preprogrammed services. For 
more information, contact the service directly. When you register with a service, 
you receive the information required to call that service with TelMerge. See 
"Calling a Service with TelMerge." 

You can also use TelMerge to call services or networks that are not preprogrammed. 
For instructions, see "Adding a New Service to TELMERGE.SYS.I1 If you use a net- 
work to call a service, see NETWORK in the "Keywords" chapter. 

Compuserve In for ma tion Service 

5000 Arlington Centre Blvd. 
Columbus, OH 43220 
(800) 848-8990 

TelMerge Service Name: CIS 

CompuServe offers an information service as well as electronic mail (EasyPlex and 
InfoPlex). CompuServe provides business news, computer games, special interest 
group bulletin boards, online conferencing, newspapers, and much more. 

Note: When you call CompuServe, TelMerge uses the CompuServe A protocol to 
exchange files. 
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Easylink by Western Union 
Western Union Telegraph 
4230 Altha Road 
Dallas, TX 75244 
(800) 527-51 84 (Sales); (800) 435-7375 (Help) 

TelMerge Service Name: ESL 

Western Union offers EasyLink electronic mail service (a store-and-forward system), 
an information service called FYI, and a Mailgram service. EasyLink cables your 
message if it can't be delivered by a telex network. 

/TT Telex and TIMETRA N 

ITT World Communications 
100 Plaza Drive 
Secaucus, NJ 07096 
(800) 922-01 84 

TelMerge Service Name: ITT 

ITT offers telex services, a store-and-forward service (TIMETRAN), and a paper mail 
service. ITT cables your message if it can't be delivered by telex. ITT also offers an 
information service called UPDATE. TelMerge turns logging and printing on 
automatically for ITT. If you don't want to print your sessions, change the PRINT 
setting to NO. 

MCI Mail 

MCI Mail TelMerge Service Name: MCI 
11 50 17th St., N.W, 8th Floor 
Washington, DC 20036 
(800) 444-6245; (202) 833-8484 (Washington, DC) 

MCI Mail offers an electronic mail service, an information service (in cooperation 
with Dow Jones NewsIRetrieval), and a courier service. Access to telex networks is  
also available. 

Official Airline Guides 

Official Airline Guides 
2000 Clearwater Drive 
Oak Brook, IL 60521 
(800) 323-4000 

TelMerge Service Name: OAG 

The Official Airline Guides Electronic Edition provides airline schedules and fares 
for commercial air carriers. 
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ON TYM E Messaging Service 

ONTYME Marketing TYMSHARE 
2560 North First Street 
San Jose, CA 95 1 3 1 
(800) 435-8880 

TelMerge Service Name: ONT 

ONTYME is an electronic store-and-forward message service that provides 
worldwide local-call access. You can route messages through the telex networks if 
you want. TYMSHARE has another network called TYMNET. 

RCA Telex and TEL EXTRA 

RCA Global Communications 
201 Centennial Avenue 
Piscataway, NJ 08854 
(800) 526-3969 

TelMerge Service Name: RCA 

RCA provides real-time telex services, TELEXTRA store-and-forward service, and an 
information service called HOTLINE. RCA Telegram turns your telex into a 
telegram if necessary. TelMerge turns LOGGING and PRINT on automatically for 
RCA. If you do not have a printer or prefer not to use one, change the PRINT set- 
ting to NO. 
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acoustic modem, TM-43 
Additional pull-down menu, TM-10 
ADDLF keyword, defined, TM-35 
answer mode, TM-23, TM-24 
ANSWERBACK keyword 

defined, TM-35 
in telex script file, TM-14 

APPEND keyword 
defined, TM-35 
and file problems, TM-52 
and logfiles, TM-20 

ASCII transfer 
for data collection, TM-24 
described, TM-2 1 
and logfiles, TM-23 
receive a file, TM-23 
send a file, TM-22 

asterisk (*), for sending multiple files, TM-25 
asynchronous communications adapter card, 

TM-6 
ATDELAY keyword 

and connection problems, TM-51 
defined, TM-35 

AlTENTlON keyword, defined, TM-36 
auto-answer, TM-23, TM-24 
AUTOLOG keyword, defined, TM-36 
automated communications session, TM-29 

to TM-3 1 

BAUD keyword 
in communications service files, TM-10 
defined, TM-36 
in TELMERGESYS, TM-11 
and transmission problems, TM-22 

BBS. See bulletin boards 
binary file transfer. See protocol transfer 
BITS keyword, defined, TM-36 
bulletin boards, TelMerge script file for, 

TM-22 to TM-23 

CALL keyword 
automate entire session, TM-30 
defined, TM-37 

call waiting, and TelMerge operation, TM-5 
capture a screen. See screen capture 
caret character (") 

as control key symbol, TM-34 
in TELMERGE.SYS scripts, TM-34 

carriage return 
as caret character (") in TELMERGE.SYS, 

TM-34 
in modem initialization string 

(POSTMODEM), TM-45 
send at end of TelMerge command line, 

TM-28 
characters, special, in keywords, TM-34 
checksum. See XMODEM checksum1CRC 

protocols 
CLS (clear screen) keyword, defined, TM-37 
COMI . See serial port 
comma, delay modem dialing with, TM-12 
comment lines, in TELMERGESYS, ,TM-34 
communications service files, create, TM-10 
communications services 

add a new service to TELMERGESYS, 
TM-13 to TM-14 

automate a session, TM-29 to TM-31 
data network access and HOSTID, TM-13 
exit while online, TM-31 
listed, TM-57 to TM-59 
registering with, TM-9 
return online (F8), TM-31 
See also individual service names 

CompuServe 
address and information about, TM-57 
CompuServe A protocol, TM-21, TM-25 
data transfer, TM-22 
function key customization and check 

mail, TM-27 to TM-28 
receive mail, TM-19 
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CompuServe (continued) 
script file, TM-12 
send electronic mail, TM-16 
SERVICE keyword for, TM-48 
terminal emulation for, TM-22 

connection problems, TM-51 to TM-52 
Control key characters, in TELMERGESYS 

scripts, TM-34 
CRC. See XMODEM checksum/CRC 

protocols 
customize 

function keys, TM-27 to TM-28 
help screen with ShoFil, TM-31 
log-on sequence, TM-29 
prompts in TELMERGESYS, TM-28 to 

TM-29 

\d (delay for a second), 34 
data networks, to access communications 

services, TM-13 
data transfer, types of, TM-21 
default settings 

communications service files, TM-10 
Hayes modem switches, TM-6 to TM-7 
keywords, TM-35 to TM-50 
for TELMERGESYS, TM-11 
terminal emulation (VT1 OO), TM-22 
XMODEM checksum, TM-23 . 

delay for a second (\d), 34 
delay modem dialing with comma, TM-12 
dialing 

delay with comma, TM-12 
prefixes, TM-45 to TM-46 
prefixes and connection problems, TM-51 
redial, TM-16, TM-49 

DIP switch settings, for Hayes modems, 
TM-6 to TM-7 

direct transfer procedure 
MODEM setting for, TM-43 
null modem script file, TM-25 

disconnect. See hang up (F10) 
display 

extended character set, TM-39 
keyword settings (F1 ), TM-33 

DTR signal, TM-49 
DUPLEX keyword 

in communications service files, TM-10 
defined, TM-37 
echo mode string, TM-45 
and screen display problems, TM-52 

echo setting. See DUPLEX keyword 
electronic mail 

create with Wordstar, TM-15 
receive, TM-19 to TM-20 
send, TM-16 
send paper mail, TM-17 
types of, TM-15 to TM-16 
See also telex 

ELSE keyword, defined, TM-40 
Email. See electronic mail 
EMU LATE keyword 

defined, TM-37 
and mainframe computers, TM-22 

END keyword 
in bulletin board script file, TM-23 
in CompuServe script file, TM-12 
defined, TM-38 

ENDIF keyword, defined, TM-40 
Esc key (return to TelMerge session), TM-31 
exclamation point (!), in TELMERGE.SYS 

scripts, TM-34 
EXIT keyword, defined, TM-38 
exit while online, TM-31 
extended character set, display, TM-39 
external modems, switch settings, TM-6 



F1, display keyword settings, TM-33 
F3, go to DOS, TM-31 
F4, send a file, TM-16, TM-17, TM-18, 

TM-19, TM-2 1 to TM-22 
F5 

receive a file with XMODEM, TM-23 
Snap Shot, TM-31 

F6, send a file with XMODEM, TM-22, 
TM-23 

F7, logfile on/off toggle, TM-19 
F8 

print session while online, TM-20 
return online, TM-31 
ShoFil, TM-31 

F10, hang up, TM-16, TM-30, TM-49 
files created by other word processors, 

TM-53 
FILESEND keyword 

automate entire session, TM-30 
defined, TM-38 

FIRST keyword, defined, TM-38 
FK keyword 

automatic CompuServe mail checking, 
TM-27 to TM-28 

defined, TM-38 to TM-39 
full duplex. See DUPLEX keyword 
FULLSCREEN keyword, defined, TM-39 
function keys 

assignments, TM-55 to TM-56 
customize, TM-27 to TM-28 
See also individual function key entries 

go to DOS (F3), TM-31 
GOT0 keyword, defined, TM-39 
GRAPHIC keyword, defined, TM-39 

half duplex. See DUPLEX keyword 
half-duplex services, logging on to, TM-35 
hang up (F1 O), TM-16 

DTR signal, TM-49 
during automated session, TM-30 

HANGCOM keyword, defined, TM-39 
HANGUP keyword 

automate entire session, TM-30 
defined, TM-40 

HARDCOPY keyword. See PRINT keyword 
hardware requirements, TM-5 
Hayes modems 

2400 modem and DTR switch, TM-49 
switch settings, TM-6 to TM-7 

help screen, customize with ShoFil, TM-31 
"hold button" phone systems, and TelMerge 

operation, TM-5 
HOLD keyword, defined, TM-40 
HOSTID keyword, defined, TM-40 

IF keyword, defined, TM-40 
IFNOT keyword, defined, TM-40 
INCLUDE keyword, defined, TM-41 
INIT keyword, defined, TM-41 
INIT2 keyword, defined, TM-41 
installing TelMerge, TM-6 to TM-7 
INTERACTIVE keyword 

defined, TM-41 
in telex script file, TM-14 

interactive mode (telex), TM-18 to TM-19 
internal modems, switch settings, TM-7 
ITT 

address and information about, TM-58 
format for telex message, TM-17 
send telex using ITT telex, TM-18 to 

TM-19 
send telex using TIMETRAN, TM-18 
SERVICE keyword for, TM-48 



keywords 
display settings (FI), TM-33 
listed, TM-35 to TM-50 
NUMBER keyword required, TM-33 
order of, TM-33 to TM-34 
special characters in, TM-3A 

LABEL keyword 
in bulletin board script file, TM-23 
in CompuServe script file, TM-12 
defined, TM-42 

LEXIS, logging on to, TM-35 
line feed, add, TM-35 
LINEDELAY keyword 

and connection problems, TM-52 
defined, TM-42 
and transmission problems, TM-22 

.LOG file, TM-19 to TM-20 
LOGFILE keyword 

in CompuServe script file, TM-12 
defined, TM-42 
and file problems, TM-52 

logfiles 
and ASCII transfer, TM-23 
erasure of, TM-52 
prompt for, TM-28 
in TelMerge, TM-19 to TM-20 
turn onloff (F7), TM-19 

LOGGING keyword 
automate entire session, TM-30 
in CompuServe script file, TM-12 
defined, TM-42 

LOGON keyword 
customize script file, TM-29 
defined, TM-42 to TM-43 

long distance prefixes, TM-29, TM-51 

AM, carriage return character, TM-34 
mainframe computers, terminal emulation, 

TM-22 
MCI mail 

address and information about, TM-58 
end of document marker V), TM-51 
receive mail, TM-19 
send paper mail, TM-17 
SERVICE keyword for, TM-48 

MODEM keyword 
in bulletin board script file, TM-23 
in communications service files, TM-10 
defined, TM-43 
in TELMERGE.SYS, TM-11 

modems 
acoustic modem, TM-43 
answer mode, TM-23, TM-24 
delay dialing with comma, TM-12 
dialing prefixes for, TM-45 to TM-46 
external modem switch settings, TM-6 
hangup instructions for, TM-39 
initialize, TM-41, TM-45 
internal modem switch settings, TM-7 
phone systems with built-in modems, 

TM-7 
setting up, TM-6 to TM-7 
speaker, onloff, TM-46, TM-49 

multiline phones, and TelMerge operation, 
TM-5 

multiple file transfers with wild-card 
characters, TM-25 

NETWORK keyword, defined, TM-43 
null modem transfer 

MODEM setting for, TM-43 
script file for, TM-25 

NUMBER keyword 
in bulletin board script file, TM-23 
in CompuSewe script file, TM-13 
defined, TM-44 



Official Airline Guides 
address and information about, TM-58 
SERVICE keyword for, TM-48 

ONTYME Messaging Service 
address and information about, TM-59 
SERVICE keyword for, TM-48 

outside lines 
accessing for TelMerge, TM-12 
dialing, TM-51 

paper letter (electronic), TM-15 
send, TM-17 

PARITY keyword, defined, TM-44 
PASSWORD keyword 

in CompuServe script file, TM-13 
defined, TM-44 

password prompt customization, TM-28 
PAUSE keyword 

automate entire session, TM-30 
defined, TM-45 

PBX systems. See outside lines 
PC-to-PC transfers, TM-22 to TM-23 
phone numbers. See NUMBER keyword 
phone systems 

with built-in modems, TM-7 
and TelMerge operation, TM-5 

PORT keyword 
in communications service files, TM-10 
defined, TM-45 
in TELMERGE.SYS, TM-11 

POSTMODEM keyword, defined, TM-45 
PREFIX keyword, defined, TM-45 to TM-46 
prefixes 

dialing prefixes for modems, TM-45 to 
TM-46 

long distance prefix, TM-51 
PBX prefix, TM-51 

PREMODEM keyword 
defined, TM-46 
and phone systems with built-in modems, 

TM- 7 
print control codes 

protocol transfer of, TM-21 to TM-22 
stripped by TelMerge, TM-15, TM-52 to 

TM-53 
PRINT keyword 

automate entire session, TM-30 
defined, TM-46 
and freezing up of communication, 

TM-52 
print session, TM-20 

printing 
communications session while online 

(F8), TM-20 
problems with, TM-52 to TM-53 

program file transfer. See protocol transfer 
PROMPT keyword, defined, TM-47 
prompts, customizing in TELMERGE.SYS, 

TM-28 to TM-29 
PROTOCOL keyword 

defined, TM-47 
XMODEM CRC, TM-23 

protocol transfer 
for bulletin boards, TM-23 
for data collections, TM-24 
described, TM-21 
types supported, TM-21 to TM-22 

pulse dialing, and PREFIX keyword, TM-46 

question mark (?), in TELMERGE.SYS scripts, 
TM-34 

QUIET keyword, defined, TM-47 
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RAM-resident programs 
and freezing up of TelMerge, TM-52 
using with TelMerge, TM-5 

RBBS. See bulletin boards 
RCA TeleflELEXTRA 

address and information about, TM-59 
SERVICE keyword for, TM-48 

receive a file 
ASCll transfer, TM-23 
XMODEM protocol (F5), TM-23 

receive electronic mail, TM-19 to TM-20 
redial. See TRY keyword 
return online (F8), TM-31 

.SAV files, TM-19 
save current screen (F5), TM-31 
SAY keyword 

in bulletin board script file, TM-23 
and creating prompts, TM-20 
defined, TM-47 

screen capture 
during communications session (logfiles), 

TM-19 to TM-20 
with Snap Shot (F5), TM-31 

screen display, problems with, TM-52 
script files. See TELMERGE.SYS 
send a file (F4), TM-21 

ASCll transfer, TM-21, TM-22 
to CompuServe, TM-16 
CompuServe A protocol, TM-21 
to MCI Mail, TM-17 
telex message, TM-19 

send a file (F6), XMODEM checksum/CRC 
protocols, TM-23 

send electronic mail, TM-15 to TM-19 
SEND keyword 

automate entire session, TM-30 
defined, TM-48 

send telex document, TM-17 to TM-19 

serial port 
and modem connection, TM-6 
See also PORT keyword 

SERVICE keyword 
in CompuServe script file, TM-13 
defined, TM-48 

setting up, TelMerge, TM-6 to TM-7 
ShoFil (F8), TM-31 
shortcuts, TM-27 to TM-31 
show. See display 
Snap Shot (F5), TM-31 
special characters, in keywords, TM-34 
STOPS keyword, defined, TM-48 
store-and-forward mode (telex), TM-18 
SUFFIX keyword, defined, TM-49 
switch settings, for Hayes modems, TM-6 to 

TM-7 

.TEL files, TM-10 
telephone numbers. See NUMBER keyword 
telex 

add service to TELMERGE.SYS, TM-14 
interactive mode, TM-18 to TM-19 
ITT format for message, TM-17 
line wrap problems, TM-52 
message format, TM-17 
punctuation marks lost in message, 

TM-53 
receive a telex, TM-19 
send a telex, TM-17 to TM-19 
store-and-forward mode, TM-18 

TELEXTRA. See RCA TelexnELEXTRA 
TelMerge 

hardware requirements, TM-5 
installing, TM-6 to TM-7 
overview of, TM-3 
TelMerge-to-TelMerge transfer, TM-24 to 

TM-25 



TELMERGE.SYS, TM-I 1 
add new service to, TM-13 to TM-14 
add telex service to, TM-14 
adding information to, TM-11 to TM-14 
automate entire session, TM-29 to TM-31 
bulletin board scripts, TM-22 to TM-23 
comment lines in, TM-34 
communications services files, TM-9 
CompuServe script files, TM-12 
control characters in, TM-34 
data collection script, TM-24 
keyword order, TM-33 to TM-34 
keywords listed, TM-35 to TM-50 
log-on customization, TM-29 
logfile name prompt, TM-28 
null modem script, TM-25 
password prompt customization, TM-28 
printer or disk file output prompt 

customization, TM-29 
reprogramming of, TM-28 to TM-31 
special characters in, TM-34 

terminal emulation, TM-22 
See also EMULATE keyword 

TERMINAL keyword, defined, TM-49 
TIMETRAN, send telex using, TM-18 
tone dialing, and PREFIX keyword, TM-46 
troubleshooting, TM-51 to TM-53 
TRY keyword, TM-16 

defined, TM-49 

USEDTR keyword, defined, TM-49 
USERID keyword 

in CompuServe script file, TM-13 
defined, TM-50 

VIDTEX terminal emulation 
described, TM-22, TM-37 
EMULATE keyword, TM-37 
FULLSCREEN keyword, TM-39 

VT25 terminal. See VIDTEX terminal 
emulation 

VT100 terminal emulation 
described, TM-22, TM-37 
EMULATE keyword, TM-3 7 
FULLSCREEN keyword, TM-39 

wait for keyboard response (?), TM-34 
WAIT keyword 

automate entire session, TM-30 
defined, TM-50 

wild-card characters, and multiple file 
transfers, TM-25 

XMODEM checksumICRC protocols 
described, TM-21 
receive a file (F5), TM-23 
send a file (F6), TM-22, TM-23 





NOTES 






